
      

  

 ปจจุบันนี้นับเปนยุคแหงขอมูลและขาวสารที่เรียกกันส้ันๆวา “ยุคโลกาภิวัฒน”   ความกาวหนาทาง

เทคโนโลยีเปนสวนสําคัญในชีวิตประจําวันของมนุษยมากขึ้น “คอมพิวเตอร” (COMPUTER)  นับวา

เปนเทคโนโลยีประเภทหนึ่งที ่กาวเขามามีบทบาทตอการดํารงชีวิตของมนุษยเปนอยางมาก  การ

เรียนวิชาคอมพิวเตอรจึงเปนส่ิงที่จําเปนสําหรับเยาวชนในปจจุบัน  ดังนั้นสถานศึกษาตางๆ  จึงจัดให

วิชาคอมพิวเตอรเปนสวนหนึ่งของการเรียนการสอน   ในระดับชั้นอนุบาล  ประถมศึกษา  มัธยมศึกษา  

และ อาชีวศึกษา 

  ดังนั้นจึงไดเล็งเห็นความสําคัญในการพัฒนาการเรียนการสอนคอมพิวเตอรในสถานศึกษา    และได

จัดทําแผนการจัดการเรียนรูวิชาคอมพิวเตอรโดยเรียบเรียงจากเอกสาร และซอฟแวรตางๆ  ใหกับแตละสถาบัน 

และสอดคลองกับสาระการเรียนรูตามหลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน  พ.ศ. ๒๕๕๑   ของ

กระทรวงศึกษาธิการ   เพ่ือเปนงานวิชาการสําหรับการเรียนสอนนักเรียน  เนื้อหาหลักสูตรประกอบไปดวย การใช

โปรแกรม Adobe  Flash  CS5  สําหรับสรางโครงงานคอมพิวเตอร เมื่อนักเรียนไดเรียนรู และฝกปฏิบัติจนครบ

เนื้อหาภายในเลมแลว  จะทําใหนักเรียนมีความรูความสามารถที่จะใชคอมพิวเตอรเบื้องตน  และใช

คอมพิวเตอรระบบมัลติมีเดียในโปรแกรมตางๆ ได 

     คณะผูจัดทําไดเรียบเรียงแผนการจัดการเรียนรูวิชาคอมพิวเตอรเลมนี้ขึ้นมา เพ่ือเปนประโยชนตอ

การเรียนการสอนสําหรับสถานศึกษาตางๆ และเปนการเตรียมความพรอมใหแกผูเรียนในการนําไปประยุกต

กับการทํางานในยุคปจจุบัน มิไดมีจุดมุงหมายเพ่ือจําหนาย 

 

คํานําคํานํา 



สารบัญ 

 เร่ือง                                                                                                   หนา   

รูจักกับเทคโนโลยีของ Adobe Flash CS5 Professional                                 1 

การสรางช้ินงานดวยเครื่องมือของ Flash CS5 14 

เลือกและเปลี่ยนขนาดของออบเจ็กต                                                                 50 

ตกแตงภาพใหมีสสีันท่ีสวยงาม                         68 

สรางช้ินงานแบบ Symbol กับ Instance       92           

รูจักกับ Layer ซีน และเฟรม                              112 

การสราง Animation                                         128                                  

การกาํหนดสรางการเช่ือมโยงและการใสเสยีงประกอบ               150 

การนําไฟลช้ินงานของ Flash CS5 ไปใช      175                                                       

  



ค ำอธิบำยรำยวิชำ 

                   เวลำ  ๔๐  ชั่วโมง 

       มุ่งเน้นให้ผู้เรียนเข้าใจหลักการและวิธีการสร้างโครงงานคอมพิวเตอร์  โดยมี
จุดมุ่งหมายหลักคือต้องการให้ผู้เรียนศึกษา วิเคราะห์ อภิปราย สรุป เกี่ยวกับ
ความหมาย ประเภท คุณค่าโครงงานคอมพิวเตอร์  ขั้นตอนการพัฒนาโครงงาน
คอมพิวเตอร์  ใช้คอมพิวเตอร์ช่วยสร้างชิ้นงานหรือโครงงานตามหลักการท า
โครงงาน  ผลกระทบด้านสังคมและสิ่งแวดล้อมที่เกิดจากงานที่สร้างขึ้น เพื่อหา
แนวทางปรับปรุงและพัฒนา 
 ฝึกปฏิบัติท าโครงงานคอมพิวเตอร์ตามหลักการท าโครงงาน โดยใช้ความรู้ 
ความคิด จินตนาการ ทักษะ เหตุผล และกระบวนการต่างๆ  ทางเทคโนโลยี
สารสนเทศ ตลอดจนประสบการณ์ด้านคอมพิวเตอร์ โดยมีการ บูรณาการความรู้
จากกลุ่มสาระการเรียนรู้ต่าง ๆ หรือความรู้ด้านอื่น ๆ   ที่เกี่ยวข้องเข้ามาร่วมในการ
พัฒนาโดยใช้กระบวนการเทคโนโลยี การบวนการสืบค้น กระบวนการแก้ปัญหา 
กระบวนการคิดวิเคราะห์  

เพื่อให้เกิดความรู้ ความเข้าใจ และสามารถน าเอาคอมพิวเตอร์มาประยุกต์ใช้
ในการสร้างโครงงานได้อย่างมีจิตส านึกและมีความรับผิดชอบ 



1 

 

 

 

มาตรฐาน ง 3.1  เขาใจเห็นคุณคา และใชกระบวนการเทคโนโลยีสารสนเทศในการสืบคนขอมูล  

การเรียนรู  การสื่อสาร  การแกปญหา  การทํางานและอาชีพอยางมีประสิทธิภาพ  ประสิทธิผล   

และมีคุณธรรม 

   

ช้ัน ตัวช้ีวัด  สาระการเรียนรูแกนกลาง 

ม.4-6 1. อธิบายองคประกอบของระบบ

สารสนเทศ 

•   องคประกอบของระบบสารสนเทศ  ไดแก ฮารดแวร 

ซอฟตแวร ขอมูล บุคลากร   และข้ันตอนการปฏิบัติงาน 

 2. อธิบายองคประกอบและหลักการ

ทํางานของคอมพิวเตอร 

 

•   การทํางานของคอมพิวเตอรประกอบดวยหนวยสําคัญ 

๕ หนวยไดแก หนวยรับเขาหนวยประมวลผลกลาง  

หนวยความจําหลัก  หนวยความจํารอง และหนวย

สงออก  

-  หนวยประมวลผลกลาง ประกอบดวยหนวยควบคุม  

และหนวยคํานวณและตรรกะ  

-  การรับสงขอมูลระหวางหนวยตางๆ  จะผานระบบทาง

ขนสงขอมูลหรือบัส 

 3. อธิบายระบบสื่อสารขอมูลสําหรับ

เครือขายคอมพิวเตอร 

 

•   ระบบสื่อสารขอมูล  ประกอบดวย ขาวสาร    ผูสง ผูรับ     

  สื่อกลาง  โพรโทคอล 

•   เครือขายคอมพิวเตอรจะสื่อสารและรับสงขอมูลกันได  

 ตองใชโพรโทคอล  ชนิดเดียวกัน 

•   วิธีการถายโอนขอมูลแบบขนาน และ แบบอนุกรม 

 

 

สาระที่  3  เทคโนโลยีสารสนเทศและการส่ือสาร 
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ช้ัน ตัวช้ีวัด สาระการเรียนรูแกนกลาง 

ม.4-6 4. บอกคุณลักษณะของคอมพิวเตอร และ

อุปกรณตอพวง 

• คุณลักษณะ(specification)ของอุปกรณคอมพิวเตอร 

และอุปกรณตอพวง  เชน  ความเร็วและความจุของ

ฮารดดิสก 

 5. แกปญหาดวยกระบวนการเทคโนโลยี

สารสนเทศอยางมีประสิทธิภาพ 

 

•   แกปญหาโดยใชข้ันตอนดังน้ี 

-   การวิเคราะหและกําหนดรายละเอียดของปญหา  

-   การเลือกเคร่ืองมือ และออกแบบข้ันตอนวิธี  

-   การดําเนินการแกปญหา  

-   การตรวจสอบ และการปรับปรุง 

•   การถายทอดความคิดในการแกปญหา  อยางมีข้ันตอน 

 6. เขียนโปรแกรมภาษา •   ข้ันตอนการพัฒนาโปรแกรม มี  ๕ ข้ันตอน ไดแก       

การวิเคราะหปญหา  การออกแบบโปรแกรม การเขียน

โปรแกรม   การทดสอบโปรแกรม   และการจัดทําเอกสาร

ประกอบ 

•   การเขียนโปรแกรม  เชน ซี  จาวา  ปาสคาล  

 วิชวลเบสิก   ซี  ชารป   

•   การเขียนโปรแกรมในงานดานตางๆ   เชน    การจัดการ

ขอมูล  การวิเคราะหขอมูล     การแกปญหาในวิชา

คณิตศาสตร     และวิทยาศาสตร   การสราง  ช้ินงาน 
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ช้ัน ตัวช้ีวัด สาระการเรียนรูแกนกลาง 

ม.4-6 7. พัฒนาโครงงานคอมพิวเตอร 

 

•  โครงงานคอมพิวเตอร  แบงตามวัตถุประสงคของการใช   

งานดังน้ี 

     -   การพัฒนาสื่อเพ่ือการศึกษา 

-   การพัฒนาเคร่ืองมือ 

-   การทดลองทฤษฎี 

-   การประยุกตใชงาน 

     -   การพัฒนาโปรแกรมประยุกต 

  •   พัฒนาโครงงานคอมพิวเตอรตามข้ันตอนตอไปน้ี 

-   คัดเลือกหัวขอท่ีสนใจ 

-   ศึกษาคนควาเอกสาร 

-   จัดทําขอเสนอโครงงาน 

-   พัฒนาโครงงาน 

-   จัดทํารายงาน 

-   นําเสนอและเผยแพร 

 8.ใชฮารดแวรและซอฟตแวรใหเหมาะสม

กับงาน 

 

•   การเลือกคุณลักษณะของฮารดแวรและซอฟตแวรให

เหมาะสมกับงาน  เชน คอมพิวเตอรท่ีใชในงานสื่อ

ประสม ควรเปนเคร่ืองท่ีมีสมรรถนะสูง  และใช

ซอฟตแวร ท่ีเหมาะสม 
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ช้ัน ตัวช้ีวัด สาระการเรียนรูแกนกลาง 

ม.4-6 9.ติดตอสื่อสาร  คนหาขอมูลผาน

อินเทอรเน็ต 

•  ปฏิบัติการติดตอสื่อสาร คนหาขอมูลผานอินเทอรเน็ต  

•   คุณธรรมและจริยธรรมในการใชอินเทอรเน็ต 

 10.ใชคอมพิวเตอรในการประมวลผล

ขอมูลใหเปนสารสนเทศเพ่ือประกอบ การ

ตัดสินใจ 

•  ใชเทคโนโลยีสารสนเทศชวยในการตัดสินใจของบุคคล  

กลุม องคกร  ในงานตางๆ     

 11. ใชเทคโนโลยีสารสนเทศนําเสนองาน

ในรูปแบบท่ีเหมาะสม  ตรงตาม

วัตถุประสงคของงาน 

•   ใชเทคโนโลยีสารสนเทศนําเสนองานในรูปแบบโดย

พิจารณาวัตถุประสงคของงาน   

 12.ใชคอมพิวเตอรชวยสรางช้ินงานหรือ

โครงงานอยางมีจิตสํานึกและความ

รับผิดชอบ 

 

•   ใชคอมพิวเตอรชวยสรางช้ินงานหรือโครงงาน ตาม

หลักการทําโครงงาน 

•   ศึกษาผลกระทบดานสังคมและสิ่งแวดลอมท่ีเกิดจาก

งานท่ีสรางข้ึน เพ่ือหาแนวทางปรับปรุงและพัฒนา 

 13.บอกขอควรปฏิบัติสําหรับผูใช

เทคโนโลยีสารสนเทศ 

•   ขอปฏิบัติสําหรับผูใชเทคโนโลยีสารสนเทศ  เชน 

สื่อสารและปฏิบัติตอผูอ่ืนอยางสุภาพ ปฏิบัติตาม

ระเบียบขอบังคับของระบบท่ีใชงาน ไมทําผิดกฎหมาย

และศีลธรรม แบงปนความสุขใหกับผูอ่ืน 

 

   



โครงสรางรายวิชา 

วิชาคอมพิวเตอร                            เวลา     ๒๐    ช่ัวโมง 

                                                                                                                                  

 

ลําดับที ่ มฐ/ตชว. สาระสําคัญ ช่ือหนวยการเรียนรู 
เวลา   

(ช.ม.) 

น้ําหนัก

คะแนน 

๑ 
ง ๓.๑ 

 

หลักการทํางานเบ้ืองตนของโปรแกรม 

Adobe Flash CS5  เชน 

ความสามารถ ของโปรแกรม , 

เครื่องมือใหมที่เพิ่มเขามา 

รูจักกับเทคโนโลยีของ Adobe Flash 

CS5 

  

๒ 
ง ๓.๑  

 

รูจักสวนประกอบของโปรแกรม เชน 

หนาตางการทาํงาน วาแตละสวนเรียก

กวาอะไร และใชงานอยางไร 

และการเริ่มตนสรางช้ินงานใน

โปรแกรม Flash CS5 

การสรางช้ินงานดวยเครื่องมอืของ 

Flash CS5 

  

๓ ง ๓.๑ 

รูจักเครื่องมือในกลุมการเลือกวัตถุ 

สามารถใชเครื่องมือในกลุมนี้เพื่อ

เปลี่ยนรูปทรง ขนาดของช้ินงาน  

เคลื่อนยายตําแหนง 

การเลือกและเปลี่ยนขนาดของ

ออบเจ็กต 

  

๔ ง ๓.๑ 

รูจักกับเครื่องมือใสสสีันใหกับช้ินงาน 

เชน การเปลีย่นสเีสนของ สีพื้น การ

ไลเฉดส ี

การตกแตงภาพใหมีสีสนัที่สวยงาม

  

  

๕ ง ๓.๑ 
รูจักกับประเภทของ Symbol และการ

สราง Symbol แตละแบบ 

การสรางช้ินงานแบบ Symbol กับ 

Instance 

  

เวลาตามหนวย   

สอบปลายป   



โครงสรางรายวิชา 

วิชาคอมพิวเตอร เวลา     ๒๐    ช่ัวโมง 

ลําดับที ่ มฐ/ตชว. สาระสําคัญ ช่ือหนวยการเรียนรู 
เวลา 

(ช.ม.) 

น้ําหนัก

คะแนน 

๖ ง ๓.๑ 
การสราง การแกไข และ การลบ 

Layer  ซีน  และ เฟรม  

รูจักกับ Layer ซีน และ เฟรม 

๗ ง ๓.๑ 

รูจักกับ ประเภทของ Animation 

และการสราง Animation ในแบบ

ตางๆ 

การสราง Animation 

๘ ง ๓.๑ 

การใสคําสั่ง ในการเช่ือมโยง ซีน การ

เช่ือมโยงช้ินงานตางไฟล หรือ

เช่ือมโยงเว็บไซต และการใสเสียง

ประกอบช้ินงาน 

การกําหนดการสรางการเช่ือมโยง

และการใสเสียงประกอบ  

๙ ง ๓.๑ 

การแปลงไฟลอยูในรปูแบบที่น้ําไปใช

งานได เชน การแปลงไฟลเปน swf 

เปนไฟล avi   หรือ ไฟล html 

การนําไฟลช้ินงานของ Flash CS5 

ไปใช 

เวลาตามหนวย 

สอบปลายป 
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หน่วยการเรียนรู้ที่ 1 

รู้จักกับเทคโนโลยีของ Adobe Flash  CS5  Professional 
  มาตรฐานการเรียนรู้ / ตัวชี้วัด 

  กลุ่มสาระการงานอาชีพและเทคโนโลยี 
       สาระที่  3  เทคโนโลยีสารสนเทศและการสื่อสาร 

        เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การเรียนรู้   การ
สื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม  

        ตัวชี้วัด   
            1.   อธิบายหลักการท าโครงงานที่มีการใช้เทคโนโลยีสารสนเทศ 
            2.   เขียนโปรแกรมภาษาขั้นพื้นฐาน 
  สาระส าคัญ 
          หลักการท างานเบื้องต้นของโปรแกรม Adobe Flash CS5  เช่น ความสามารถ ของโปรแกรม , 
เครื่องมือใหม่ที่เพิ่มเข้ามา 
  สาระการเรียนรู ้
         -  ความรู้ 
              1.  รู้จักกับโปรแกรมเบื้องต้น 
 2.  ความสามารถของโปรแกรมว่าสร้างช้ินงานประเภทอะไรได้บ้าง 
         -  ทักษะ / กระบวนการ 
               1.  อธิบายความสามารถของโปรแกรม 
               2.  ประยุกต์การสร้างช้ินงานจากโปรแกรม 
                
         -  คุณลักษณะที่พึงประสงค์ 
               1.  มีวินัย 
               2.  ใฝ่เรียนรู้ 
               3.  มุ่งมั่นในการท างาน  
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Flash คืออะไร 

  หากกล่าวกันถึงโปรแกรม Flash ในปัจจุบัน ในแวดวงของนักพัฒนาเว็บไซต์ นักออกแบบ 
Multimedia หรือเหล่าคนท า Animation คงไม่มีใครไม่รู้จักเจ้าโปรแกรมนี้เป็นแน่ ในฐานะที่เป็นเคร่ืองมือ
สร้าง Animation ที่ทรงคุณภาพ และสามารถสร้างงานที่ตอบโต้กับผู้ใช้ได้อย่างยอดเย่ียม อีกทั้งยังเป็นที่รู้จัก
ในฝ่ังของผู้ชมในฐานะ Animation ตื่นตาตื่นใจที่ท าให้การท่องเว็บไซต์ หรือการนั่งชม Presentation ไม่ใช่
ภาพนิ่งๆ  

 งาน Flash นั้นแบ่งเป็น 2 ประเภทใหญ่ คือ งาน Online และงาน Offline ซึ่งมีงานประเภทต่างๆ 
ดังต่อไปนี้ 

งาน Flash แบบ Online 

1. Web Banner 
งานป้ายโฆษณาบนเว็บไซต์พัฒนามาจาก Gif Animation ที่โหลดช้าและคุณภาพต่ าในสมัยก่อน มา
เป็น Animation ของ Flash ที่เคลื่อนไหวต่อเนื่องมีขนาดเล็กและยังมี Graphic ที่สวยงาม 

2. Web Animation  
ส่วนประกอบของเว็บไซต์ที่เคยใช้เป็นภาพนิ่ง สามารถสื่อสาร และดึงดูดความสนใจได้มากขึ้นด้วย 
Flash 

3. Web Introduction 
ถ้า 1 ภาพแทนค าพูด 1000 ค า  ภาพเคลื่อนไหวยอมพูดได้มากขึ้นอีกหลายเท่ าตัว การใช้
ภาพเคลื่อนไหวอธิบายบุคลิก ตัวตนของเว็บไซต์เป็นอีกอย่างที่  Flash ท าได้ดีและได้รับความนิยม
อย่างสูง 

4. Flash Website ถ้าไม่ใช้เว็บไซต์จะไม่เพียงแค่ตกแต่งประดับประดาด้วย Flash เท่านั้น มันสามารถ
ใช้ท าเว็บไซต์ทั้งกระบวนการได้ด้วย ไม่จ ากัดแค่เพียง Animation และเนื้อหาอย่างเดียว หากยังการ
เช่ือมโยงกับฐานข้อมูล และการสร้าง Application ที่มีรูปแบบเฉพาะตัวอีกด้วย 

 

งาน Flash แบบ Offline 
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1. Product Introduction 

งานเปิดตัวสินค้า งาน Event งานคอนเสิร์ต งานแต่งงาน ที่จะต้องมีการน าเสนอความน่าสนใจ
ของสินค้า หรือกิจกรรมต่างๆ การท า Animation อธิบายวิธีการใช้ หรือแนะน ากิจกรรมลูกค้า
ด้วยโปรแกรม Flash ก็เป็นทางเลือกใหม่ที่ก าลังมาแรง ด้วยวิธีการที่สะดวก และประหยัด
ค่าใช้จ่ายกว่างานด้าน VDO 

2. Presentation, CD Interactive 

เมื่องาน Flash สามารถตอบโต้กับผู้ใช้งานได้ การสร้างงานแบบ Presentation ก็ไม่เป็นปัญหา
ส าหรับ flash อีกทั้งยังมีประโยชน์ในเร่ืองความยืดหยุ่นของการเขียนโปรแกรม จึงเปิดโอกาส
ให้สร้างงาน Interactive แบบจินตนาการกว้างไกล โดยไม่ยึดติดอยู่ในโครงร่างตายตัว
เหมือนกับ PowerPoint อีกต่อไป 

3. Application 

ในขั้นสูง การเขียนโปรแกรมช่วยให้สามารถสร้าง Application เฉพาะทางขึ้นเอง เอาไว้ใช้
ส่วนตัว หรือใช้กันเองในบริษัท 

ทั้งนี้ยังมีงานที่สามารถใช้ได้ทั้ง Online และ Offline ได้อีกด้วย 

1. Full Animation, Cartoon, E-Card, Music Video 

ไม่ว่าจะเป็นการสร้าง Cartoon บนเว็บไซต์หรือการท า Music Video รวมถึง Animation ที่ส่งไปตาม
อีเมล์ ในลักษณะ Electronic-Cards งานประเภทเหล่านี้จะใช้โปรแกรม Flash เป็นตัวเลือกแรกๆ 
ด้วยเหตุที่กล่าวข้างต้น 

2. Games  

การพัฒนาในส่วนของการเขียนโปรแกรมในช่วงหลังๆ ท าให้ Flash สามารถสร้างเกมที่มี
ประสิทธิภาพมากขึ้นเร่ือยๆ ถึงแม้ว่าอาจจะยังไม่ใช้เกมที่ขายได้อย่างจริงจัง แต่มันสามารถได้ซึ่ง  
flash ท าให้การสร้างเกมไม่ใช่เร่ืองยากจนเกินไป 

 
เก่ียวกับทางผู้ผลิตและเวอร์ชั่นของโปรแกรม Flash 
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ข่าวใหญ่ในแวดวง Web Designer, Graphic Designer หรือ Animator ในช่วงที่ผ่านมา คงหนีไม่พน้
การที่บริษัทยักษ์ใหญ่ทางด้าน Graphic Editor Software อย่าง Adobe ที่เป็นเจ้าของ Software ประจ าเคร่ือง
ของ Graphic Designer อย่าง Photoshop และ Illustrator ได้ซื้อ บริษัท Macromedia เจ้าของ Software ที่เป็น
มือฉมังทางด้านเว็บไซต์และเป็นผู้ผลิต Flash เวอร์ช่ันใหม่ออกมาพร้อมกับหลายๆ โปรแกรมภายใต้ Series 
ที่ช่ือ  CS5 เพื่อแสดงถึงความเป็นอันหนึ่งอันเดียวกันของ Adobe นั่นเอง 

Adobe Flash CS5 หรือ Flash เวอร์ช่ัน 11 นั้นไดถู้กพัฒนาขึน้โดยอาศัยเทคโนโลยีทางด้าน Graphic 
ของ Adobe อย่างมากมาย ท าให้การสร้าง Graphic ใน flash นั้นสะดวกสบายกว่าเวอร์ช่ันก่อน อีกทั้งยัง
รองรับเทคโนโลยีที่ก าลังมาแรงอย่างการใช้ VDO  และการสร้าง Application ส าหรับโทรศัพท์มือถือเป็น
อย่างดีอีกด้วย ซ่ึงความสามารถต่างๆ เหล่านี้จะได้กล่าวถึงในบทต่อๆ ไป  

 

Flash ใช้ท าอะไรได้บ้าง 
 โปรแกรม Flash เป็นโปรแกรมยอดนิยมส าหรับการสร้างผลงานได้หลายประเภท ไม่ว่าจะเป็น
การ์ตูนแอนิเมชัน, เกม, สื่อโฆษณาบนเว็บไซต์ หรืออินเตอร์เฟสแผ่นซีดีที่มีการตอบโต้กับผู้ใช้ โดยในหัวข้อ
นี้เราจะมาท าความรู้จักกับความสามารถของโปรแกรม Flash ไว้เป็นแนวทางเพื่อน าไปพัฒนาชิ้นงานต่อไป  

 ความสามารถในการสร้างชิ้นงาน Interactive  
 ช้ินงาน Interactive คือ ช้ินงานที่มีการตอบสนองกับผู้ใช้ เช่น ผู้ใช้สามารถคลิกเลือกเมนูตา่งๆ ได้ ซึ่ง
ส่วนใหญ่งานประเภท Interactive ที่สร้างด้วยโปรแกรม Flash นั้นจะน าไปใช้เป็นสื่อการสอน (E-Learning) 
หรือหน้าจอควบคุมการท างานของแผ่น CD เป็นต้น 

 
 ความสามารถในการสร้างชิ้นงาน Animation  
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 การสร้าง Animation หรือภาพการ์ตูนเคลื่อนไหวนั้น ถือเป็นหัวใจหลักของการท างานในโปรแกรม 
Flash เนื่องจากมีเครื่องอ านวยความสะดวกมากมาย จึงท าให้โปรแกรม Flash สร้างผลงาน Animation ได้ง่าย
กว่าโปรแกรมอื่น ซึ่งเราสามารถพบเห็นงานแอนิเมชันได้ทั่วไป ไม่ว่าจะเป็นสื่อโฆษณา (Banner) บน
เว็บไซต์ หรือการ์ตูนแอนิเมชันต่างๆ  

 
 

 ความสามารถในการสร้างเว็บไซต์ (Website) 
 งานประเภทเว็บไซต์ ก็เป็นการสร้างช้ินงานอีกรูปแบบหนึ่งที่ใช้โปรแกรม Flash สร้างผลงานได้ 
เนื่องจากโปรแกรม Flash สามารถสร้างเว็บไซต์ได้สวยงาม และสร้างลูกเล่นต่างๆ ได้ง่ายกว่าการใช้
โปรแกรมอื่น แต่มีข้อเสียคือ เว็บไซต์ที่สร้างด้วยโปรแกรม Flash แก้ไขข้อมูลได้ยาก และขนาดของไฟล์
เว็บไซต์จะมีขนาดค่อนขา้งใหญ่ ดังนั้น หากต้องการสร้างเว็บไซต์ควรพิจารณาถึงรูปแบบของเว็บไซต์ก่อน
ว่าเหมาระสมที่จะสร้างด้วยโปรแกรม Flash หรือไม่  

 
ความสามารถในการสร้างเกม (Game) 
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 ปัจจุบันได้มีเกมที่สร้างจากโปรแกรม Flash ออกมาอย่างแพร่หลายตามเว็บไซต์ต่างๆ เนื่องจาก
โปรแกรม Flash มีเครื่องมือช่วยสร้างองค์ประกอบต่างๆ ของเกมให้สวยงาม, มีเครื่องมือส าหรับใส่ค าสั่ง
ควบคุมการเล่นเกม อีกทั้งไฟล์เกมที่สร้างออกมามขีนาดเล็ก ท าให้อัพโหลดขึ้นสู่เว็บไซต์ได้อย่าง
รวดเร็ว 

 
เตรียมตัวอย่างไร ส าหรับการสรา้งแอนิเมชัน 

 ส าหรับการเตรียมตัวในการท างานโปรแกรม Flash CS5 นั้น จะต้องเร่ิมจากวางโครงร่างเร่ืองราว
แอนิเมชัน หลังจากนั้นก็จะสร้างตัวละครให้เหมาะสมกับเร่ืองราว สร้างฉากแล้วน าทุกอย่างมาประกอบกัน
ให้เป็นชิ้นงาน 

วางโครงร่างส าหรับสร้างงานแอนิเมชัน (Storyboard) 
 การวางโครงร่าง (Storyboard) คือการคิดเนื้อเร่ืองขึ้นมา และวาดออกมาเป็นภาพตั่งแต่ต้นจนจบ
อย่างคร่าวๆ ซ่ึงก็เหมือนกับการวางแผนการท างานในเบื้องต้น เพื่อให้ผลงานที่ออกมาเป็นระบบและรวดเร็ว 

 
สร้างตัวละครส าหรับงานแอนิเมชัน 
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 เมื่อเราสร้างผลงานแอนิเมชันขึ้นมาสักช้ินหนึ่ง สิ่งที่จ าเป็นจะต้องท าก็คือ การสร้างตัวละครเพื่อเป็น
ตัวด าเนินเร่ืองราว โดยต้องคิดเนื้อเร่ืองขึ้นมาก่อน ว่าเราต้องการที่จะสร้างเร่ืองราวอะไรขึ้นมา และค้นหา
เอกลักษณ์ของตัวละครนั้นๆ เพื่อให้ตัวละครมีความโดดเด่นและน่าสนใจ แต่ส าหรับผู้ที่ไม่มีทักษะทางด้าน
การวาดรูปอาจขอให้เพื่อน หรือคนรู้จักวาดรูปให้น ามาสแกน แล้วปรับแต่งเพื่อใช้งานในโปรแกรม Flash ก็
ได้ 

1. วาดโครงร่างของตัวละครด้วยดินสอ จากนั้นน าไปสแกน 

2. ใช้เคร่ืองมือที่มีในโปรแกรม Flash ปรับต่างภาพตัวละคร 

3. ลงสี และเก็บรายละเอียดให้กับตัวละคร 

 

มีอะไรใหม่ใน Flash CS5 
 ในโปรแกรม Flash CS5 แตกต่างจากโปรแกรม Flash เวอร์ชันก่อนหน้าหลายส่วนตั้งแต่หน้าจอ
โปรแกรม และเครื่องมือใหม่ๆ ที่เพิ่มขึ้นมา ซึ่งจะมีอะไรบ้างนั้นเราจะได้เรียนรู้กันในส่วนนี้ 
 

 หน้าตาของโปรแกรมทีเ่ปลีย่นไป (User Interface) 
 ส าหรับโปรแกรม Flash CS5 เวอร์ชันล่าสุด หน้าตาของโปรแกรมได้เปลี่ยนไปจากเดิม เปลี่ยน
ต าแหน่งการวางแถบเครื่องมือต่างๆ ทั้ง Timline, Scene และ Panel ต่างๆ ท าให้ผู้ที่ใช้งานนั้นสามารถท างาน
ได้สะดวกสบายย่ิงขึ้น  

 
เครื่องมือใหม่ที่เพ่ิมขึ้นมา 
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 เมื่อเปิดโปรแกรม Flash CS5 เราจะเห็นว่าเคร่ืองมือใหม่ๆ เพิ่มขึ้นมาหลายช้ิน โดยแบ่งออกเป็น 5 
หมวดหลักๆ ดังต่อไปนี ้

 เครื่องมือส าหรับปรับแต่งภาพ 3 มิติ 

 เครื่องมือ    (3D Rotation Tool) และเครื่องมือ       (3D Translation Tool) เป็นเคร่ืองมือที่
สามารถปรับต่างภาพ หมุน  บิด  ให้ออกมาเป็นรูปแบบ 3 มิติ ซึ่งเป็นความสามารถที่ท าให้เราสร้างงาน
แอนิเมชันที่ดูเป็นมิติมากย่ิงขึ้น  

 
 

เครื่องมือส าหรับสร้างหัวแปรงทาสี  
 เครื่องมือ      (Deco Tool) เป็นเคร่ืองมือส าหรับสร้างวัตถุที่มีลักษณะคล้ายๆ กับเครื่องมือแปรง
ทาสี (Brush) แต่เราสามารถสร้างหัวแปรงใหม่ โดยเปลี่ยน Symbol ให้กลายเป็นหัวแปรงได้  
 

 
เครื่องมือส าหรับสร้างโครงกระดกู 
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เครื่องมือส าหรับสร้างโครงกระดูก   (Bone Tool) และเครื่องมือ   (Bind Tool) เป็นเคร่ืองมือ
ที่สามารถเช่ือมต่อโครงกระดูกเพื่อใส่เข้าไปบนการ์ตูน ท าให้การ์ตูนมีการเคลื่อนไหวที่เป็นอิสระมากย่ิงขึ้น 
โดยขั้นตอนการใช้งานของเครื่องมือ (Bone Tool) 

 

 
 

พาแนล Motion Editor 
พาแนล  Motion Editor เป็นลูกเล่นใหม่ของ Flash CS5 เพราะจะท าให้เราสามารถปรับแต่ง

รายละเอียดของการเคลื่อนไหวได้ละเอียดขึ้น  

 
 

ค าสั่ง Motion Tween รูปแบบใหม่ 

ส าหรับค าสั่ง Motion Tween ในโปรแกรม Flash เป็นเวอร์ชันล่าสุดนี้จะต่างออกไปจากเดิม ไม่ว่าจะ
เป็นการใช้งานในลักษณะที่ต่างกันแล้ว เราจะพบว่ามีลูกเล่นใหม่ๆ ที่เสริมขึ้นมาอกีมากมาย  
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 สร้างงานมัลติมีเดียด้วยกราฟิก 
รูปแบบของไฟล์รูปภาพกราฟิกที่ใช้ในการตกแต่งนั้นมีหลากหลายรูปแบบแล้วแต่จะใช้เกณฑ์ไหน

มาแบ่ง ในที่นี้จะแบ่งรูปภาพตามระบบของโปรแกรมกราฟิก โดยเฉพาะในโปรแกรม Flash นั้นแบ่ง
ออกเป็น 2 อย่าง เมื่อพิจารณาจากรูปเดียวกันแต่รูปแบบต่างกันเมื่อขยายภาพจะมีรายละเอียด ดังนี้ 

 

 ภาพบิตแมป หรือราสเตอร์ (Bitmap or Raster) 
เป็นภาพที่เกิดจากช้ินส่วนเล็กๆ ของภาพมาเรียงต่อกัน ซึ่งความละเอียดของช้ินส่วนเหล่านี้จะเล็ก

ขนาดไหน มีการก าหนดค่าความละเอียดของหน้าจอ ภาพแบบนี้จะเป็นภาพที่มีความละเอียดของสีสันมาก 
แต่เมื่อขยายภาพให้ใหญ่ขึ้นก็จะเห็นรอยต่อของภาพคล้ายขั้นบันไดเหมือนกับรูปถ่ายที่เราไปขยายจากขนาด 
4x6 นิ้ว ไปเป็น 8x10 นิ้ว ก็จะเห็นแกนของรูปภาพขยายขึ้นอย่างชัดเจน รูปแบบที่พบอยู่บ่อยๆ คือ ไฟล์ที่มี
นามสกุล *.BMP นั่นเอง       

 ภาพเวคเตอร์ (Vector Picture) 
 จะเป็นภาพที่เกิดจากลายเส้น แทนที่จะเป็นช้ินส่วนภาพ ดังนั้นเมื่อท าการขยายภาพให้ใหญ่ขึ้น

โอกาสที่แกนของภาพจะหยาบมีน้อย ท าให้ขอบของรูปภาพแทบจะไม่เห็นเป็นขั้นบันไดเลย จึงเหมาะ
ส าหรับการสร้างงานกราฟิกที่ต้องการความสวยงามมากๆหรือการสร้างตัวอักษร หรือภาพเคลื่อนไหวใน
เว็บไซต์อย่างที่เห็นกันทั่วไป ส าหรับโปรแกรม Flash แล้วส่วนใหญ่จะท างานกับภาพแบบเวคเตอร์เป็นส่วน
ใหญ่โดยเรียกช่ือว่า ซิมโบล(Symbol) 

 

การเปิดโปรแกรม Adobe Flash  CS5 ข้ึนมาใช้งาน 
1. คลิกเมาส์ที่ปุ่ม Start บนแถบงานจะเกิดป๊อปอัพเมนูของโปรแกรม 
2. น าเมาส์เลือกค าสั่ง All  Programs เลื่อนเมาสไ์ปที่ Adobe Master Collection  CS5> Adobe 

Flash  CS5 Professional 
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3. คลิก 1 คร้ังที่ Adobe Flash  CS5 ก็จะท าการเปิดหน้าต่างโปรแกรมขึ้นมาจะปรากฏหน้าจอดัง
รูป 
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รูปแบบการท างาน 

 ในขั้นตอนนี ้การเรียนใช้งานโปรแกรม จะพบหน้าจอ Welcome Screen ส าหรับเลือกรูปแบบ
เร่ิมต้นการท างานดังนี้ 

 Open a Recent Item เป็นการเปิดไฟล์เก่าที่สร้างไว้แล้ว โดยคลิกเลือกรายช่ือที่แสดง (เรียงจากการ
บันทึกไฟล์ครั้งหลังสุดเป็นต้นไป สูงสุด 8 ไฟล์) หรือคลิก   Open เพื่อเปิดไฟล์อื่น  

คลิกเลือกรูปแบบเร่ิมต้นการท างาน 

คลิกเลือกส่วนของการแนะน าโปรแกรม 
คลิกเพ่ือดาวน์โหลดโปรแกรมหรือ 
ดูข้อมูลจากเว็บ Adobe 

คลิกเลือกในช่องนี้ หากไม่ต้องการให้แสดงหน้าจอ Welcome Screen อีกในครั้งต่อไป 
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 Create New สร้างไฟล์ใหม่ โดยคลิกเลือกรูปแบบของไฟล์ที่ตอ้งการสร้าง เช่น เลือก Flash File 
(ActionScript 3.0) เพื่อสร้างไฟล์มูฟว่ีใหม่ที่มีโหมดการเขียน ActionScript เป็นเวอร์ช่ัน 3 เป็นต้น 
ส าหรับเนื้อหาในเล่มนี้จะแนะน าให้ใช้ ActionScript 2.0 เป็นหลัก 

 Create From Template สร้างไฟล์ใหม่จากรูปแบบเทมดเพลตที่โปรแกรมมีให้โดยคลิกเลือกหมวด
ของเทมเพลตที่ต้องการก่อนแล้วคลิกเลอืกไฟล์อกีทีหนึ่ง 

ให้คลิกเลือกหัวข้อ  Flash File (ActionScript 2.0) จะพบกับหน้าจอดังรูป   

 

 
  



 14 

หน่วยการเรียนรู้ที่ 2 

การสร้างช้ินงานด้วยเครื่องมอืของ Flash CS5 
  มาตรฐานการเรียนรู้ / ตัวชี้วัด 
        กลุ่มสาระการงานอาชีพและเทคโนโลยี   
              สาระที่  3  เทคโนโลยีสารสนเทศและการสื่อสาร 
                เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การ
เรียนรู้   การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม        
         ตัวชี้วัด 
            1.   เขียนโปรแกรมภาษาขั้นพื้นฐาน       
            2.   อธิบายหลักการท าโครงงานที่มีการใช้เทคโนโลยีสารสนเทศ 

  สาระส าคัญ 
 

          รู้จักส่วนประกอบของโปรแกรม เช่น หน้าต่างการท างาน ว่าแต่ละส่วนเรียกกว่าอะไร และใช้
งานอย่างไร 
และการเริ่มต้นสร้างชิ้นงานในโปรแกรม Flash CS5 

  สาระการเรียนรู้ 
-  ความรู้ 
    1.  รู้จักส่วนประกอบของโปรแกรม 
    2.  การใช้งานในโปรแกรม  

    3. การสร้างช้ินงานด้วยเครื่องในโปรแกรม 
- ทักษะ / กระบวนการ 
    1.   เข้าใจและอธิบายส่วนประกอบของหน้าต่างประแกรมได ้
    2.   สามารถสร้างช้ินงานได้ตามความต้องการ 

             -  คุณลักษณะที่พึงประสงค์ 
                1.  มีวินัย 
                2.  ใฝ่เรียนรู้ 
                3.  มุ่งมั่นในการท างาน 
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หน้าต่างของโปรแกรม Flash CS5 
 โปรแกรม Flash ประกอบไปด้วยหน้าต่างท างาน (Panel) ที่มีเคร่ืองมือส าหรับปรับแต่ง
ช้ินงานช่วยสร้างช้ินงานให้ได้ตามต้องการ เนื่องจาก Flash จะมีหลายหน้าต่างมาก ในที่นี้จะขอ
แนะน าเฉพาะหน้าต่างที่จ าเป็นและสิ่งที่น่าสนใจ ดังรูป 
 
 

 

แสดงรายละเอียดของหน้าต่างโปรแกรม Flash CS5 

 

 Menu Bar  

Menu Bar คือ เมนูที่ใช้แสดงชุดค าสั่งทั้งหมดโปรแกรม Flash โดยคลิกเลือกเมนูค าสั่ง จะ 
ปรากฏค าสั่งย่อยให้เลือกตามตอ้งการ  

สเตจ (Stage) 

แท็บไฟล์เอกสาร 

ไทม์ไลน ์

พาเนลต่างๆ เมนูบาร์ ทูลพาเนล 
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 หน้าต่าง Timeline  

ประกอบไปด้วยเลเยอร์และเฟรม (ช่องเล็กๆ เรียงกัน) ที่จะช่วยในการกับช้ินงานส่วนต่างๆ ให้
แยกกันได้อย่างอิสระ การแสดงภาพเคลื่อนไหวจะแสดงทีละเฟรมตรงต าแหน่งที่หัวอ่าน (Play 
Head) ว่ิงไปถึง นอกจากนี้ยังมีส่วนของปุ่มแสดงเฟรมย้อนหลังที่เรียกว่า Onion Skin อยู่ที่ด้านล่าง 
ของ Timeline  

 
 

 
 
 
 
 
 

 

รูปภาพแสดงจอภาพของ Timeline Panel 

Layer  เลเยอร์เปรียบเสมือนแผ่นใสที่สามารถวาดภาพ หรือวางอ็อบเจ็กต์ลงไป เพื่อสร้าง
ภาพเคลื่อนไหวต่างๆ ซึ่งเลเยอร์แต่ละแผ่นจะแยกเป็นอิสระต่อกัน สามารถเปลี่ยน
ต าแหน่งการซ้อนทับกันของแต่ละเลเยอร์ได้ โดยจะมีผลให้ภาพที่อยู่ในเลเยอร์บน 
Stage เปลี่ยนต าแหน่งการซ้อนทับกันด้วย 

Timeline  เป็นส่วนที่ใช้ส าหรับก าหนดการเคลื่อนไหวของภาพวาดต่างๆ โดยภายใน 
Timeline ยังประกอบไปด้วยตารางเล็ก ๆ และมีแถบบอกจ านวนเฟรม (Frame) 
ด้านบน รวมทั้งมีเส้นสีแดงที่เรียกว่า “Playhead” ที่ใช้ส าหรับบอกต าแหน่งว่า
ขณะนี้ก าลังท างานอยู่ ณ ที่ใด 

เลเยอร ์

เพ่ิมเลเยอร์ 

Onion Skin 
Framerate 

คีย์เฟรม 

เฟรม 
หัวอ่าน 
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 หน้าต่าง Controller  

เมื่อสร้างเสร็จแล้ว หรือเมื่อต้องการทดสอบผลงานและภาพเคลือ่นไหวที่เกิดขึ้น จะท าการคลิก 
ปุ่มบนหน้าต่าง Controller นี้ จะแสดงผลเหมือนกับการกด <Alt+Enter> ที่แป้นคีย์บอร์ด 
 

 
 

รูปแสดง Controller Toolbar 

ตารางแสดงรายละเอียดของ Controller Toolbar 
ไอคอน ช่ือเรียก การใช้งาน 

 Stop ให้หยุดการแสดงมูฟว่ี 

 Go To first frame ให้ย้อนกลับไปเฟรมแรก เพื่อเร่ิมต้นการแสดงมูฟว่ีใหม่ 

 Step Back one frame ให้ย้อนกลับไปเฟรมก่อนหน้าทลีะขั้นตอน 

 Play ให้เร่ิมต้นแสดงมูฟว่ี 

 Step Forward one 
frame 

ให้เดินหน้าไปเฟรมต่อไปทีละขั้นตอน 

 Go to Last frame ให้ไปยังเฟรมสุดท้ายของมูฟว่ี 

 
 

 หน้าต่างไลบรารี (Library Panel)  
 
เมื่อสร้างช้ินงานขึ้นมาแล้วท าการแปลงเป็นซิมโบล หรือการน าภาพจากข้างนอกโปรแกรมเข้า 

มาใน Flash ภาพเหล่านั้นจะบรรจุอยู่ในหน้าต่างไลบรารีนี้ และสามารถเรียกหน้าต่างอย่างรวดเร็ว
ด้วยคีย์ลัด <Ctrl+L> 
 
 
 
 



 18 

 
 
 
 

 
 
 

 
 
  

         
   

 กล่องเคร่ืองมือ (Toolbox) 

Toolbox คือ กลอ่งที่ใช่ส าหรับบรรจุเครื่องมือวาดภาพต่างๆ เช่น เครื่องมือสร้างรูปสี่เหลี่ยม 
เครื่องมือสร้างข้อความ เป็นต้น ซ่ึงภายใน Toolbox จะถูกแบ่งออกเป็น 4 กลุ่มคือ Tool , View , 
Colors และ Option  
ตารางแสดงไอคอนของเครื่องมือใน Toolbox 
ไอคอน ชื่อเรียน หน้าที่ของปุม่เครื่องมือ 

 Arrow Tool ใช่ส าหรับเลือกอ็อบเจ็กต์ (Object) โดยการคลิก หรือคลิก
แล้วลากให้เป็นบริเวณสี่เหลี่ยมรอบอ็อบเจ็กต์ที่ต้องการเลือก 

 Subselection Tool ใช้ส าหรับเลือกจัดการกับอ็อบเจ็กต์เฉพาะบางส่วน 

 Free Transform ใช้ส าหรับปรับแต่งรูปทรงของอ็อบเจ็กต์ในแบบต่างๆ อย่าง
อิสระ 

 Gradient Transform ปรับแนวสีเกรเดียนท์ 

 3D Rotation tool  การปรับแต่งรูปทรงอ็อบเจ็กต์แบบ 3 มิติ 

 Lasso Tool ใช้ส าหรับเลือกอ็อบเจ็กต์ โดยการวาดเส้นแบบอิสระรอบอ็
อบเจ็กต์ 

 Pen วาดรูปทรง เส้นตรง เส้นโค้ง 

 Add Anchor Point เพิ่มจุดแองเคอร์ 

ตัวอย่างซิมโบล 

ชื่อซิมโบล 

เพ่ิมซิมโบลใหม่ 
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 Delete Anchor Point ลบจุดแองเคอร์ 

 Convert Anchor Point ปรับจุดแองเคอร์ 

 Line Tool ใช้ส าหรับวาดเส้นตรง 

 Rectangle Tool ใช้ส าหรับวาดรูปส่ีเหลี่ยม 

 Oval Tool ใช้ส าหรับวาดวงกลม หรือวงรี 

 Rectangle Primitive วาดสี่เหลี่ยมที่ปรับแต่งมุมได้ภายหลัง 

 Oval Primitive วาดวงกลมหรือวงรีที่ปรับแต่งรูปแบบได้ภายหลัง 

 PolyStar วาดรูปหลายเหลี่ยมและรูปดาว 

 Text  ใช้ส าหรับสร้างตัวอักษร หรือข้อความ 

 Brush Tool ใช้ส าหรับระบายสีคล้ายพู่กัน หรือแปลงทาสี 

 Pencil Tool ใช้ส าหรับวาดลายเส้นแบบอิสระ 

 Ink Bottle Tool ใช้ส าหรับเปลี่ยนสีเส้นขอบ 

 Eyedropper Tool ใช้ส าหรับคัดลอกลักษณะของเส้น หรือสีพ้ืนภายในของส่วน
ที่ถูกคลกิเพื่อน าไปใส่ให้เส้น หรือรูปทรงอื่น 

 Paint Bucket Tool ส าหรับเติมสีพ้ืนภายในของอ็อบเจ็กต์ 

 Eraser Tool  ใช้ส าหรับลบเส้น หรือสีพ้ืนภายใน 

 Hand Tool ส าหรับเคลื่อนย้ายจอภาพของ Stage ไปยังต าแหน่งต่างๆ 

 Zoom Tool ใช้ส าหรับย่อ หรือขยาย Stage 

 Stroke Color ใช้ส าหรับเลือกสีเส้นขอบของออ็บเจ็กต์ 

 Fill Color ใช้ส าหรับเลือกสีพ้ืนภายในของอ็อบเจ็กต์ 

 Default Color ใช้ส าหรับเลือกสีพ้ืนผิว และสีเส้นเป็นสีมาตรฐานคือ สีขาว- 
ด า 

 No Color คลิกเลือกเมื่อไม่ต้องการก าหนดสีให้กับเส้น หรือสีพ้ืนอ็อบ
เจ็กต์ 

 Swap Colors Tool ใช้สลับสีระหว่างสีพ้ืนที่ กับสีเส้นขอบ ก าหนดสีที่เลือกไว้
ก่อนหน้าของอ็อบเจ็กต ์

การซ่อนเครื่องมือ และการแสดงชุดเครื่องมอื (Toolbox)   
โดยปกติชุดเคร่ืองมือ Toolbox จะปรากฏอยู่ที่ด้านซ้ายมือสุดของจอภาพ แต่ผู้ใช้สามารถ

ก าหนดให้ซ่อนหรือแสดงชุดเครื่องมือ Toolbox ได้ตามต้องการ ดังนี้ 
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- การซ่อนชุดเครื่องมือ คลิกเลอืกเมนู Window > Tools เพื่อท าให้เครื่องหมาย  หน้า
ตัวเลือก Tools หายไปเพื่อซ่อนชุดเครื่องมือ 

- การแสดงชุดเครื่องมือ คลิกเลือกเมนู Window > Tools ซ้ าอีกครั้งเพื่อท าให้ปรากฏ
เครื่องหมาย  หน้าตัวเลือก Tools  

 หน้าต่าง Action Script  

หน้าต่างที่บรรจุชุดค าสั่งที่จะจัดการกับการแสดงของรูปภาพ หรือภาพเคลื่อนไหวที่จะเกิดขึ้น    
กับเร่ืองราวทั้งหมดหรือบางส่วน นอกจากนี้หน้าต่าง Actions ยังสามารถตรวจสอบการท างานของ
โค้ดต่างๆ ในไฟล์งานได้ 

 
 

 
 

       
 
 
 
 

การแบ่งหมวดหมู่ในหน้าต่าง Actions ช่วยให้การเขียนโปรแกรมสะดวกขึ้น 

 หน้าต่าง Properties  

ใช้ส าหรับปรับแต่งสีสัน และปรับเปลี่ยนเครื่องมือวาด
รูปต่างๆ หรือตรวจสอบคุณสมบัติของรูปภาพจะสะดวก
มากหากเปิดหน้าต่าง Properties ขึ้นมาด้วยคีย์ลัด
<Ctrl+F3> 

 
 

 

 พ้ืนที่ท างาน ( Working Area : Stage)  

Action Script Group 

Action List 

ประเภทของซิมโบล 

ปรับเอฟเฟ็กต์สี 
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Stage เป็นพื้นที่ส าหรับใช้ในการท างาน หรือจัดวางอ็อบเจ็กต์ต่างๆ ที่ต้องการให้ปรากฏใน 
ไฟล์เอกสาร โดยรูปวาดที่สร้างจากชุดเครื่องมือหลักหรือสิ่งต่างๆ ที่วางบน Stage จะเรียกว่า อ็อบ
เจ็กต์ ซึ่งผู้ใช้สามารถเปลี่ยนสีพื้นหลัง ขนาด หน่วยไม้บรรทัด หรืออื่นๆ ได้ตามตอ้งการ โดยคลิก
เลือกเมนู Modify > Document จะปรากฏจอภาพ 

 
 
รายละเอียดบนจอภาพ Document Properties ประกอบด้วย 
 Dimension   ก าหนดขนาดความกว้าง และความสูงของ Stage ปกติโปรแกรมจะ 

ก าหนดค่าเร่ิมต้องขนาด Stage เท่ากับ  550 x 400 Pixel สามารถก าหนด 
ขนาดของ Stage ได้เล็กที่สุด 1x1 Pixel และ ใหญ่ที่สุด 2880 x 2880 Pixel  

 Match  ก าหนดขนาดของ Stage ตามตัวเลือก ดังนี้ 
 * ปุ่ม Printer  ขนาดของ Stage เท่ากับขนาดกระดาษปกติที่เครื่องพิมพ์สามารถพิมพไ์ด ้
 * ปุ่ม Contents ขนาดของ Stage เท่ากับรายละเอียดที่แสดงในไฟล์เอกสาร 
 * ปุ่ม Default ขนาดของ Stage เท่ากับค่าเร่ิมต้น คือ 500 x 400 Pixel 
 Background Color ก าหนดสีฉากหลังของ Stage 
 Fame Rate  ก าหนดจ านวนเฟรมที่ต้องการแสดงภายใน 1 วินาที 
 Ruler Units  ก าหนดหน่วยของ Ruler 
 ปุ่ม  Make Default เปลี่ยนค่าที่ก าหนดให้เป็นค่าเร่ิมต้นของโปรแกรม 
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การย่อ หรอืขยาย Stage  
การเปลี่ยนมุมมองของจอภาพ Stage โดยการย่อ หรือ ขยายจอภาพ Stage เพื่อความสะดวกในการ
สร้างไฟล์เอกสาร Flash สามารถท าได้ ดังนี ้
  คลิกปุ่มเครื่องมอื Zoom    ที่อยู่ในส่วนของชุดเครื่องมือ View จากนั้นคลิกเลอืกปุ่มเครื่องมอื 
Enlarge   เพื่อขยายขนาด หรือคลิกปุ่มเครื่องมอื Reduce   เพื่อย่อขนาดจาก ชุดเครื่องมือ 
Options  
  

     
จอภาพแสดงปุ่มเคร่ืองมือ Zoom ในจอภาพ View และปุ่มเครื่องมือย่อยในจอภาพ Options 

 คลิกเลือกเมนู View > Zoom In / Zoom Out / Magnification > เลือกขนาดจอภาพที่ต้องการแสดง  
 
 
 
 
 
 
 
 
 
 
 

จอภาพแสดงการใช้ค าสั่ง / ขยายจากเมนู View 
 คลิกปุ่ม   ที่อยู่ด้านขวามือของแถบเครื่องมือ Edit Symbol จะปรากฏจอภาพย่อยให้เลือกขนาด
จอภาพที่ต้องการแสดง  

 
จอภาพแสดงการใช้ค าสั่งย่อ / ขยาย จากแถบเครื่องมือ 

 Edit Symbol     
       

            

Zoom 

ย่อขยายขนาดจอภาพ 

ขยายขนาดจอภาพ 

แสดงจอภาพ Stage ทั้งหมด 

แสดงอ็อบเจ็กต์
ทั้งหมดบน Stage 
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 หน้าต่าง Scene   

ในหนึ่งมูฟวี่อาจจะประกอบไปด้วยหลาย Scene ก็ได้ สามารถจัดการ Scene เหล่านั้นใน 
หน้าต่างScene ได้ 

 

กรณีที่มูฟว่ีมีหลาย Scene สามารถจัดการได้ในหน้าต่าง Scene 

 การจัดการกับไฟล์เอกสาร Flash 

เมื่อเข้าสู่โปรแกรม Flash CS5 โปรแกรมจะให้เลือกสร้างไฟล์เอกสารใหม่ เมื่อสร้าง 
ไฟล์เอกสาร Flash ขึ้นมาใหม่แล้ว ผู้เรียนสามารถก าหนดรูปแบบของไฟล์เอกสาร Flash ใหม่ได้ 
เช่น ก าหนดขนาด อัตราการแสดงต่อเฟรม (Framerate) สีพ้ืน และคุณสมบัติอื่นๆ ได้ที่จอภาพของ 
Document Properties นอกจากนี้เมื่อผู้ใช้ต้องการสร้างไฟล์เอกสารใหม่โดยใช้ค าสั่ง File > New.. 
โปรแกรมจะให้เลือกสร้างไฟล์เอกสารใหม่ โดยต้องการให้ไฟล์เอกสารใหม่ซ้อนทับกับไฟล์
เอกสารเดิม หรือสร้างไฟล์เอกสารใหม่จาก Template 

 การสร้างไฟล์เอกสาร Flash ใหม่ 

เมื่อผู้ใช้ต้องการสร้างไฟล์เอกสารใหม่ท าได้โดยคลิกเมนู File > New.. จะปรากฏจอภาพ New 
Document ให้เลือกชนิดไฟล์เอกสาร เมื่อสร้างเสร็จแล้วไฟล์เอกสารใหม่จะซ้อนทับกับไฟล์
เอกสารเดิม 

       
รูปจอภาพแสดงการสร้างไฟล์เอกสาร  Flash 
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 การสร้างไฟล์เอกสาร flash โดยใช้ Templates  

Template คือ แบบส าเร็จรูปที่โปรแกรมสร้างขึ้นมา เพื่อใช้เป็นต้นแบบของการสร้างไฟล์ 
เอกสาร  Flash เพื่อให้สามารถสร้าง Movie Flash ได้อย่างรวดเร็ว และง่ายดายมากย่ิงขึ้น 
ตัวอย่าง การสร้างไฟล์เอกสาร Flash โดยใช้ Template 

1. เปิดโปรแกรม Flash CS5 จะปรากฏจอภาพ ให้เลือกรูปแบบของ Template ที่ต้องการ 

 
 

จอภาพแสดงให้เลือกสร้าง หรือเปิดเอกสารเมื่อเรียนโปรแกรม Flash CS5 
2. เมื่อเลือกรูปแบบของ Template ที่ต้องการแล้วจะปรากฏจอภาพ New from Template ใน

กรณีที่ต้องการสร้างเอกสาร Template ขึ้นมาใหม่ให้ คลิกเมนู File > New จะปรากฏ
จอภาพ New from Template  
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3. คลิกเลือกชนิดของ Template ที่ช่องรายการ “ Category” และเลอืกรายการ Template ที่ช่อง 
“Templates” โดยสามารถดูภาพตัวอย่างของ Template ที่เลือกได้ที่จอภาพ Preview และดู
รายละเอียดของ Template ได้ใน Description 

4. คลิกปุ่ม OK เพื่อสร้างไฟล์เอกสารใหม่ตามรูปของ Template ที่เลือก  

 

นอกจากนี้เมือ่ผู้ใช้สร้างมูฟว่ีแล้วต้องการบันทึกเก็บไว้เป็น Template ของตนเอง เพื่อ 
น าไปใช้งานต่อไป สามารถท าได้โดยเลือกเมนู File > Save AS Template 
ตัวอย่าง การบันทึกไฟลม์ูฟว่ีเก็บไว้เป็น Template  

1. สร้างมูฟว่ี 
2. คลิกเลือกเมนู File > Save As Template  
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3. ก าหนดช่ือ Template ที่ช่อง “Name” ก าหนดประเภท Category และก าหนดรายละเอียดที่
ช่อง “Description” ตามต้องการ 

 

4. คลิกปุ่ม Save โปรแกรมจะสร้างและเก็บ movie ดังกล่าวไว้ใน Library “Template” ของ 
Flash CS5ให้โดยอัตโนมัติ  

5. ผู้เรียนสามารถดูไฟล์ Template ที่สร้างเก็บไว้ได้โดยคลิกเลือกเมนู File > New From 
Template  
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 การบันทึกไฟล์ 

การเข้าสู่โปรแกรม Flash CS5 โปรแกรมจะให้สร้างไฟล์เอกสาร Flash ขึ้นมาใหม่ 
โดยก าหนดช่ือไฟล์ว่า Untitled-1 และเมื่อผู้ใช้ต้องการสร้างไฟล์เอกสารใหม่ โดยคลิกเลือกค าสั่ง 
File > New โปรแกรมจะก าหนดช่ือไฟล์ว่า Untitled – 2 โดยเรียงตัวเลขตามล าดับการสร้างไฟล์
เอกสารใหม่ทุกครั้ง ช่ือไฟล์เอกสารนี้จะเปลี่ยนไปตามที่ผู้ใช้ก าหนดเมื่อมีการบันทึกไฟล์ โดยเลือก
ค าสั่งดังนี้ 

 ค าสั่ง File > Save   ส าหรับการบันทึกไฟล์ครั้งแรก หรือบันทึกเพื่อปรับปรุง 
ไฟล์ที่ได้แกไ้ข 

 ค าสั่ง File > Save As  ส าหรับการบันทึกไฟล์เอกสารในชื่อใหม่ หรือบันทึก 
ไฟล์เอกสารในรูปแบบของ Flash MX เวอร์ชันเก่า 

เมื่อเลือกค าสั่งใดค าสั่งหนึ่งจะปรากฏจอภาพ Save หรือ Save As ซึ่งทั้งสองจอภาพมี 
ลักษณะคล้ายดังรูป 
 
 
 
 
 
 
 
 
 
 
 
 

เลือกโฟลเดอร์ที่ต้องการเก็บบันทึกไฟล์ ก าหนดช่ือไฟล์ในช่อง “File Name” และเลือก
เวอร์ชันไฟล์เอกสาร Flash ที่ต้องการบันทึกที่ช่อง Save as type โดยปกติโปรแกรมจะบันทึกใน
ไฟล์ในรูปแบบ flash CS5 Document (*.Fla) แต่ผู้เรียนสามารถเลือกบันทกึไฟล์เอกสาร flash หรือ 
flash MX Document (Flash MX เวอร์ชันเก่า) ได้อีกด้วยจากนั้นคลิกปุม่ Save เพื่อบันทึกไฟล์
เอกสาร 

เลือกเวอร์ชันที่ต้องการบันทึก 

ก าหนดชื่อไฟล์เอกสาร Flash 

เลือกโฟลเดอร์ที่ต้อง 
การเก็บบันทึกไฟล์ 

บันทึกไฟล์ 

ยกเลิกการบันทึกไฟล์ 
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 รูปแบบไฟล์เอกสาร Flash   

รูปแบบของไฟล์เอกสาร Flash แบ่งออกเป็น 2 แบบคือ 
 Flash Movie (*.fla) เป็นการบันทึกข้อมลูในเอกสารเพื่อเก็บไว้ในรูปแบบไฟล์

ธรรมดาของโปรแกรม Flash ซึ่งผู้ใช้สามารถเปิดไฟล์เพื่อแก้ไข เพิ่มเติม หรือ
ทดสอบการแสดงได้ตามต้องการไฟล์ลกัษณะนีจ้ะมีขนาดใหญ่ และไม่สามารถ
น าไปแสดงได้จริง เป็นเหมือนไฟล์ต้นฉบับ 

 Flash Player หรือ Shockwave Flash (*.swf) เป็นการบันทึกไฟล์เพื่อน าไปใช้
งานจริงบน Web Browser ซึ่งไฟล์จะมีขนาดเล็ก แต่ผู้ใช้จะไม่สามารถแกไ้ขไฟล์
ในลักษณะนีไ้ด ้

 การสร้างชิ้นงานด้วยโปรแกรม Flash 

 การสร้างช้ินงานเป็นพื้นที่ส าคัญส าหรับการสร้างภาพนิ่งภาพเคลื่อนไหว (Animation)  การ
สร้างเว็บไซต์ รวมถึงการประยุกต์ใช้งานอย่างอื่นด้วย เพราะเคร่ืองมือต่างๆ ของโปรแกรม Flash มี
ประสิทธิภาพไม่น้อยไปกว่าเคร่ืองมือตกแต่งที่ รู้จักกันดี เช่น Photoshop, Illustrator และยังมี
รูปแบบเฉพาะตัวที่ไม่เหมือนใครให้ติดตามดูได้จากข้อถัดไป 
 หลังจากสร้างช้ินงานแล้วเราจะท าการเปลี่ยนให้เป็นซิมโบลซึ่งจะจ าเป็นส าหรับการสร้าง
ภาพเคลื่อนไหวและสามารถใช้ลูกเล่นของเคร่ืองมือใน Flash ได้อย่างเต็มที่ต่อไปได้อย่างสะดวก
ขึ้น มาดูกันว่าเครื่องมือส าหรับการสร้างงานด้วย Flash มีอะไรกันบ้าง ดังนี้  
รูปแบบการวาด 
 การวดภาพกราฟิกใน Flash แบ่งออกเป็น 2 รูปแบบดังนี้ 

วาดแบบ Object Drawing 

     รูปทรงที่ได้จาการวาดแต่ละคร้ังจะเป็นอิสระจากกัน และเมื่อมีการวางซ้อนทับกันก็ไม่
มีผลท าให้ออบเจ็คอื่นหรือตัวเองเปลี่ยนแปลงรูปร่างในการวาดแบบนี้ให้คุณคลิกเลือก  Object 
drawing ที่ออปช่ันของเครื่องมือไว้ก่อนลงมือวาด 

    
           รูปทรงที่วาดหรือน ามาวางซ้อนกัน จะเป็นอิสระจากกัน 
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วาดแบบ Merge Drawing 

  รูปทรงนี้ได้จากการวาดจะมีผลต่อรูปทรงอื่น โดยเมื่อมีการวาดหรือน าไปวางซ้อนทับกัน
จะท าให้คุณสมบัติของพ้ืนภาพหรือเส้นแปรเปลี่ยนไป ในการวาดแบบนี้ให้คุณยกเลิกการเลือก  
Object Drawing ที่ออปช่ันของเครื่องมือ ก่อนลงมือวาด 
 การซ้อนทับของรูปทรงในแบบ Merge Drawing 
ในการวาดแบบ Merge Drawing เมื่อวาดรูปทรงใดๆ ทับรูปทรงอื่นที่อยู่ด้านล่าง (หรือย้ายรูปทรงที่
วาดด้วยวีนี้มาซ้อนทกัน) จะมีผลกับรูปทรงทั้งสอง โดยแยกได้เป็นกรณีต่างๆ ดังนี้ 
 

 รูปทรงทั้งสองไม่มีเส้นและมีสีพื้นเป็นสี
เดียวกัน จะท าให้รูปทรงทั้งหมดถูกรวมเป็นช้ิน
เดียวกัน 

 

 รูปทรงทั้งสองไม่มีเส้นและมีสีพื้นที่ไม่ใช่สี
เดียวกัน จะท าให้รูปทรงทั้งสองแยกออกจากกัน 
โดยที่รูปด้านบนยังเหมือนเดิมแต่รูปด้านล่างจะ
ถูกตัดและส่วนที่ถูกทับจะหายไป 

 

 รูปทรงทั้งสองหรือชิ้นใดชิ้นหนึ่งมีเส้น  
(ไม่ว่าพื้นและเส้นจะเป็นสีเดียวกันหรือคนละสี) 
จะท าให้รูปทรงทั้งสองแยกออกจากกัน โดยที่
รูปทรงด้านบนยังเหมือนเดิมแต่รูปด้านล่างจะ
ถูกตัด และหากดับเบิลคลิกเลือกที่รูปทรงใดก็
จะได้เส้นกรอบตามรูปทรงนั้น ดังภาพ 
 

  
                                  
                              วาดรูปทรงซ้อนกัน 
 

 
 
 

ดับเบิลคลิกบนรูปสีเขียว     ดับเบิลคลกิบนรูปสีฟ้า 
แล้วคลิกลากออกมา          แล้วคลิกลากออกมา 

 รูปทรงที่ มี เฉพ าะเส้ น  ไม่ ว่ าจะ เป็น สี
เดียวกันหรือไม่ก็ตาม เส้นจะสามารถแยกส่วน
ออกตามมุมหรือตรงจุดที่เส้นตัดกันได้ 
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 ลากเส้นตรง (Line Tool)  

เส้นตรงเป็นพื้นฐานของรูปทรงต่างๆ การลากเส้นตรงด้วยเครื่องมือของโปรแกรม Flash จะ 
คล้ายกับเครื่องมือในโปรแกรมตกแต่งภาพทั่วไป แต่จะมีความสามารถบางอย่างที่แตกต่างกันไป 
ดังตัวอย่างต่อไปนี้  

1. คลิกปุ่ม Line Tool      ทีทู่ลบ็อกซ์ 
2. คลิกเลือกสีของเส้นจากช่อง Stroke Color  
3. คลิกเมาส์ที่จุดเร่ิมต้นบนสเตจ (พื้นที่ว่าง) คลิกค้างไว้แล้วลากเมาส์ก าหนดความยาวและ

ทิศทางของเส้นตรง แล้วปล่อยเมาส์ก็จะได้เส้นตรงตามที่ต้องการ หรือจะลองลากเมาส์
สร้างเส้นตรงอื่นๆ ได้อีกตามต้องการ รวมถึงการเปลี่ยนสีสันที่หลากหลายให้เกิดความ
คล่องตัวมากขึ้น  

4. หากต้องการวาดให้เป็นรูปต่างๆ ให้ดรากส์เมาส์ลากจนกลายเป็นรูปที่ต้องการ ซ่ึง Snap to 
Objects (เป็นรูปวงกลมที่ปรากฏพร้อมเส้นที่วาด) จะช่วยท าให้ขณะที่วาดอยู่นั้น มุมมอง
เส้นจะสามารถชนกันและกลายเป็นเส้นที่ต่อเนื่องกันโดยอัตโนมัติ 

 
 
 
           
      
           
           
           
 
            
 
 
 
 
 
 

ดรากส์เมาส์จนกลายเป็นรูปที่ต้องการ 4 ดรากส์เมาส์ลาก 3 

คลิกเลือกสีของเส้น 

1 

2 
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ปรับเปล่ียนแก้ไขเส้นระดับพื้นฐาน 
 เส้นที่ได้สร้างขึ้นมาให้มีรูปร่างต่างๆ นั้นสามารถปรับเปลี่ยนแก้ไขในภายหลังได้ ไม่ว่าจะ
เป็น สี ขนาด รูปร่างของเส้น ซึ่งเมื่อต้องการปรับเปลี่ยนค่าต่างๆ ให้ท าการเปิด Properties Panel 
ขึ้นมาเท่านั้น ก็สามารถก าหนดค่าต่างๆ ได้ตามต้องการ 

1. คลิกปุ่ม Arrow Tool    ที่ทูลบ็อกซ์ และดรากส์เมาส์คลุมเลือกออบเจ็กต์ 
2. คลิกเมนู Window เลือกค าสั่ง Properties ให้ปรากฏเครื่องหมายถูก 
3. คลิกเลือกสีของเส้นจากช่อง Stroke Color 
4. คลิกเลือกความหมายของเส้นจากช่อง Thickness 
5. คลิกเลือกรูปแบบของเส้นจากช่อง Type 
6. คลิกเมาส์ที่พื้นงาน 1 คร้ัง จากนั้นเส้นที่ เลือกไว้จะมีสี ความหนา และรูปแบบ

เปลี่ยนไปตามค่าที่ก าหนด  
           
           
           
           
           
           
           
           
           
           
           
           
           
 
 
 
 
 
 

1.คลิกปุ่ม Arrow Tool 
3.คลิกเลือกสีของเส้น 

4. คลิกเลือกความหนาของเส้น 

5. คลิกเลือกรูปแบบของเส้น 

6.คลิกเมาส์ที่พื้นงาน 1 คร้ัง 
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ปรับเปล่ียนแก้ไขระดับสูง  
ส าหรับวิธีการเปลี่ยนแปลงแก้ไขเส้นนั้น ยังสามารถก าหนดรูปแบบต่างๆ เพิ่มเติมขึ้นได้อีก 

เช่น หากเป็นเส้นประก็สามารถก าหนดว่าต้องการให้ความถี่ของระยะห่างระหว่างเส้นประแต่ละ
เส้นนั้น มีระยะความห่างมากน้อยเท่าไรมีความเข้มจางเท่าไร เป็นต้น ซ่ึงค่าต่างๆ ที่มีให้ก าหนดนั้น
จะขึ้นอยู่กับรูปร่างลักษณะของเส้นแต่ละรูปแบบที่ได้เลือกไว้ 

1. คลิกปุ่ม    ที่ Properties Panel จะปรากฏไดอะลอ็กบ็อกซ์ Stoke Style ขึ้นมา 

 
 

2. ก าหนดค่าระยะห่างของเส้นประจากช่อง Dot Spacing เมื่อก าหนดเรียบร้อยแล้วให้
คลิกที่ปุ่ม OK 

 
 

 3.   จะได้รูปภาพเส้นประที่มีระยะความห่างมากขึ้นตามค่าทีก่ าหนดไว้ 
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 สร้างเส้นปากกาด้วยเคร่ืองมือ Pen Tool 

หน้าที่การท างานของเครื่องมือ Pen Tool คือ ใช้ส าหรับวาดเส้นตรงและเส้นโค้งไปในทิศทาง 
ต่างๆ เส้นที่สร้างจากเคร่ืองมือ Pen Tool จะมีความยืดหยุ่นต่อการท างานมากกว่าเส้นที่สร้างจาก
เครื่องมือ Line Tool เนื่องจากปรากฏแฮนเดิลขึ้นมาในระหว่างท างาน ท าให้สามารถดัดเส้นให้เป็น
รูปร่างตามต้องการได้อย่างสะดวกขึ้น 
 นอกจากการก าหนดสีเส้นแล้ว ออบเจ๊กต์ที่สร้างจากเคร่ืองมือ Pen Tool ยังสามารถก าหนด
ใส่สีให้กับพื้นได้ ซึ่งหลังจากการวาดเป็นที่เรียบร้อยแล้ว  

1. คลิกปุ่ม Pen Tool    ที่ทูลบ็อกซ ์
2. คลิกเลือกสีเส้นจากช่อง Stroke Color 
3. คลิกเลือกพื้นจากช่อง Fill Color  
4. คลิกเมาส์ที่พื้นที่งานจะปรากฏจุดแฮนเดิลขึน้มา 
5. ดรากส์เมาส์ลากพร้อมทั้งดึงแฮนเดิลไปในทิศทางและต าแหน่งที่ต้องการ จากนั้นจะ

ปรากฏเส้นขึ้นมา 
6. ให้ดรากสเ์มาส์ลากจนกลายเป็นรูปที่ต้องการ เมื่อต าแหน่งเร่ิมต้น จุดแฮนเดิลจะ

เช่ือมต่อเข้าหากันเพื่อเป็นการส้ินสุดการสร้างออบเจ็กต์และจะปรากฏสีพ้ืนที่ก าหนด
ขึ้นมาให้โดยอัตโนมัติ 

 
 

 
 
 
 
 
 
 
 
 
 
 

1. คลิกปุ่ม Pen Tool 

2.คลิกเลือกสีเส้น 
3. คลิกเลือกสีพ้ืน 

4. คลิกเมาส์ที่พ้ืนงาน 
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   ปรับเปลีย่นแก้ไขสีพืน้ 
 การสร้างออบเจ็กต์โดยใช้เคร่ืองมือ Pen Tool แตกต่างจากการสร้างโดยใช้เคร่ืองมือ Line 
Tool ก็คือ ออบเจ็กต์ที่สร้างขึ้นมานั้นสามารถก าหนดใส่สีพื้นเติมได้ตามต้องการ และส าหรับค่า
อื่นๆ ไม่ว่าจะเป็นการปรับเปลี่ยน สีเส้น ขนาด รวมถึงรูปร่างลักษณะของเส้นที่สร้างขึ้นจะสามารถ
ก าหนดได้เช่นเดิม 

1. คลิกปุ่ม Arrow Tool   ที่ทูลบ็อกซ์ และดรากส์เมาส์คลุมเลือกออบเจ็กต์ 
2. คลิกเมนู Window > Properties ให้ปรากฏเครื่องหมายถูก 
3. คลิกเลือกพื้นจากช่อง Fill Color 
4. คลิกเมาส์ที่พื้นงาน 1 ครั้ง จากนั้นพื้นของออบกเจ็กต์ที่เลือกไว้จะมีเปลี่ยนแปลงไป

ตามค่าที่ก าหนด 
 

 
 
 
 
 
 
 
 
 
 
 
 

5. ดรากส์เมาส์ลากพร้อมดึง 6.ดรากส์เมาส์จนกลายเป็นรูปที่ต้องการ 

1.คลิกปุ่ม Arrow Tool 

2.คลิกเมนู Window > Properties 

3.คลิกเลือกสีพ้ืน 
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 สร้างเส้นดินสอด้วยเคร่ืองมือ Pencil Tool 

หน้าที่การท างานของเครื่องมือ Pencil Tool คือ ใช้ส าหรับวาดเส้นตรงและเส้นโค้งในรูปแบบ 
อิสระ ซึ่งการสร้างออบเจ็กต์จากเคร่ืองมือ Pencil Tool นี้ จะสามารถก าหนดรูปแบบลักษณะของ
ดินสอที่ใช้ในการวาด เช่น ต้องการให้ลายเส้นที่ได้เป็นเส้นตรง เส้นโค้ง หรือเส้นอิสระยังสามารถ
ก าหนดเปลี่ยนแปลงสีเส้น สีพื้น ขนาด และรูปร่างของเส้นในภายหลังได้เช่นเดียวกันอบเจ็กต์ที่
สร้างขึ้นมาจากเครื่องมืออื่นๆ 

1. คลิกปุ่ม Pencil Tool   ที่ทูลบ็อกซ์ และดรากส์เมาส์คลุมเลือกออบเจ็กต์ 
2. คลิกเลือกลักษณะของดินสอที่ใช้ในการวาดที่ Options จากส่วนของ Pencil Mode 

 เลือก Straighten   เส้นที่ได้จะเป็นเส้นตรง 
 เลือก Smooth  เส้นที่ได้จะเป็นเส้นโค้ง 
 เลือก Ink    เส้นที่ได้จะเป็นเส้นอิสระ 

3. ดรากส์เมาส์วาดเป็นรูปต่างๆ ตามต้องการ 
 

 
 
 
 
 
 
 
 
 
 
 

4. คลิกเมาส์ที่พ้ืนงาน 1 คร้ัง 

1. คลิกปุ่ม Pencil Tool 

2. คลิกเลือกลักษณะของดินส่อที่  
                ใช้ในการวาด 

Straighten Smooth Ink 

3. ดรากส์เมาส์วาดเป็นรูปต่างๆ 
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 การสร้างวงกลมด้วยเคร่ืองมือ Oval Tool  

หน้าที่ของเครื่องมือ Oval Tool   คือ ใช้ส าหรับวาดรูปวงกลม และวงรี ซ่ึงหาก 
ต้องการเปลี่ยนแปลงสี เส้น สีพื้น ขนาด และรูปร่างของเส้น ในภายหลังก็สามารถท าได้เช่นเดียวกัน
ออบเจ็กต์ที่สร้างขึ้นมาจากเครื่องมืออื่นๆ  

1. คลิกปุ่ม Rectangle Tool           ที่ทูลบ็อกซ์ค้างไว้ จะปรากฏเครื่องขึ้นมา ให้เลือกมาที่ Oval 
Tool  

 
 
 
 
 

2. คลิกเลือกสีเส้นของรูปวงกลมจากช่อง Stroke Color 
3. คลิกเลือกพื้นของรูปวงกลมจากช่อง Fill Color 
4. กดปุ่ม Shift ที่คีย์บอร์ดค้างไว้ พร้อมทั้งดรากส์เมาส์ลากที่พื้นงาน จากมุมหนึ่งทแยงไปยัง

มุมหนึ่ง จะเกิดรูปวงกลมขึ้นมา 
5. คลิกเลือกเปลี่ยนสีพื้นของวงกลมจากช่อง Fill Color  
6. ดรากส์เมาส์ไปในทิศทางและต าแหน่งที่ต้องการ โดยไม่ต้องกดปุ่ม Shift ค้างไว้ จากนั้นจะ

เกิดรูปวงรีขึ้นมา  
 
 
 
 
 
 
 
 
 
 
 

1. คลิกปุ่ม Oval Tool 

2. คลิกเลือกสีเส้นของรูปวงกลม 

3. คลิกเลือกสีพ้ืนของรูปวงกลม 

4.กดปุ่ม Shift ที่คีย์บอร์ดพร้อมทั้งดรากส์เมาส์ลาก 
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การดัดแปลงรปูทรง 

เราสามารถดัดแปลงรูปวงกลมหรือวงรี ให้มีลักษณะเป็นเส้ียวหรือเจาะเป็นรูปโดนัท โดยก าหนดค่า
ต่างๆ บน Property inspector ซึ่งมีส่วนประกอบดังนี้ 

 

 

 

 

 

 

 

 

 

 

 

6.คลิกดรากส์เมาส์ลาก 

5.คลิกเลือกเปล่ียนสีพ้ืนของวงกลม 

 ค่ามุมเริ่มต้นและมุม 
  สุดท้ายเสี้ยววงกลม 

เลือกเพ่ือวาดรูปทรงแบบ
ปิด 

รัศมีของวงกลมวงใน 

ค่ามุมเริ่มต้นและมุม 
สุดท้ายเสี้ยววงกลม 
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  Start angle (ค่ามุมเริ่มต้น) และ End angle (มุมสุดท้าย) ใช้เพื่อนการดัดแปลงรูปทรงให้มี
ลักษณะเป็นเสียว ซ่ึงมีทิศทางดังนี้ 

 

                                   

 Inner radius รัศมีของวงกลมในซึ่งจะเจาะทะลุรูปวงกลมวงนอกจนกลายเป็นรูปโดนัท โดยมี
ค่าเป็นเปอร์เซ็นต์เมื่อเทียบกับรัศมีของวงกลมวงนอก 

 

 

 

 Close path เลือกออปช่ันน้ีเพื่อให้รูปทรงเป็นแบบปิด ซึ่งจะสามารถเติมสีพื้นได้ 
แต่หากยกเลกิออปช่ันน้ีก็จะได้รูปทรงแบบเปิด ซึ่งจะสามารถเติมสีพื้นได้ แต่หาก
ยกเลิกออปช่ันน้ีก็จะได้รูปทรงแบบเปิดซึ่งมีเฉพาะเส้นเท่าน้ัน 

Note : นอกจากการคลิกลากปรับจุดควบคุมแลว้  เราอาจปรับแต่งโดยใช้วีการแก้ไขค่าต่างๆ 
บน Property inspector ได้  

 

 

 

270 

225 

180 

135 

90 

45 

0,360 

315 
Start : 90 
End : 225 

Start : 90 
End : 315 

Start : 225 
End : 90 

ตัวอย่างผลลัพธ์จากค่ามุมต่างๆ  

ตัวอย่างผลลัพธ์จากค่าเปอร์เซ็นต์ต่างๆ  

Inner radius : 50 Inner radius : 25 Start : 90 
End : 225 

Start : 90 
End : 225 

แก้ไขค่ารัศมีวงกลมวงใน 
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 การสร้างสี่เหล่ียมด้วยเคร่ืองมือ Rectangle Tool  

หน้าที่การท างานของเครื่องมือ Rectangle Tool  คือ  ใช้ส าหรับวาดรูปส่ีเหลี่ยมผืนผ้า และ 
สี่เหลี่ยมจัตุรัส แต่คุณสมบัติที่ เพิ่มเติมส าหรับการท างานของเคร่ืองมือ Rectangle Tool นี้  คือ 
สามารถก าหนดมุมของส่ีเหลี่ยมก่อนที่จะท าการวาดได้ด้วย ซึ่งหากก าหนดค่าตัวเลขมากขึ้นเท่าไร
สี่เหลี่ยมที่ได้ก็จะมีมุมที่มนมากขึ้นเท่านั้น 

1. คลิกปุ่ม Rectangle Tool    ที่ทลูบ็อกซ์ 
2. คลิกเลือกสีเส้นของรูปสี่เหลี่ยมจากช่อง Stroke Color 
3. คลิกเลือกสีพื้นของรูปสี่เหลี่ยมจากช่อง Fill Color 
4. คลิกลากในแนวทแยงให้ได้ขนาดและรูปทรงตามต้องการ 

 

                                          
 

 
 
 
 
 
 
 
 

1.คลิกปุ่ม Rectangle Tool 

2. เลือกสีเส้นของ
รูป 

3. เลือกสีพ้ืนของรูป 

4. คลิกลากในแนวทแยงให้ได้ขนาดรูปตามต้องการ 

ก าหนดคุณสมบัติของเส้นและพื้น 

ก าหนดความโค้งของมมุต่างๆ 
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Note :  
 การวาดรูปทรงสี่เหลี่ยมมุมฉากให้ก าหนด Conner radius เป็นค่า 0 pixels เท่านั้นโดยคลิกปุ่ม 

  
 ถ้าวาดรูปด้วยวิธี Object Drawing หลังจากวาดแล้วรูปทรงนั้นจะถูกเลือกอยู่ซึ่งถ้าจะวาดรูปที่ 2 
ต่อไป ก็จะไม่สามารถก าหนดคุณสมบัติบน Property inspector ได้ เพราะจะเป็นการไปเปลี่ยน
คุณสมบัติของรูปทรงเดิม ดังนั้นก่อนวาดรูปที่ 2 จะต้องยกเลิกการเลือกรูปทรงแรก โดยกดคีย์ Esc 
  
 
ก าหนดความโค้งของมมุต่างๆ  
 ในขั้นตอนการวาด เราสามารถปรับความโค้งของแต่ละมุมได้ โดยก าหนดค่ารัศมีมีมุมโค้ง
บน Property inspector ซึ่งค่าบวกจะให้ผลเป็นมุมโค้งออก ส่วนค่าลบจะให้ผลเป็นมุมเว้าเข้า 
 
 
 
 
 
 
 
 
 
 
ตัวอย่างผลลัพธ์จากการก าหนดค่ารัศมีมุมโค้งแบบต่างๆ  

 
 

                                   
 

ก าหนดรัศมีมุมโค้ง 

คลิกเพื่อลอ็ค   หรือยกเลิกล็อค     
ในการก าหนดให้ทุกมุมมีคาทา่กัน 

คลิกเพื่อตั้งค่ารัศม ี
ทั้งหมดกลับเป็น 0 

เลือนแถบ    เพื่อปรับค่ามุมโค้ง 
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ปรับแต่งรูปทรงหลังการวาด 

เฉพาะกรณีที่วาดด้วยเครื่องมือ  Rectangle Primitive จะสามารถดัดแปลงรูปทรงภายหลังได้

โดยใช้เครื่องมือ  Selection คลิกเลือกออบเจ็ค แล้วคลิกลากปรับจุดควบคุมแต่ละมุมได้ ดังนี้ 
 

 
ตัวอย่างการปรับแต่งรูปทรงเพิม่เติม 

               
 

 สร้างตัวอักษรด้วยเคร่ืองมือ Text Tool  

หน้าที่การท างานของเครื่องมือ Text Tool คือ ใช้ส าหรับพิมพ์ข้อความตัวอักษร ในลักษณะให้ 
ขยายไปตามแนวระยะบรรทัดและให้ขยายไปในลักษณะเป็นพารากราฟ โดยเมื่อท าการพิมพ์
ข้อความที่ต้องการเรียบร้อยแล้ว ยังสามารถก าหนดรูปแบบ ขนาด สี ตัวหนา ตัวเอียง ลักษณะการ
จัดวาง การจัดย่อหน้า ระยะห่างระหว่างตัวอักษร ระยะห่างระหว่างข้อความแต่ละแถว ในภายหลัง
ได้อีกตามต้องการ 

1. คลิกปุ่ม Text Tool    ที่ทูลบ็อกซ ์
2. คลิกเลือกสีของตัวอักษรจากช่อง Fill Color 
3. คลิกเมาส์ที่พื้นงาน 1 คร้ัง จากนั้นพิมพ์ข้อความตามต้องการ จะเห็นว่ากล่องขอ้ความ

จะมีวงกลมเล็กๆ อยู่ด้านบนขวามอื พร้อมกับถูกขยายขนาดออกมาในแนวนอนตาม
จ านวนข้อความที่ก าลังพิมพ์อยู่ 

 

ปรับความโค้งของมุมบนขวา 

ปรับความโค้งของมุมล่างซ้าย 

ปรับความโค้งของมุมบนซ้าย 

ปรับความโค้งของมุมล่างขวา 
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4. คลิกเลือกสีของตัวอักษรจากช่อง Fill Color 
5. ดรากส์เมาส์ลากก าหนดขนาดของพารากราฟเป็นที่รูปสี่เหลี่ยม สามารถสังเกตเห็นได้

ว่า กล่องข้อความจะมีสี่เหลี่ยมเล็กๆ อยู่ด้านบนขวามือ จากนั้นให้ท าการพิมพ์ข้อความ
ตามต้องการ แต่หากพิมพ์ข้อความจนเกินบรรทัดแล้ว ข้อความต่อไปจะถูกตัดขึ้นเป็น
บรรทัดใหม่ให้โดยอัตโนมัติ 

 

ส่วนประกอบ Properties ของเคร่ืองมือ Text Tool 
 ข้อความตัวอักษรที่ได้ท าการพิมพ์ขึ้นมา สามารถท าการแก้ไขในภายหลังให้มีความ
แตกต่างกันไปตามต้องการได้ไม่ว่าจะเป็นการก าหนดรูปแบบ ขนาด สี ตัวหนา ตัวเอียง ลักษณะ
การจัดวาง การจัดย่อหน้า ระยะห่างตัวอักษร ระยะห่างระหว่างข้อความแต่ละแถว ฯลฯ ส าหรับการ
ปรับเปลี่ยนแก้ไขค่าต่างๆ นั้น ให้ท าการคลิกเมนู Window > Properties ให้ปรากฏเคร่ืองหมายถูก 
และต่อไปนี้เป็นส่วนประกอบค าสั่งๆ ที่มีอยู่ใน Properties ให้ปรากฏเคร่ืองหมายถูก และต่อไปนี้
เป็นส่วนประกอบค าสั่งต่างๆ ที่มีอยู่ใน Properties ของเครื่องมือ Text Tool  

1. คลิกปุ่ม Text Tool 

2. คลิกเลือกสีของตัวอักษร 

3. คลิกเมาส์ที่พ้ืนงาน 1 คร้ัง 
     จากนั้นพิมพ์ข้อความ 
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ปรับแต่งออปชันตัวอักษร 
 โดยปกติแล้วข้อความที่พิมพ์จะมีคุณสมบัติตามรูปแบบเดิมที่เคยใช้ครั้งล่าสุด แต่คุณ
สามารถเปลี่ยนออปช่ันเหล่านีไ้ด้ใหม่ก่อนที่จะพมิพ์ข้อความ หรือถา้จะปรับแต่งข้อความที่พิมพ์ไป
แล้วจะต้องเลือกข้อความที่ต้องการเสียก่อนแล้วจึงเปลี่ยนออปช่ัน 
 
 
 
 
 
 
 
 

เลือกประเภทข้อความ 

ขนาดของกรอบข้อความและต าแหน่ง
ของข้องความ 

คลิกเลือกแนวข้อความ 

ก าหนดออปช่ันตัวอกัษรและย่อหน้า 

ฟอนต์ตัวอักษร 

ระยะห่างตัวอักษรโดยรวม 

รูปแบบการแสดงตัวอักษร 

เปลี่ยนเป็นตัวยก / หอ้ย 
ระยะห่างระหว่างคู่อกัษร 

สีตัวอักษร 

ขนาดตัวอักษร 
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ปรับแต่งออปชั่นย่อหน้า 
 เป็นการก าหนดลักษณะการจัดย่อหน้า เช่น การจัดชิดขวา, ชิดซ้าย, กึ่งกลาง, จัดระยะห่าง
ระหว่างบรรทัด หรือ ต้ังย่อหน้าให้มีการเย้ือง เป็นต้น 
 
 
 

 
 
 
 
 

ปรับเปล่ียนแก้ไขตัวอักษรระดับพื้นฐาน 

 หลังจากที่ได้ท าความรู้จักกับส่วนประกอบหน้าที่การท างานของปุ่มเคร่ืองมือต่างๆ ที่อยู่ใน 
Properties ของเคร่ืองมือ Text Tool ไปแล้ว ต่อไปนี้จะได้เรียนรู้ขั้นตอนวิธีการใช้เคร่ืองมือต่าง ๆ 
พร้อมทั้งผลลัพธ์ที่ได้จากการใช้งานปุ่มค าสั่งเหล่านั้น 

1. ดรากส์เมาส์เลือกหัวข้อความที่ตอ้งการจะท าการปรับแก้ไข 
2. คลิกเลือกรูปแบบตัวอักษรที่ต้องการจากช่อง Font  
3. คลิกก าหนดขนาดตัวอักษรจากช่อง Font size โดยย่ิงก าหนดค่ามากขึ้นเท่าไร ตัวอักษร

ก็จะมีขนาดใหญ่มากขึ้นเท่านั้น 
4. คลิกเลือกสีที่ต้องการจากช่อง Text Fill Color 

 

จัดให้ซ้ายขวาตรงกันทุกบรรทัด
(ยกเว้นบรรทัดสุดท้ายของย่อหน้า) 

รูปแบบการเยื้องและระยะ
บรรทัด 

จัดย่อหน้าชิดซ้าย จัดย่อหน้ากึ่งกลาง 

จัดย่อหน้าชิดขวา 
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1. ดรากส์เมาส์เลือกข้อความ 

2.คลิกเลือกรูปแบบตัวอักษร 

ข้อความที่เลือกไว้จะมีรูปแบบ
ตัวอักษรเปล่ียนแปลงไป 

ข้อความที่เลือกไว้จะมีขนาด
ตัวอักษรเปล่ียนไป 

3.คลิกก าหนดขนาดตัวอักษร 

4.คลิกเลือกสี 

ข้อความที่เลือกไว้จะมีสีเปล่ียนแปลงไป 
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5. คลิกปุ่ม Change direction   เพื่อก าหนดเปลี่ยนทิศทางให้ตัวอักษรวางอยู่ใน
แนวนอนหรือแนวตั้ง 

 
 
 
 
 
 
 
 

 
 
 
 
 

6. คลิกปุ่ม Center Justify   ข้อความตัวอักษรทั้งหมดจะถูกวางไว้ตรงกลางของกล่อง
ข้อความ 

 

7. คลิกปุ่ม Right / Bottom Justify    ข้อความตัวอักษรทั้งหมดจะถูกวางไว้ชิดด้านขวา
ของกลอ่งข้อความ 

 
 

8. คลิกปุ่ม Full Justify      ข้อความตัวอักษรบรรทัดที่ยาวที่สุดจะถูกขยายขนาดออก
จนกระทั่งเต็มกล่อง 

ข้อความที่เลือกไว้จะถูกวาง
ในแนวตั้งทางด้านขวา 

6.คลิกปุ่ม Change direction 
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9. คลิกก าหนดระยะห่างระหว่างตัวอักษรจากช่อง Letter spacingโดยหากก าหนดตัวเลข
เป็นค่าบวกระยะห่างระหว่างตัวอักษรก็จะถูกเพิ่มมากขึ้น 
 

 
 

 
 
 
 
 
 

10. คลิกก าหนดต าแหน่งตัวอักษรจากปุ่ม   
* Normal   ตัวอักษรจะอยู่ในลักษณะปกติไม่คลกิเลือกที่ปุม่ใด 
* Toggle the Superscript  ตัวอักษรที่เลือกจะถูกยกขึ้นเมือ่คลกิที่ปุ่ม   
* Toggle the  Subscript  ตัวอักษรจะกลายเป็นตัวห้อยเมื่อคลิกที่ปุ่ม  

 
 
 
 
 
 
 
 
 
 
 

คลิกก าหนดระยะห่าง
ระหว่างตัวอักษร 

ข้อความทั้งหมดจะมีระยะห่าง
ระหว่างตัวอักษรเพ่ิมมากข้ึน 

ข้อความที่เลือกจะถูกยกข้ึน 

11.คลิกก าหนดต าแหน่งตัวอักษร 
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  Font Rendering Method 

 การเลือกแสดงผลของ Font ต่างๆ ใน Flash นั้น เราสามารถก าหนดใช้ให้เหมาะสมกับการ
ใช้งานแต่ละประเภทที่แตกต่างกันได้ 

  

- Use Device Fonts เป็นการเลือก Font จากเครื่องคอมพิวเตอร์ที่แสดงผล เพื่อการ
ประหยัดไฟล์ซึ่งโดยปกติแล้ว Static Text ที่ใช้ใน flash เมื่อมีการแสงผลโปรแกรมจะ
ท าการ Create Outline ให้กลายเป็น shape เพื่อไปแสดงผลที่ใดก็ได้ แต่ทั้งนี้ก็ท าให้
ขนาดไฟล์ใหญ่โตตามไปด้วยในกรณีที่การใช้ Text มากๆ ดังนั้นหากว่าท่านมีเนื้อหา
ของ Text ค่อนข้างมาก อาจใช้ Device Fonts ในการลดขนาดไฟล์ลงได้ แต่ทั้งนี้
ข้อจ ากัดกอ็ยู่ตรงที่ใช้ Device Fonts ในการลดขนาดไฟลล์งได้ แต่ทั้งนี้ข้อจ ากัดก็อยู่
ตรงที่  Font ที่เลือกใช้ ต้องเป็น Font มาตรฐาน โดย Flash ได้ก าหนด Font ที่ใช้
ส าหรับ Device ไว้ 3 รูปแบบ คือ 

1. _sans ส าหรับผู้ใช้ Font ใกล้เคียงกับตระกูล Helvetica หรือ Arial 

2. _serif ส าหรับผู้ที่ใช้ Font ใกล้เคียงกับตระกูล Time Roman 

3. _typewriter ส าหรับผู้ที่ใช้ Font ใกล้เคียงกับตระกูล Courier 

- Bitmap text (no anti-alias) ใช้ในกรณีที่ต้องการพิมพ์ Text ขนาดเล็ก เนื่องจาก Text 
ที่เป็นค่าเร่ิมต้นของ Flash นั้นจะเป็นลักษณะ Anti-Alias ซึ่งหมายถึง Text ที่มีการท า
ขอบให้ฟุ้งเพื่อไม่ให้แสดงผลเป็นเหลี่ยมแบบ Pixel โดยให้ผลสวยงามกับ Text ที่
ค่อนข้างใหญ่ แต่กลับกันเมือ่ใช้กับ Text ที่เล็ก ก็จะท าให้เบลอ และอ่านไม่รู้เร่ือง 
ดังนั้นกรณีที่ Text ในงาน Flash ค่อนข้างเล็ก (12 px ลงไปแล้วแต่รูปแบบของ Font) 
ควรเลือกใช้เป็น  Bitmap Text 
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- Anti-Alias for animation  จากที่กล่าวมาข้างต้น Text ประเภทนี้ใช้กับตัวหนังสือ
ขนาดทั่วๆ ไปถึงขนาดใหญ่ แต่กรณีของ Anti-Alias for animation นั้นถูกออกแบบมา
ให้ใช้กับ Text ที่จะมีการเคลื่อนที่  

- Anti-Alias for readability ใช้กับ Font ขนาดทั่วไปถึงขนาดใหญ่เช่นเดียวกัน แต่
แสดงผลได้คมชัดสวยงามกว่าแบบ for  animation แต่ขณะเดียวกันถ้าน ามา
เคลื่อนไหว ก็จะไม่ Smooth เท่าแบบ for  animation 

- Custom anti-alias ส าหรับการต้ังค่า Anti-Alias ด้วยตนเอง 
 

URL Link 

การพิมพ์ Text ใน flash ทุกค านั้น มีคุณสมบัติพิเศษว่า สามารถท า Link ได้ทันที โดยท า 
ไฮไลท์บริเวณที่ต้องการท า Link จากนั้นให้ใส่ URL ของเว็บไซต์ใดก็ได้ หรือหากเป็น
เว็บไซต์ของเราเองก็สามารถใส่ช่ือไฟล์ html ได้เช่นกัน 
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หน่วยการเรียนรู้ที่ 3   

 เลือกและเปลี่ยนขนาดของออบเจ็กต์ 
  มาตรฐานการเรียนรู้ / ตัวชี้วัด 

 กลุ่มสาระการงานอาชีพและเทคโนโลยี   
                สาระที่  3  เทคโนโลยีสารสนเทศและการสื่อสาร 
                เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การ
เรียนรู้   การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม  

               ตัวชี้วัด   
                1.   ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน  

  สาระส าคัญ 
                รู้จักเครื่องมือในกลุ่มการเลือกวัตถุ สามารถใช้เครื่องมือในกลุ่มนี้เพื่อเปลี่ยนรูปทรง 
ขนาดของช้ินงาน  เคลื่อนย้ายต าแหน่ง 

  สาระการเรียนรู้ 
          -  ความรู้ 
              1.  การเลือกวัตถไุด้ถูกตอ้งตรงตามความต้องการ 
              2.  สามารถเปลี่ยนรูปทรงวัตถุ ได้  
              3.  สามารถปรับขนาด และ ย้ายวัตถุได้ 
         -  ทักษะ / กระบวนการ 
               1.  ศึกษาและอธิบายการใช้เครื่องมือในกลุ่มเครื่องมอืการเลือก 
               2.   ฝึกปฏิบัติเกี่ยวกับเครื่องมือได้คล่องแคล่ว  
         -  คุณลักษณะที่พึงประสงค์ 
               1.  มีวินัย 
               2.  ใฝ่เรียนรู้ 
               3.  มุ่งมั่นในการท างาน  
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 หลังจากที่ได้สร้างออบเจ็กต์ขึ้นมาเรียบร้อยแล้ว หากต้องการท าการเคลื่อนย้ายออบเจ็กต์
เหล่านั้นไปในต าแหน่งต่างๆ สามารถท าได้โดยใช้เคร่ืองมือ Arrow Tool แต่หากต้องการย่อ ขยาย
ขนาดด้วยแล้ว จะต้องสั่งงานจากเคร่ืองมือ Free Transform Tool และเพื่อความยืดหยุ่นต่อการ
ท างานในการเลือกในลักษณะเป็นพื้นที่อิสระก็สามารถท าได้ด้วยเคร่ืองมือ Lasso Tool ซึ่งในบทนี้
จะได้เรียนรู้ขั้นตอน การใช้งานเคร่ืองมือทั้งหมดที่ใช้ในการเลือกและปรับเปลี่ยนขนาด รวมถึง
เครื่องมือ Distort ที่ใช้ส าหรับบิดออบเจ็กต์ และเคร่ืองมือ Envelope ที่ใช้ในการบิดดัดออบเจ็กต์ให้
มีรูปร่างตามต้องการ 

 เลือกและเคล่ือนย้ายด้วยเคร่ืองมือ Arrow Tool  
หน้าที่การท างานของเครื่องมอื Arrow Tool คือ ใช้ส าหรับคลิกเพื่อเลือกออบเจ็กต์ จากนั้นจึง 

สามารถเคลื่อนย้ายเปลี่ยนไปวางไว้ยังต าแหน่งต่างๆ บนพื้นงานได้ตามตอ้งการ  
ส าหรับการใช้งานเครื่องมือ Arrow Tool สามารถแบ่งขั้นตอนการท างานได้  2 ลักษณะ คอื การ 

ใช้เคร่ืองมือ Arrow Tool เพื่อเลือกและเคลื่อนย้ายซิมโบล ส่วนอีกลักษณะหนึ่งคือ การใช้เครื่องมือ 
Arrow Tool เพื่อเลือกและเคลือ่นย้ายออบเจ็กต ์

 การเลือกและเคลื่อนย้ายซิมโบล 
 หลังจากได้ท าการสร้างออบเจ็กต์และแปลงให้เป็นซิมโบลประเภทต่างๆ แล้วนั้น หากมี
การน ามาเรียกใช้งานและต้องการเคลื่อนย้ายซิมโบลหรือภาพกราฟิกไปในทิศทางต าแหน่งที่
ต้องการ สามารถท าได้ง่ายดังนี้ 

1. คลิกปุ่ม Arrow Tool   ที่ทูลบ็อกซ ์
2. คลิกซิมโบลที่ตอ้งการเคลื่อนย้ายต าแหน่ง 
3. ดรากส์เมาส์ลากไปวางยังต าแหน่งที่ต้องการ จากนั้นซิมโบลหรือภาพกราฟิกจะเคลื่อน

เปลี่ยนต าแหน่งจากเดิม 
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 การเลือกและเคลื่อนย้ายออบเจ็กต์ 
 การเลือกและเคลื่อนย้ายออบเจ็กต์ที่สร้างจากเครื่องมือต่างๆ สามารถคลิกแยกเป็นส่วน 
ประกอบแต่ละส่วนได้ เช่น คลิกเลือกเฉพาะเส้น หรือคลิกเลือกเฉพาะพื้นของออบเจ็กต์ อีกทั้ง
เมื่อวางออบเจ็กต์ซ้อนทับกนัแล้ว ยังสามารถคลิกเฉพาะส่วนที่วางซ้อนทับกันให้แยกออกมา
ต่างหาก ท าให้สะดวกและยืดหยุ่นต่อการสร้างออบเจ็กต์รูปทรงต่างๆ ได้มากขึ้น  

1.คลิกปุ่ม Arrow Tool 

2.คลิกซิมโบล 

3.ดรากส์เมาส์ลากไปวางยังต าแหน่งที่ต้องการ 



 
 

53 

1. คลิกปุ่ม Arrow Tool    ที่ทูลบ็อกซ ์
2. ดรากส์เมาส์คลุมออบเจ็กต์ที่ต้องการ 
3. ดรากส์เมาส์ไปวางยังต าแหน่งที่ต้องการ จากนั้นออบเจ็กต์จะเคลื่อนเปลี่ยนต าแหน่ง

ไปจากเดิม 
4. คลิกเมนู Edit แล้วเลือกค าสั่ง Copy เพื่อท าการคดัลอกออบเจ็กต์ที่เลือกไว้ 
 

 
 
  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
5. คลิกเมนู Edit > Paste เพื่อท าการวางออบเจ็กต์ที่ได้คัดลอกไว้ 
6. ดรากส์เมาส์ไปวางยังต าแหน่งที่ต้องการ จากนั้นออบเจ็กต์ใหม่ที่ได้ท าการคัดลอกไว้

จะเคลื่อนเปลี่ยนต าแหน่งไปจากเดิม 

1.คลิกปุ่ม Arrow Tool 

2.ดรากส์เมาส์ลากคลุม 

4.คลิกเมนู Edit > Copy 

3.ดรากส์เมาส์ลากไปวางยัง 
    ต าแหน่งที่ต้องการ 
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ออบเจ็กต์ส่วนเลือกไว้จะถูกลบออกไป 

7. คลิกออบเจ็กต์ในส่วนที่วางซ้อนทับกัน และกดปุม่ Delete ที่คีย์บอร์ด เพื่อท าการลบ
ออบเจ็กต์ส่วนที่ได้เลือกไว้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

5.คลิกเมนู Edit > Paste  
in place  

6.ดรากส์เมาส์ไปวางยัง    
   ต าแหน่งที่ต้องการ 

7.คลิกออบเจ็กต์ในส่วนที่วาง  
   ซ้อนทับกันและกดปุ่ม Delete 
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8. คลิกที่พื้นของออบเจ็กต์ จากนั้นโปรแกรมจะตัดเฉพาะพื้นที่ส่วนที่ได้เลือกไว้ 
9. ดรากส์เมาส์ไปวางยังต าแหน่งที่ต้องการ พ้ืนที่บริเวณส่วนพื้นของออบเจ็กต์จะเคลื่อน

เปลี่ยนต าแหน่งไปจากเดิม 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 เลือกพ้ืนที่บางส่วนด้วยเคร่ืองมือ Subselection Tool  
หน้าที่การท างานของเครื่องมอื Subselection Tool คือ ใช้ส าหรับคลิกเลือกส่วนของ 

ออบเจ็กต์จากนั้นจึงสามารถท าการเคลื่อนย้าย ปรับเปลี่ยนออบเจ็กต์ให้มีรูปร่างต่างๆ ตามต้องการ 
ดังตัวอย่างต่อไปนี้จะเป็นการสร้างออบเจ็กต์รูปวงกลมขึ้นมา จากนั้นจึงใช้เครื่องมือ 

Subselection Tool ในการปรับเปลี่ยนรูปวงกลมให้กลายเป็นรูปใบพัด 

1. คลิกปุ่ม  Oval Tool    ที่ทูลบ็อกซ ์
2. ดรากส์เมาส์ลากจากมมุหนึ่งทแยงไปยังอีกมุมหนึ่งให้เป็นรูปวงกลม 

3. คลิกปุ่ม Subselection Tool     ที่ทูลบ็อกซ์ 
4. คลิกที่รูปวงกลมจากนัน้จะปรากฏจุดแฮนเดิลขึ้นมา ให้ดรากส์เมาส์ปรับเปลี่ยนรูปร่าง

ตามต้องการ 
 

8.คลิกที่พ้ืนของออบเจ็กต์ 

9.ดรากส์เมาส์ลากไปวางยังต าแหน่งที่ต้องการ 
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5. คลิกจุดแฮนเดิลและท าการปรับเปลี่ยนรูปร่างตามต้องการ 
6. คลิกที่แขนของแฮนเดิลจากนั้นให้ดรากส์เมาส์ลากปรับรูปร่าง 
7. คลิกและปรับแต่งเพิ่มเติมจนกลายเป็นรูปใบพัด 

 
 
 
 
 

2.ดรากส์เมาส์ลาก 

1.คลิกปุ่ม Oval Tool 

3.คลิกปุ่ม Subselection Tool 

4.คลิกที่รูปวงกลม และดรากส์
เมาส์ปรับเปล่ียนรูปร่าง 
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 เลือกพ้ืนที่อิสระด้วยเคร่ืองมือ Lasso Tool 
หน้าที่การท างานของเครื่องมือ  Lasso Tool  คือ ใช้ส าหรับคลิกเลือกพื้นที่ของออบเจ็กต์ใน 

ลักษณะเป็นรูปทรงอิสระได้ตามต้องการ แต่ไม่เพียงแค่การเลือกพื้นที่เป็นรูปทรงอิสระเท่านั้น 
เครื่องมือ Lasso Tool ยังมีคุณสมบัติพิเศษช่วยให้การเลือกพื้นที่ได้ง่ายย่ิงขึ้นด้วย Magic Wand หรือ
หากต้องการเลือกพื้นที่เป็นรูปทรงหลายเหลี่ยมก็สามารถท าได้เช่นกัน  

1. คลิกเมนู File เลือก  Import  แล้วเลือกค าสั่ง Import to stage เพื่อน าภาพกราฟิกเข้ามา
ใช้ในโปรแกรม  

2. คลิกเมนู Modify เลือก Break Apart เพื่อแยกองค์ประกอบของภาพกราฟิกออกมาเป็น
ส่วนๆ  

 

6.คลิกที่แขนของแฮนเดิลจากน้ัน 
    ให้ดรากส์เมาส์ลาก 
 

5.คลิกจุดแฮนเดิลและท าการปรับเปล่ียนรูปร่าง 
 

7.คลิกและปรับแต่งเพ่ิมเติม 
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3. คลิกปุ่ม Lasso Tool   ที่ทูลบ็อกซ์ 
4. คลิกเมาส์ที่พื้นงาน 1 คร้ัง จากนั้นดรากส์เมาส์ลากเป็นพื้นที่รูปทรงอิสระ จนกระทั่งถึง

ต าแหน่งเร่ิมต้นเพื่อเป็นการปิดเส้น Selection  

5. คลิกปุ่ม Arrow Tool   ที่ทูลบ็อกซ ์
6. ดรากส์เมาส์ลากบริเวณพื้นที่ที่เลือกไว้ไปวางยังต าแหน่งใหม่ที่ต้องการ 

1.คลิกเมนู File > Import  
> Import  to stage 

2.คลิกเมนู Modify > Break Apart 
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 เลือกพื้นที่โดยเปรยีบเทียบจากค่าสีด้วยเครื่องมอื Magic Wand  
 Magic Wand เป็นเคร่ืองมือย่อยของ Lasso Tool มีหน้าที่ในการใช้เลือกพื้นที่เช่นเดียวกัน 
แต่ลักษณะการท างานของเคร่ืองมือ Magic Wand นั้น เป็นการเลือกโดยการเปรียบเทียบจากค่าสี
ของพ้ืนที่บริเวณที่ใกล้เคียงกัน หากก าหนดค่าตัวเลขมากขึ้น โปรแกรมก็จะท าการค านวณและเลือก 
Penumbra พื้นที่ที่มีค่าสีใกล้เคียงกันให้เป็นบริเวณมากย่ิงขึ้น ส าหรับการใช้งาน Magic Wand 
สามารถท าได้โดยคลิกเลือก Options ของเครื่องมือ Lasso Tool  

5.คลิกปุ่ม Arrow Tool 

4.คลิกเมาส์ที่พ้ืนงาน 1 คร้ัง จากนั้น 
ดรากส์ เมาส์ลากเป็นพ้ืนที่รูปทรงอิสระ 

3.คลิกปุ่ม Lasso Tool 

6.ดรากส์เมาส์ลากบริเวณพ้ืนที่ที่เลือกไว้ 
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1. คลิกปุ่ม Lasso Tool  ที่ทูลบ็อกซ์  

2. คลิกปุ่ม Magic Wand    ที่ Option ของเครื่องมือ Lasso Tool   
3. คลิกเมาส์ที่พื้นงาน 1 คร้ัง โปรแกรมจะค านวณและเลือกพื้นที่บริเวณที่มีค่าสีใกล้เคียง

กันโดยอัตโนมัติ 
4. ทดลองดรากส์เมาส์บริเวณพื้นที่ที่เลือกไว้ออกมา หากเห็นว่าช่วงพ้ืนที่ที่ได้เลือกไว้มี

บริเวณน้อยเกินไปให้ก าหนดค่าพื้นที่และท าการคลิกเลือกใหม่ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. คลิกปุ่ม Magic Wand Properties   ที่ Option ของเครื่องมือ Lasso Tool  

1.คลิกปุ่ม Lasso Tool 

3.คลิกเมาส์ที่พ้ืนที่งาน 1 คร้ัง 

2.คลิกปุ่ม Magic Wand 

4.ดรากส์เมาส์บริเวณพ้ืนที่ที่เลือกไว้ 
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6. ก าหนดค่าพื้นที่บริเวณค่าสีที่ต้องการให้เลือกลงในช่อง Threshold หากก าหนดค่า
ตัวเลขมากขึ้น โปรแกรมก็จะท าการค านวณและเลือกพื้นที่ทีม่ีค่าใกล้เคียงกันให้เป็น
บริเวณมากย่ิงขึ้น 

7. คลิกปุ่ม OK เพื่อยืนยันค าสั่ง 
8. ทดลองดรากส์เมาส์บริเวณพื้นที่ที่เลือกไว้ออกมา จะเห็นว่าช่วงพ้ืนที่ที่ได้เลือกไว้มี

บริเวณมากขึ้นตามค่าทีก่ าหนด 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.คลิกปุ่ม Magic Wand 
 Properties 

6.ก าหนดค่าพ้ืนที่บริเวณค่าสี 7.คลิกปุ่ม OK 

8.ดรากส์เมาส์บริเวณพ้ืนที่ที่เลือกไว้ 
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 เลือกพื้นที่เป็นรูปทรงหลายเหลีย่ม Polygon Mode  
 Polygon Mode เป็นเคร่ืองมือย่อยของ Lasso Tool มีหน้าที่ในการใช้เลือกพื้นที่ให้เป็น
ลักษณะรูปทรงหลายเหลี่ยม ขั้นตอนการเลือกท าได้โดยคลิกต าแหน่งเร่ิมต้นก่อน แล้วคลกิเมาส์ลาก
ตามบริเวณพื้นที่ที่ต้องการ จากนั้นให้ดับเบิ้ลคลิก เพื่อสิ้นสุดการเลือก ซ่ึงพ้ืนที่ที่ได้จะมลีักษณะ
เป็นรูปทรงหลายเหลี่ยม  

1. คลิกปุ่ม Lasso Tool  ที่ทูลบ็อกซ ์

2. คลิกปุ่ม Polygon Mode   ที่ Options ของเครื่องมอื Lasso Tool  
3. คลิกเมาส์ที่พื้นงาน 1 คร้ังแล้วลากตามแนวบริเวณพื้นที่ที่ต้องการ จากนั้นดับเบิลคลิก

เพื่อสิ้นสุดการเลือก 
4. ดรากส์เมาส์ลากบริเวณพื้นที่ที่เลือกไว้ไปวางยังต าแหน่งใหม่ที่ต้องการ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. คลิกปุ่ม Lasso Tool 

3.คลิกเมาส์ที่พ้ืนงาน 1 คร้ัง  
   จากนั้นให้ดับเบิลคลิก 

2.คลิกปุ่ม Polygon Mode 

4.ดรากส์เมาส์ลากบริเวณพ้ืนที่ที่เลือกไว้ 
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 ในเร่ืองของการเลือกวัตถุมีการเลือกอยู่ 3 แบบด้วยกัน คือ  
1. Arrow Tool  
2. Subselection Tool 
3. Lasso Tool  

ให้ผู้สอนอธิบายให้ผู้เรียนฟังเกี่ยวกับเครื่องมือ Arrow Tool ว่าเป็นเครื่องมือที่ใช้เลือก 
ออบเจ็กต์ และลากเคลื่อนย้ายออบเจ็กต์ไปยังต าแหน่งที่ต้องการ และมีการใช้งาน 2 แบบคือ 

- การใช้เครื่องมือ Arrow Tool เพื่อเลือกและเคลื่อนย้ายซิมโบล 
- การใช้เครื่องมือ Arrow Tool เพื่อเลือก และเคลื่อนย้ายออบเจ็กต์ 

ส่วนที่  2 เคร่ืองมือ Subselection Tool ใช้ส าหรับคลิกเลือกส่วนของออบเจ็กต์สามารถท าการ
เคลื่อนย้าย หรือปรับเปลี่ยนออบเจ็กต์ให้มีรูปร่างตามที่ต้องการในส่วนนี้ จะให้ผู้สอนสอนให้
ผู้เรียนสังเกตเมาส์จะมีสัญลักษณ์แต่ละตัวแตกต่างกัน 

- ถ้าเมาส์มีลักษณะ   สามารถที่จะเปลี่ยนแปลงรูปร่างของออบเจ็กต์ได้ 

- ถ้าเมาส์มีลักษณะ   สามารถที่จะเคลื่อนย้ายออบเจ็กต์นั้นได้ 
ส่วนที่ 3 เครื่องมือ Lasso Tool ใช้ส าหรับคลิกเลือกพื้นที่ของออบเจ็กต์ในลักษณะเป็นรูปทรงอิสระ
ในของการเลือกนี้ ยังมีคุณสมบัติพิเศษช่วยให้การเลือกพื้นที่ได้ง่ายย่ิงขึ้นด้วย Magic Wand ให้
ผู้สอน สอนว่า Magic Wand คือมีหน้าที่ในการใช้เลือกพื้นที่ เช่นเดียวกัน โดยการเปรียบเทียบจาก
ค่าสีของพ้ืนที่บริเวณที่ใกล้เคียงกัน  
 เมื่อผู้สอนให้ผู้เรียนรู้จักกันเครื่องมือทั้ง 3 ตัวนี้ แล้วลองให้ผู้เรียนลองท าตามผู้สอนและให้
ฝึกจนเกิดความช านาญ 
 

 หมุนและปรับเปล่ียนขนาดด้วยเคร่ืองมือ Free Transform Tool  
หน้าที่การท างานของเคร่ืองมือ Free Transform Tool คือ  ใช้ส าหรับคลิกเพื่อหมุน  หรือ

ปรับเปลี่ยนขนาดของออบเจ็กต์และภาพกราฟิกไปในทิศทางต่างๆ อีกทั้งที่ Options ยังมีปุ่มค าสั่งที่
น่าสนใจไว้ให้เลือกใช้งานเพิ่มเติม เช่น ปุ่มDistort มีหน้าที่ในการบิดออบเจ็กต์ให้มีรูปร่างแปลกไป
จากเดิม ปุ่ม Envelope มีหน้าที่ในการบิดดัด ส่วนประกอบต่างๆ ให้มีรูปร่างตามต้องการ  

1. คลิกปุ่ม Free Transform Tool  ที่ทูลบ็อกซ ์
2. คลิกที่ออบเจ็กต์จะปรากฏจุดแฮนเดิลขึ้นมา เมือ่เมาส์เป็นลูกศร 2 หัว ให้ดรากส์เมาส์

เพื่อท าการย่อ ขยายขนาดของออบเจ็กต์ 
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3. เมื่อเมาส์เป็นรูปเส้นคู่ขนาน ให้ดรากส์เมาส์เพื่อท าการบิดเอียงออบเจ็กต์ 
4. เมื่อเมาส์เป็นรูปลูกศรวงกลม ให้ดรากส์เมาส์ท าการหมุนออบเจ็กต์ไปในทิศทางต่างๆ  

 
 

1.คลิกปุ่ม Free Transform Tool 

2.คลิกที่ออบเจ็กต์ จากนั้น 
ให้ดรากส์เมาส์ย่อขยายขนาด 

ออบเจ็กต์ที่ได้หลังจากการท าการ
ขยายขนาดเรียบร้อยแล้ว 
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3.ดรากส์เมาส์บิดเอียงออบเจ็กต์ 

ออบเจ็กต์ที่ได้หลังจากท าการบิด
เอียงเรียบร้อยแล้ว 

4.ดรากส์เมาส์หมุนออบเจ็กต์ 

ออบเจ็กต์ที่ได้หลังจากท าการ 
หมุนเรียบร้อยแล้ว 



 
 

66 

 บิด ดัดออบเจ็กต์ด้วย Distort 
 ปุ่ม Distort เป็นเคร่ืองมือย่อยของ  Free Transform Tool เมื่อคลิกที่มุมของจุดแฮนเดิลจะ
เป็นการบิดออบเจ็กต์ให้มีรูปร่างแปลกไปจากเดิม แต่หากคลิกที่ด้านข้างจะเป็นการย่อหรือขยาย
ขนาดของออบเจ็กต์แทน 

1. คลิกปุ่ม Free Transform Tool  ที่ทูลบ็อกซ ์

2. คลิกปุ่ม Distort   ที่ Options ของเครื่องมือ Free Transform Tool  
3. คลิกและท าการดรากส์เมาส์ให้ออบเจ็กต์มีรูปร่างต่างๆ ตามต้องการ  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.คลิกปุ่ม Free Transform Tool 

3.คลิกและท าการดรากส์
เมาส์ 2.คลิกปุ่ม Distort 

ออบเจ็กต์ที่ได้หลังจากท าการบิด
ขนาดเรียบร้อย 
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 บิด ดัดออบเจ็กต์ด้วย Envelope  
 ปุ่ม Envelope เป็นเคร่ืองมือย่อยของ Free Transform Tool เมื่อคลิกที่ออบเจ็กต์จะปรากฎ
จุดแฮนเดิลเหล่านั้น และท าการบิดดัดส่วนประกอบต่างๆ เพื่อให้ออบเจ็กต์มีรูปร่างตามต้องการได้
อย่างง่ายดาย 

1. คลิกปุ่ม Free Transform Tool    ที่ทูลบ็อกซ์ 

2. คลิกปุ่ม Envelope    ที่ Options ของเครื่องมือ Free Transform Tool  
3. คลิกและท าการดรากส์เมาส์บิดดัดให้ออบเจ็กต์มรูีปต่างๆ ตามต้องการ  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.คลิกปุ่ม Free Transform Tool 
 

3.คลิกและท าการดรากส์ 
   เมาส์บิดดัด 

2.คลิกปุ่ม Envelope 

ออบเจ็กต์ที่ได้ หลังจากท าการ
บิดดัดจนเป็นที่เรียบร้อยแล้ว 
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หน่วยการเรียนรู้ที่ 4 

  ตกแต่งภาพให้มีสีสันที่สวยงาม 
  มาตรฐานการเรียนรู้ / ตัวชี้วัด 

     กลุ่มสาระการงานอาชีพและเทคโนโลยี   
         สาระที่  3  เทคโนโลยีสารสนเทศและการสือ่สาร 
         เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การเรียนรู้   
การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม  

         ตัวชี้วัด   
            1.  ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน 
     สาระส าคัญ 
               รู้จักกับเครื่องมือใส่สีสันให้กับช้ินงาน เช่น การเปลี่ยนสีเส้นของ สีพ้ืน การไล่เฉดสี 
     สาระการเรียนรู้ 
          -  ความรู้ 
              1.  รู้จักเครื่องมือในการเติมสีสันให้กับช้ินงาน 
              2.  สามารถเติมสี เปลี่ยนสี ในรูปแบบต่างๆ ได้ 
      
    -  ทักษะ / กระบวนการ 
               1.  ศึกษาและอธิบายการใช้เครื่องมือในกลุ่มเครื่องมอืการเติมส ี
               2.   ฝึกปฏิบัติเกี่ยวกับเครื่องมือได้คล่องแคล่ว 
    -  คุณลักษณะที่พึงประสงค์ 
               1.  มีวินัย 
               2.  ใฝ่เรียนรู้ 
               3.  มุ่งมั่นในการท างาน  
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 ส าหรับเร่ืองนี้ผู้เรียนจะได้เรียนรู้การใช้งานเครื่องมือที่ใช้ในเร่ืองเกี่ยวกับสี รวมถึงวิธีการ
ระบายสีด้วยเคร่ืองมือ Brush Tool การลบพื้นที่ส่วนที่ไม่ต้องการด้วยเคร่ืองมือ Eraser Tool และ
การใช้เครื่องมือ Fill Transform Tool เพื่อปรับเปลี่ยนทิศทาง การเทสีของออบเจ็กต์ 

 เปล่ียนสีเส้นขอบด้วยเคร่ืองมือ Ink Bottle Tool  

หน้าที่การท างานของเครื่องมือ Ink Bottle Tool คือ ใช้ส าหรับเทสีให้กับพื้นที่เฉพาะบริเวณ 
เส้นของรูปภาพโดยสามารถก าหนดเปลี่ยนแปลงค่าสี ขนาด และรูปร่าง ให้กับเส้นของรูปภาพได้
ใหม่ตามต้องการ 
 แต่หากต้องการเปลี่ยนแปลงสีให้กับพื้นของรูปภาพ โปรแกรมก็ได้เตรียมเครื่องมืออีกชนิด
หนึ่ง คือ Paint Bucket Tool ที่มีหน้าที่ส าหรับเปลี่ยนแปลงค่าสีพื้นของรูปภาพโดยเฉพาะ ซึ่งจะ
กล่าวถึงในเร่ืองถัดไป แต่ส าหรับขั้นตอนการเปลี่ยนแปลงสีเส้นของรูปภาพสามารถท าได้ ดังนี้  

1. คลิกปุ่ม Ink Bottle Tool   ทีทู่ลบ็อกซ ์
2. คลิกเลือกสีของเส้นจากช่อง Stroke Color 
3. คลิกเลือกขนาดของเส้นจากช่อง Stroke Height 
4. คลิกเลือกรูปแบบเส้นจากช่อง Stroke Style  
5. คลิกเทสีพ้ืนที่เส้นบริเวณที่ต้องการ จากนั้นที่เส้นที่เลือกจะมีสีและขนาดเปลี่ยนแปลง

ไปตามค่าทีไ่ด้ก าหนดไว้ 
6. คลิกเทสีพ้ืนที่เส้นบริเวณที่ต้องการจนครบ จากนั้นบริเวณเส้นของรูปภาพจะมีสีและ

ขนาดเปลี่ยนแปลงไป 
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 เปล่ียนสีพื้นด้วยเคร่ืองมือ Paint Bucket Tool  
หน้าที่การท างานของเครื่องมือ Paint Bucket Tool คือ ใช้ส าหรับเทสีให้กับพื้นที่เฉพาะบริเวณ 

พื้นของรูปภาพโดยสามารถก าหนดเปลี่ยนแปลงค่าสีให้กับเส้นของรูปภาพได้ใหม่ตามต้องการ 
ส าหรับขั้นตอนการเปลี่ยนแปลงสีพื้นสามารถท าได้ ดังนี้ 

1. คลิกปุ่ม Paint Bucket Tool    ที่ทูลบ็อกซ์  
2. คลิกเลือกสีของพ้ืนที่ต้องการเทจากช่อง Fill Color 
3. ที่ Options ในส่วนของ Gap Size ให้คลิกเลือกขนาดของสีที่ใช้ปิดช่องว่าง 

1.คลิกปุ่ม 
 Ink Bottle Tool 

5.คลิกเทสีพ้ืนที่เส้นบริเวณ   ที่ต้องการ 

2.คลิกเลือกสี 
ของเส้น 

3.คลิกเลือกขนาดของเส้น 

4.คลิกเลือกรูปแบบเส้น 

6.คลิกเทสีพ้ืนที่เส้นบริเวณที่ต้องการจนครบ 
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 Don’t Close Gaps   ไม่มกีารปิดช่องว่าง 
 Close Small Gaps  ปิดช่องว่างขนาดเล็ก 
 Close Medium Gaps  ปิดช่องว่างขนาดกลาง 
 Close Large Gaps   ปิดช่องว่างขนาดใหญ่ 

4. คลิกเทสีพ้ืนของรูปภาพบริเวณที่ต้องการ จากนั้นพื้นที่บริเวณที่คลิกเลือกจะมีสี
เปลี่ยนแปลงไปตามค่าสีที่ก าหนดไว้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. ทดลองคลกิเลือกรูปแบบ Close Large Gaps 
6. คลิกเทสีพ้ืนของรูปภาพบริเวณที่ต้องการ จะเห็นว่าพื้นที่บริเวณที่ถูกเทสีนั้นมีบริเวณ

น้อยลง 
 
 
 
 

1.คลิกปุ่ม Paint Bucket Tool 

2.คลิกเลือกสีของพ้ืน 

5.คลิกเทสีของรูปภาพบริเวณที่ต้องการ 

3.คลิกเลือกขนาดของสีที่ใช้  
   ปิดช่องว่าง 
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 ระบายสีด้วยเคร่ืองมือ Brush Tool  
หน้าที่การท างานของเครื่องมอื Brush Tool คือ ใช้ส าหรับแปรงระบายสีลงบนภาพ โดย 

สามารถก าหนดสี ขนาด รูปร่างของขนแปรง และลักษณะการแปรงได้ตามต้องการ ส าหรับ 
ขั้นตอนการแปรงสีโดยใช้เครื่องมือ Brush Tool สามารถท าได้ ดังนี้  

1. คลิกปุ่ม Brush Tool  ที่ทูลบ็อกซ ์
2. คลิกเลือกสีของแปรงที่ต้องการระบายจากช่อง Fill Color  
3. ที่ Options ในส่วนของ Brush Mode ให้คลิกเลือกลักษณะการแปรงระบายสี 
 Paint Normal  ระบายสีโดยทับลงบนสีเส้นและสีพ้ืนของภาพเดิม 
 Paint fills   ระบายสีโดยทับลงบนสีพ้ืนอย่างเดียว 
 Paint Behind ระบายสีอยู่ที่ด้านหลังของภาพ 
 Paint Selection ระบายสีภาพเฉพาะพื้นที่ในส่วนที่เลือกไว้ 
 Paint Inside  ระบายสีตามการดรากส์เมาส์ เช่น หากเร่ิมดรากส์เมาส์ที่ด้านใน

ภาพสีก็จะปรากฏเพียงแค่ในภาพเท่านั้น แต่หากเร่ิมดรากส์เมาส์
ที่ด้านนอกของภาพ สีก็จะปรากฏเฉพาะที่พื้นที่ด้านนอกของภาพ 

6.คลิกเทสีพ้ืนของรูปภาพบริเวณที่ต้องการ 

5.คลิกเลือกรูปแบบ  
Close Medium Gaps 
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1.คลิกปุ่ม Brush Tool 

2.คลิกเลือกสีของแปรง 

3.คลิกเลือกลักษณะการแปรง
ระบายสี 4.คลิกเลือกขนาดของแปรง 

5.คลิกเลือกรูปร่างลักษณะ 
   ของแปรง 

6.คลิกเมาส์ท าการระบายสี 

4. คลิกเลือกขนาดของแปรงที่ใช้ในการระบาย จากส่วนของ Brush Size 
5. คลิกเลือกรูปร่างลักษณะของแปรงที่ใช้ในการระบาย จากส่วนของ Brush Shape 
6. คลิกเมาส์ที่พื้นงานและให้ท าการระบายสี จากนั้นจะปรากฏสีขึ้นมาบนภาพตามลกัษณะ

ของแปรงที่ได้เลือกใช้ในการระบายสี 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เม่ือคลิกเลือกลักษณะการแปรงเป็น 
Paint Fills สีที่ระบายจะปรากฏขึ้นมา
เฉพาะพ้ืนของภาพเท่านั้น 
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เม่ือคลิกเลือกลักษณะการแปรงเป็น 
Paint Behind สีที่ระบายจะปรากฏ
ข้ึนมาที่ด้านหลังภาพ 

 

เม่ือคลิกเลือกลักษณะการแปรงเป็น Paint 
Selection สีที่ระบายจะปรากฏขึ้นมา
เฉพาะบริเวณพ้ืนที่ที่เลือกไว้เท่านั้น 

เม่ือคลิกเลือกลักษณะการแปรงเป็น 
Paint Inside สีที่ระบายจะปรากฏ
ข้ึนมา ตามลักษณะการดรากส์เมาส์ 
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1.คลิกปุ่ม Eyedropper Tool 

2.คลิกดูดสีที่ต้องการจากพ้ืนงาน 

 ดูดสีที่ต้องการด้วยเคร่ืองมือ Eyedropper Tool  
หน้าที่การท างานเครื่องมือ Eyedropper Tool คือ ใช้ส าหรับดูดสีที่ต้องการ และเมื่อได้ท าการดูด 

สีเสร็จเรียบร้อยแล้วสามารถน าสีนั้นไปใช้งานต่อได้ เช่น อาจน าไปแทนที่สีที่ได้ตกแต่งไว้จาก
เครื่องมือ Brush Tool หรือแทนที่ส่วนต่างๆ ของภาพได้ตามต้องการ ส าหรับขั้นตอนการดูดและใช้
งานเครื่องมือ Eyedropper Tool สามารถท าได้ ดังนี้ 

1. คลิกปุ่ม Eyedropper Tool   ที่ทูลบ็อกซ ์
2. คลิกดูดสีที่ต้องการจากพื้นงาน จากนั้นที่ช่อง Fill Color จะมีสีเปลี่ยนแปลงไปตามค่าสี

ที่ได้ดูดไว้ และเมาส์จะเปลี่ยนเป็นเคร่ืองมือ Paint Bucket Tool พร้อมกับปรากฏรูป
กุญแจที่แสดงว่าขณะนี้ก าลังล็อคสีที่เลือกอยู่ขึ้นมา 

3. คลิกเทสีที่ได้ดูดไว้ลงบนพื้นงาน จากนั้นพื้นที่บริเวณที่คลิกเลือกจะมีสีเปลี่ยนแปลง
ไปตามค่าสีทีถู่กดูดไว้ 

4. คลิกเทสีที่ได้ดูดไว้ลงบนพื้นงานจนครบตามบริเวณที่ต้องการ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.คลิกเทสีได้ดูดไว้ลงบนพ้ืนงาน 

4.คลิกเทสีได้ดูดไว้ลงบนพ้ืนงานจนครบ 
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 ปรับเปล่ียนทิศทางการเทสีด้วยเคร่ืองมือ Gradient Transform Tool 
หน้าที่การท างานของเครื่องมือ Gradient Transform Tool สามารถแบ่งได้ 2 ลักษณะ คือ 
1. เมื่อท างานกับออบเจ็กต์และได้ท าการเทสีในลักษณะที่มีการไล่เฉดสี (Gradient) เครื่องมือ  
       Gradient Transform Tool จะมีหน้าที่ในการปรับเปลี่ยนทิศทางการไล่เฉดสี รวมถึงปรับ  
       ช่วงโทนสีที่ต้องการให้ปรากฏขึ้นมาได้ตามต้องการ 
2. เมื่อท างานกับภาพกราฟิกและได้สั่งท าการ Break Apart เพื่อแยกองค์ประกอบของภาพ

ออกมาแล้วเคร่ืองมือ Gradient Transform Tool จะมีหน้าที่ในการปรับเปลี่ยนทิศทางของ
ภาพ ส าหรับขั้นตอนการท างานกับเคร่ืองมือ Brush Tool ทั้ง 2 ลักษณะ สามารถแยกเป็น
หัวข้อตามขั้นตอน ดังนี้ 

 

  ปรับเปลี่ยนรัศมีของค่าสี 
 เมื่อท าการเทสีลงบนออบเจ็กต์โดยมีการไล่เฉดสีในลักษณะเป็นรูปวงกลมแล้ว ที่ด้านนอก
จะเป็นสีด า ซึ่งมีความเข้มมากกว่าด้านใน นักเรียนสามารถปรับเปลี่ยนรัศมีของค่าสีด้านนอกและ
ด้านในของรูปวงกลม ให้มีความเข้มจาง มากน้อยตามต้องการได้ ดังนี้ 

1. คลิกเลือกออบเจ็กต์ที่ต้องการเทสี 

2. คลิกปุ่ม Paint Bucket Tool   ที่ทูลบ็อกซ ์
3. คลิกเลือกสีของพ้ืนที่ต้องการเทจากช่อง Fill Color 

 
 
 
 
 
 
 
 
 
 
 
 

2.คลิกปุ่ม Paint Bucket Tool 

1.คลิกเลือกออบเจ็กต ์

3.คลิกเลือกสีของพ้ืน 
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4. คลิกปุ่ม Free Transform Tool    ที่ทูลบ็อกซ์ค้างไว้ จากนั้นเลือก ที่ Gradient 

Transform Tool   
5. คลิกที่ออบเจ็กต์จะปรากฏจุดแฮนเดิลขึ้นมา จากนั้นให้คลิกที่จุดแฮนเดิลรูปวงกลม 

และดรากส์เมาส์ ท าการย่อ ขยายรัศมีของค่าสีที่ได้ในลักษณะเป็นรูปวงกลม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. แต่หากคลิกจุดแฮนเดิลรูปสีเหลี่ยม และดรากส์เมาส์จะเป็นการย่อ ขยายรัศมีของค่าสีที่
ได้เทลงไปในลักษณะเป็นรูปส่ีเหลี่ยมตามแนวนอน 

       
 
 
 
 

6.คลิกที่จุดแฮนเดิลรูปส่ีเหล่ียม และดรากส์เมาส์ 

4.คลิก Gradient 
Transform Tool 

5.คลิกที่ออบเจ็กต์จากนั้นให้
คลิกที่จุดแฮนเดิลรูปวงกลม 
และดรากส์เมาส์ 

รัศมีของค่าสีด้านในจะถูกย่อให้ลดลงใน
ลักษณะเป็นรูปวงกลม พร้อมกับถูกแทนที่
ด้วยค่าสีด้านนอก 
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 ปรับเปลี่ยนการไลเ่ฉดส ี

 การไล่เฉดสีลงบนออบเจ็กต์ไม่เพียงแต่มีลักษณะเป็นรูปวงกลมเท่านั้น แต่หากต้องการไล่
เฉดสีในลักษณะเทสี ไล่เรียงต่อกับไปก็สามารถท าได้เช่นกัน ส าหรับตัวอย่างต่อไปนี้เป็นการไล่
โทนสีเป็นสายรุ้ง จากนั้นจะท าการปรับเปลี่ยนช่วงโทนสี และต่อมาจึงท าการปรับเปลี่ยนทิศ
ทางการเทสีตามล าดับ 

1. คลิกเลือกออบเจ็กต์ที่ต้องการเทสี 

2. คลิกปุ่ม Paint Bucket Tool    ที่ทูลบ็อกซ ์
3. คลิกเลือกสีของพ้ืนที่ต้องการเทจากช่อง Fill Color 

4. คลิกปุ่ม Free Transform Tool    ที่ทูลบ็อกซ์ค้างไว้ จากนั้นเลือก ที่ Gradient 

Transform Tool   
5. คลิกที่ออบเจ็กต์จะปรากฏจุดแฮนเดิลขึ้นมา จากนั้นให้คลิกที่จุดแฮนเดิลรูปสี่เหลี่ยม

และดรากส์เมาส์ท าการย่อ ขยายช่วงโทนสี ของค่าสีที่ต้องการ 
 
 
 
 
 
 
 
 
 
 

รัศมีของค่าสีด้านในจะถูกย่อให้ลดลงใน
ลักษณะเป็นรูปส่ีเหล่ียม พร้อมกับถูก
แทนที่ด้วยค่าสีด้านนอก 

2.คลิกปุ่ม Paint Bucket Tool  

1.คลิกเลือกออบเจ็กต์ 

3.คลิกเลือกสีของพ้ืน 
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6. แต่หากคลิกจุดแฮนเดิลรูปวงกลมด้านบน และดรากส์จะเป็นการหมุนช่วงโทนสีไปใน
ทิศทางต่างๆ 

 
 
 
 
 

 
 
 
 
 
 
 

4.คลิกปุ่ม Gradient Transform Tool 

5.คลิกที่ออบเจ็กต์จากนั้นให้คลิกที่จุด
แฮนเดิลรูปส่ีเหล่ียม และดรากส์เมาส์ 

ช่วงโทนสีด้านในจะถูกย่อให้ลดลงพร้อม
กับถูกแทนที่ด้วยค่าสีด้านนอก 

6.คลิกจุดแฮนเดิลรูปวงกลม
ด้านบนและดรากส์เมาส์หมุน 

ช่วงโทนสีจะถูกหมุนเอียงไป
ตาม ลักษณะการดรากส์เมาส์ 
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  หน้าต่าง Color Swatches 

เปิดหน้าต่าง Color Swatches ด้วยการกดปุ่ม <Shift+F3> จะปรากฏช่องส่ีเหลี่ยมเล็กแสดงสี 
ต่างๆ ให้เลือกซึ่งสีที่ได้จะเป็นสีเดียวกันกับ Swatches ของกรอบแสดงสีของเครื่องมือ Fill ในกล่อง
เคร่ืองมือนั่นเอง นั่นคือเมื่อเราเลือกสีใดจากกรอบแสดงสี หรือหน้าต่าง Color Swatches จะมีค่า
เท่ากันคือ เป็นสีเดียวกันเสมอหากต้องการสีสันมากกว่านี้แนะน าให้ไปเลือกก าหนดเอาในหน้าต่าง 
Color Mixed ในหัวข้อถัดไป 

 

หน้าต่าง Color Swatches 

  หน้าต่าง Color Mixer 

 สิ่งส าคัญของการก าหนดสีสันในหน้าต่างนี้จะอยู่ที่การก าหนดให้ไล่เฉดสีเรียกว่า Gradient 
นอกจากนี้ยังสามารถก าหนดสีในโหมด RGB , HSB รวมถึงการก าหนดค่าความโปร่งใสของการ
เติมสี (Alpha) ได้อีกด้วยเปิดหน้าต่าง Color Mixed ด้วยการกดปุ่ม <Shift+F9> หรือคลิกเมนู 
Window > Design Panels  > Color Mixer การก าหนดสีแบบตางๆ ได้อย่างอิสระในหน้าต่าง Color 
Mixed มีรายละเอียดดังนี้ 

 ก าหนดสีแบบ Gradient ได้เอง 
การใส่สีสันให้กับช้ินงานด้วยวิธีไล่เฉดสีนี้ นอกจากจะช่วยเพิ่มความสนใจให้กับช้ินงานแล้วยัง 

ท าให้มุมมองของภาพ 2 มิติ คล้ายกับภาพ 3 มิติได้อีกด้วย การใส่สีแบบ Gradient มีด้วยกัน 2 
ลักษณะ ที่ต่างกัน คือ การไล่เฉดสีแบบแนวรัศมี (Radial Gradient) ซึ่งวิธีการก าหนดและใช้งานสี
แบบ Gradient ทั้ง 2 แบบมีรายละเอียดดังนี้ 



 

 

81 

 Radial Gradient ไล่เฉดสีแนวรัศมี 
การไล่เฉดสีแบบนี้มักจะใช้กับช้ินงานที่เป็นวงกลม วงรี หรือลักษณะของการสร้างปุ่ม ก็เพราะ 

การไล่เฉดสีแบบนี้ท าให้สร้างมุมมองช้ินงาน ดังตัวอย่างต่อไปนี้  

1. คลิกเครื่องมือสร้างรูปดาวในกล่องเครื่องมอื 
2. คลิกเมาส์แล้วลากสร้างรูปดาวบนสเตจ 

 
 

 
 
 
 
 
 
 
 
3. เปิดหน้าต่าง Color คลิกเมนู Window แล้วเลือก  Color หรือกดปุ่ม <Shift+F9> 

 
 
 
 
 
 
 
 
 
 

4. คลิกตัวเลือก Radial Gradient 
5. ตอนนี้จะเลือกไล่เฉดสีเพียง 2 สีก่อน สังเกตว่าปุ่มเลื่อนปรับสีจะมี 2 อัน อยู่ซ้ายสุดกับ

ขวาสุดบนแถบส ี

2 

1
1 

3 
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6. คลิกถังเติมสีในกลอ่งเครื่องมือ 
7. คลิกเมาส์กลางวงกลม 1 คร้ังเพื่อเปลี่ยนสีให้กับวงกลมตามทีก่ าหนด ซ่ึงจะเห็นว่าสี

ใหม่ที่ได้จะมีการเลือกเอาไว้ 
8. คลิกเมาส์บนปุ่มเลือ่นปรับสีอันขวามือ 

 
 
 
 
 
 
 
 
 
 
 

9. ท าการเปลี่ยนสีโดยคลิกเมาส์บนกรอบแสดงสี 
10. เมื่อเมาส์เปลี่ยนเป็น รูปวงกลม แล้วให้คลิกเมาส์เลือกสีที่ต้องการ 

 
 

 
 
 
 
 
 
 
 
 

6 

4 

7 
8 

5 

9 

10 
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11. คลิกเมาส์ค้างไว้แล้วเลื่อนปุ่มเลือ่นอันขวามือมาทางซ้ายเพื่อปรับขอบเขตของสี ย่ิง
เลื่อนเข้ามามากสีที่ก าลังปรับจะมีพื้นที่ของสีนั้นๆ มากขึ้นและจุดเปลี่ยนของสีจะขยับ
ไปด้วย 

 
 
 
 
 
 
 
 
 
 

12. คลิกเมาส์เติมสีใหม่ให้กับวงกลม 
 
 
 

 
 

 Linear Gradient ไล่เฉดสีในแนวตรง 

ในท านองเดียวกันกับการไล่เฉดสีแบบแนวรัศมี สามารถที่จะใส่สีสันในแนวตรงได้เช่นเดียว  
กัน มักจะนิยมใช้เทคนิคนี้ไปตกแต่งสีพื้นหลังของเว็บไซต์หรือช้ินงานอิสระหรืออาจจะน า ไป
สร้างเป็น Theme เพื่อให้ช้ินงานทั้งหมดมีลวดลายใกล้เคียงกัน ในหัวข้อนี้จะเพิ่มเติมในเร่ืองการ
เพิ่มสีที่จะเข้ามาเกี่ยวข้องกับการไล่เฉดสีด้วย  

1. คลิกเครื่องมือสร้างสี่เหลี่ยมในกล่องเครื่องมือ 
2. ปรับมุมของส่ีเหลี่ยมโดยไปที่ Properties  

  
ใส่ตัวเลข 20 ลงในช่องตัวเลขแล้วคลิกปุ่ม Enter ที่ keyboard 

เล่ือนเพ่ือปรับขอบเขตของสี 
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3. คลิกเมาส์แล้วลากเพื่อสร้างสีเหลี่ยมบนสเตจ 
4. คลิกตัวเลือก Linear Gradient ในหน้าต่าง Color  
5. ตอนนี้จะเลือกไล่เฉดสีเพียง 2 สีก่อน สังเกตว่าปุ่มเลื่อนปรับสีจะมี 2 อัน อยู่ซ้ายสุดกับ

ทางขวาบนแถบสี 
6. คลิกถังเติมสีในกลอ่งเครื่องมือ 
7. คลิกเมาส์กลางสี่เหลี่ยม 1 คร้ัง เติมสีใหม่ที่ได้จะมีการไล่เฉดสี 2 สี 

 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

4 

5 
3 

7 

6 
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8. วางเมาส์ใต้แถบสีสังเกตที่เมาส์จะแสดงเคร่ืองหมาย+ขึ้นมาให้เห็น คลิกเพิ่มปุ่มเลื่อน
ปรับสีขึ้นมาอีก 1 อันตรงการ 

9. คลิกเมาส์ค้างไว้บนลูกศรปรับโทนสี  แล้วเลื่อนขึ้นหรือเลื่อนลงเพื่อให้ได้สีตามที่
ต้องการ 

10. ท าเลือกสีในกรอบใหญ่ โดยการคลิก 1 คร้ัง  
 

 
 
 
 
 
 
 
 
 
 

11. คลิกเมาส์เติมสีใหม่ให้กับสี่เหลี่ยม (หากเมาส์ไม่เปลี่ยนเป็นถังเติมสีให้คลิกเลือก
เครื่องมือเติมสีในกล่องเครื่องมือก่อน) 

 
 

 
 

เพิ่มปุ่มเลื่อนปรับสี 

10 

11 

9 
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12. หากต้องการเอาปุ่มเลื่อนปรับตัวไหนออก ให้คลิกที่ปุ่มนั้นค้างไว้แล้วลากให้ห่างจาก
แถบสีแล้วปล่อยเมาส์ 

 
 

 การปรับแต่งสีแบบ Gradient ด้วยวิธีอ่ืน 

 ใส่ตัวเลขลงในช่องตัวเลขแสดงค่าสี 
โดยการเปลี่ยนตัวเลขค่าสีของแม่สีในช่องโดยตรง ในหน้าต่าง Color  
  ช่อง R จะเป็นสีแดง 
  ช่อง G จะเป็นสีเขียว 
  ช่อง B จะเป็นสีน้ าเงิน 
  ช่อง Alpha จะปรับความโปร่งใสของสีในหน่วยเปอร์เซ็นต์สามารถเลื่อนแถบเลื่อนปรับ 

    ค่าได้หรือจะใส่ตัวเลขลงไปโดยตรงก็ได้ 
 
 
 
 
 
 
 
 
 
 

12 

ใส่ค่าตัวเลขสีลงไปโดยตรงในช่อง 

ปรับค่าความโปร่งใส 
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  โค้ดสี (Hex Color) 
การแสดงโค้ดสี จะแสดงเป็นตัวเลขฐาน 16 จ านวน 6 หลักและขึ้นต้นด้วยเครื่องหมาย #  

เช่น สีแดงจะแทนด้วยโค้ดสี #FF0000 เป็นต้น 
  

 
 

 เปล่ียนพู่กันสีเป็นพู่กันรูปภาพด้วย Pattern 
เปลี่ยนปลายแปรงทาสี หรือปลายพู่กันให้เป็นรูปภาพ  มักพบเห็นโดยทั่วไปในการสร้างงาน 

ด้วยโปรแกรมกราฟิกในโปรแกรม Flash ก็ได้เตรียมคุณสมบัตินี้เอาไว้ให้แล้วเช่นเดียวกัน ตัวอย่าง
ต่อไปนี้นา่จะช่วยให้ความกระจ่างได้เกี่ยวกับเทคนิคนี้  

1. คลิกเมน ูFile > Import > Import to Library  
2. ดับเบิลคลิกเลือกไฟล์รูปที่จะเอามาท าปลายพู่กัน 

 
 

 
 
 
 
 
 
 
 
 
 
 

ใส่โค้ดสีลงไปโดยตรง 

1 

2 
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3. เปิดหน้าต่าง Color  กดปุ่ม <Shift+F9> 
4. คลิกตัวเลือก Bitmap จะพบว่ารูปที่ดึงเข้ามาจะแสดงในหน้าต่าง Color นี้ทั้งหมด 
5. คลิกแปรงทาสีในกล่องเครื่องมือ 
6. เมื่อเมาส์เปลี่ยนเป็นแปรงทาสีแล้ว ให้คลิกไปบนรูปโดยตรงในหน้าต่าง Color  
7. ทดสอบการวาดบนสเตจ 

 
 
 
 
 
 
 
 

 

 

 

 

 

8. คลิกไปบนรูปอื่นโดยตรงในหน้าต่าง Color  
9. ทดสอบการวาดอีกครั้ง คราวนี้ก็สามารถเปลี่ยนปลายพู่กันได้แล้ว และน าไปประยุกต์ใช้

งานได้ต่อไป 
 
 
 
 
 
 

4 

6 

3 

5
4 

7
4 



 

 

89 

 
 

 ลบพื้นที่ส่วนที่ไม่ต้องการด้วยเคร่ืองมือ Eraser Tool 
หน้าที่การท างานของเครื่องมือ Eraser Tool คือ ใช้ส าหรับลบพื้นที่บริเวณส่วนที่ไม่ต้องการ 

ออกไปจากภาพโดยสามารถก าหนดรูปแบบลักษณะวิธีในการลบได้มากมายหลากวิธี ซ่ึงการใช้งาน
เคร่ืองมือนี้จะคล้ายกับการใช้เคร่ืองมือ Brush Tool เพียงแต่ Eraser Tool จะมีไว้เพื่อลบสีออก แต่
เครื่องมือ Brush Tool มีไว้ส าหรับระบายสีเพิ่มส าหรับขั้นตอนการลบโดยใช้เคร่ืองมือ Eraser Tool 
สามารถท าได้ดังนี้  
 

1. คลิกปุ่ม Eraser Tool    ที่ทูลบ็อกซ ์
2. ที่ Options ในส่วนของ Eraser Mode ให้คลิกเลือกลักษณะวิธีการลบ 
Erase Normal  ลบโดยทับลงสีเส้นและสีพ้ืนของภาพ 
Erase Fills   ลบโดยทับลงบนสีพ้ืนของภาพเท่านั้น 
Erase Lines   ลบโดยทับลงบนสีเส้นของภาพเท่านั้น 
Erase Selected Fills   ลบเฉพาะพื้นที่บริเวณที่ถูกเลือกไว้เท่านั้นโดยไมท่ าการ

ลบเส้นให้ 
Erase Inside  ลบตามลกัษณะการดรากส์เมาส์ เช่น หากเร่ิมดรากส์

เมาส์ที่ด้านในภาพพื้นที่บริเวณที่ถูกลบก็จะเป็นเพียงแค่
พื้นที่ด้านในภาพเท่านั้น 

8 

9 
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3. คลิกเลือกรูปร่างลักษณะของยางลบที่ใช้ในการลบ จากส่วนของ Eraser Shape 
4. ดรากส์เมาส์ท าการลบบริเวณพื้นที่ที่ไม่ต้องการ จากนั้นบริเวณพื้นที่ที่ท าการดรากส์เมาส์

จะถูกลบหายไป 
5. คลิกปุ่ม Faucet   รูปก๊อกน้ าล้างสี เพื่อให้การลบเป็นไปอย่างรวดเร็ว เนื่องจากเพียงแค่

คลิกที่บริเวณพื้นหรือเส้นของภาพเท่านั้น โปรแกรมก็จะท าการลบพื้นที่บริเวณที่คลิกเลือก
ให้ทั้งหมด 

6. คลิกพื้นที่บริเวณที่ต้องการลบ จากนั้นพื้นที่บริเวณที่คลิกไว้จะถูกลบออกไป 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.คลิกปุ่ม Eraser Tool 

2.คลิกเลือกลักษณะ  
    วิธีการลบ 

3.คลิกเลือกรูปร่างลักษณะของยางลบ 4.ดรากส์เมาส์ท าการลบ 
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5.คลิกปุ่ม Faucet  6.คลิกพ้ืนที่บริเวณที่ต้องการลบ 

ภาพที่ถูกลบแล้ว 
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หน่วยการเรียนรู้ที่ 5 

สร้างชิ้นงานแบบ Symbol กับ Instance 
  มาตรฐานการเรียนรู้  / ตัวชี้วัด 

 กลุ่มสาระการงานอาชพีและเทคโนโลยี   
       สาระที่  3  เทคโนโลยีสารสนเทศและการสือ่สาร

เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การเรียนรู้ 
การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม 

ตัวชี้วัด  
1. ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน 

      สาระส าคัญ 
 รู้จักกับประเภทของ Symbol และการสร้าง Symbol แต่ละแบบ 

     สาระการเรียนรู้ 
 -  ความรู้

1. การสร้าง Symbol ประเภทต่างๆ 

-  ทักษะ / กระบวนการ 

1. ศึกษาและอธิบายการใช้ค าสั่ง ในการสร้าง Symbol
2. ฝึกปฏิบัติเกี่ยวกับค าสั่งต่าง ๆ ในโปรแกรม  จากนันนลองทสสอบผลลัพธ์ของค าสั่ง

-  คุณลักษณะที่พึงประสงค์ 
1. มีวินัย

2. ใฝ่เรียนรู้   

3. มุ่งมั่นในการท างาน
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 รูปแบบกราฟิกที่ใช้งานบน Flash CS5

ผลงานที่สร้างขึนนมาจากโปรแกรม Flash CS5 จะอยู่ในรูปแบบเวกเตอร์ (Vector) ซึ่งข้อสี
ของเวกเตอร์คือ ออบเจ็กต์จะมีความคมชัสและไฟล์ที่ไส้จะมีขนาสเล็ก สังนันนโปรแกรม Flash CS5 
จึงเหมาะส าหรับการสร้างไฟล์งานที่มีการเคลื่อนไหวหรือมีรูปแบบที่มีความน่าสนใจไส้เป็นอย่างสี 

รูปแบบกราฟิกไม่ไส้มีเพียงแค่เวกเตอร์เท่านันน แต่คุณยังสามารถน าไฟล์งานที่อ ยู่ใน
รูปแบบราสเตอร์ (Raster) เข้ามาใช้งานในโปรแกรม Flash CS5 ไส้อีกส้วย และต่อไปนีนจะเป็น
ตารางแสสงรายละเอียสความแตกต่างระหว่างรูปแบบ กราฟิกทันง 2  รูปแบบ 

เวกเตอร(์Vector) ราสเตอร(์Raster) 
ออบเจ็กต์สร้างขึนนมาจากสูตรทางคณิตศาสตร์ ออบเจ็กต์สร้างจากช่องสีเหลี่ยมเล็กๆ ที่เรียกว่า 

“พิกเซล” 
เหมาะส าหรับการสร้างตัวอักษร หรืองานที่
แสสงบนเว็บ 

เหมาะกับงานที่ต้องการความละเอียสของสี เช่น 
รูปถ่าย 

ผลงานที่สร้างขึนนจะมีขนาสไฟล์ที่เล็ก ผลงานที่สร้างขึนนจะมีขนาสไฟล์ที่ใหญ่ 
เมื่อท าการขยายขนาสจะไม่ท าให้คุณภาพของ
งานลสลง 

เมื่อท าการขยายขนาสจะท าให้งานที่ไส้มคีุณภาพ
ลสลง 

 รู้จักกับซีนและมูฟว่ี

ซีน (Scene) เปรียบเทียบเสมือนเร่ืองราวฉากละครแต่ละฉาก ภายในซีนจะประกอบส้วย
ออบเจ็กต์ต่างๆ มากมายหลากหลายชนิสที่ไส้ท าสร้างขึนนมา และโปรแกรมจะท าการสร้างซีนขึนนมา
ให้ 1 ซีน แต่สามารถท าการเพิ่มจ านวนซีนขึนนมาใช้งานไส้อีกตามต้องการ 

มูฟวี่ (Movie) เปรียบเสมือนเร่ืองราวโสยรวมทันงหมสของละคร ซ่ึงมูฟว่ีเกิสจากการน าซีน 
ของฉากทันงหมสท าการประกอบเช่ือมโยงเข้าส้วยกันเป็นเร่ืองที่ต้องการขึนนมา 
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 รู้จักกับซิมโบลและอินสแตนซ์ 
ซิมโบล (Symbol) คือตัวแทนของออบเจ็กต์ที่สร้างขึนนมาใช้งานในมูฟว่ี เมื่อต้องการสร้าง 

ออบเจ็กต์นันนๆ ขึนนมาใช้งานอีกจะไส้ไม่ต้องท าการสร้างขึนนมาใหม่ให้สินนเปลืองเวลา เนื่องจาก
สามารถน าอินสแตนซ์ของซิมโบล ที่ท าการสร้างขึนนมาใช้งานแทนไส้เลย ซิมโบลมีทันงหมส 3 
ประเภท ไส้แก่ 

1. ซิมโบลประเภทกราฟิก (Graphic Symbol) เป็นซิมโบลประเภทที่มีความซับซ้อนน้อย
ที่สุส ในการสร้างภาพนิ่ง การสร้างซิมโบลประเภทนีนสามารถสร้างไส้จากออบเจ็กต์ทุก
ชนิส 

2. ซิมโบลประเภทปุ่ม  (Button Symbol) เหมาะส าหรับการสร้างปุ่มที่มีการติสต่อ
ตอบสนองกับผู้ใช้งานรวมถึงรับรู้การเคลื่อนที่และการกระท าของเมาส์ไส้ 

3. ซิมโบลประเภทมูฟ ว่ีคลิป  (Movie Clip Symbol) เป็นซิมโบลที่ ใช้ในการสร้าง
ภาพเคลื่อนไหวต่างๆ สามารถควบคุมและก าหนสคุณสมบัติไส้จาก ActionScript 

 
 
 

ชื่อซีนที่ก ำลัง
ท ำงำนอยู่ 

คลิกเพ่ือเปล่ียนซีนใหม่ที่
ต้องกำรท ำงำนด้วย 
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อินสแตนซ์ (Instance) คือ ออบเจ็กต์ที่ไส้จากการน าซิมโบลที่สร้างไว้แล้วเข้ามาใช้งานตาม

จ านวนที่ต้องการโสยไม่ต้องสร้างออบเจ็กต์นันนๆ ขึนนมาใหม่ ซ่ึงเมื่อท าการเปลี่ยนแปลง แก้ไขอิน 
สแตนซ์แต่ละชินนแล้วจะไม่ส่งผลกระทบต่อซิมโบล สังนันนจึงเหมาะส าหรับงานที่ต้องการสร้าง
ออบเจ็กต์ในรูปแบบที่คล้าย ๆ กัน โสยปรับเปลี่ยนเพียงแค่รูปร่างของออบเจ็กต์แต่ละชินนเท่านันน 
เช่น การสร้างรูปฝูงนก เป็นต้น 

 การสร้างซิมโบลประเภทกราฟิก 
การสร้างซิมโบลประเภทกราฟิกจะมีขันนตอนการสร้างที่ง่ายและมีความซับซ้อนน้อยที่สุส 

เนื่องจากสามารถน าภาพนิ่งหรือท าการสร้างออบเจ็กต์ขึนนมาท าเป็นซิมโบลกราฟิกในรูปแบบและ
ขันนตอนที่ง่ายท่ีสุส 

1. คลิกเมนู Insert แล้วเลือกค าสั่ง  New Symbol เพื่อท าการสร้างซิมโบลใหม่  
2. พิมพ์ตันงช่ือซิมโบลในช่อง Name  
3. คลิกเลือก Graphic ซิมโบลที่ไส้จะอยู่ในรูปแบบกราฟิก 
4. คลิกปุ่ม OK เพื่อยืนยันค าสั่ง 
5. สร้างออบเจ็กต์ที่ต้องการสร้างเป็นซิมโบลประเภทกราฟิก 
6. คลิกที่ Scene1 เพื่อกลับสู่หน้าจอการท างาน 

 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 
4
1 

3
1 
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 การสร้างซิมโบลประเภทปุ่ม 

ซิมโบลประเภทปุ่มเหมาะส าหรับงานที่ต้องการให้มีการตอบสนองติสต่อกับผู้ใช้งาน อีกยัง 
สามารถสัสแปลงพัฒนาสร้างปุ่มสกรอลล์บาร์ ปุ่มแบบป็อปอัปเมนู จนกระทั่งถึงปุ่มที่ใช้ในการ
ควบคุมวัตถุให้เคลื่อนที่ไปในทิศทางต่างๆ ส าหรับการสร้างปุ่มพืนนฐานที่ใช้คลิกค าสั่งให้กลายเป็น
ซิมโบลสามารถท าไส้สังนีน 

1. คลิกเมนู Insert แล้วเลือกค าสั่ง New Symbol เพื่อสร้างซิมโบลใหม่ 
2. พิมพ์ตันงช่ือซิมโบลในช่อง Name  
3. คลิกเลือก Button  ซิมโบลที่ไส้จะอยู่ในสถานะท าหน้าที่เป็นปุ่ม 
4. คลิกปุ่ม OK เพื่อยืนยันค าสั่ง จากนันนจะปรากฏสถานะของปุ่มขึนนมา 4 สถานะ 
5. ที่เฟรม UP ให้ท าการสร้างปุ่มที่ต้องการเมื่ออยู่ในสถานะปกติ ยังไม่มีการคลิกเมาส์

ใสๆ 

6.คลิกที่ Scene1 

5.สร้ำงปุ่มเม่ืออยู่ใน  
    สถำนะปกต ิ
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6. คลิกเมนู Insert แล้วเลือกค าสั่ง Keyframe จากนันนจะปรากฏปุ่มที่อยู่ในสถานะ UP 
ขึนนมา 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. ที่เฟรม Over ให้ท าการตกแต่งแก้ไขปุ่มในสถานะที่มีการน าเมาส์ไปวางไว้บนปุ่ม เช่น 
ท าการเปลี่ยนแปลงสี เปลี่ยนแปลงรูปร่าง เปลี่ยนแปลงขนาสของปุ่ม เป็นต้น  

8. คลิกเมนู Insert เลือก Timeline แล้วเลือกค าสั่ง Keyframe จากนันนจะปรากฏปุ่มที่อยู่ใน
สถานะ Over ขึนนมา 

9. ที่เฟรม Down ให้ท าการตกแต่งแก้ไขปุ่มในสถานะที่มีการน าเมาส์ไปคลิกที่ปุ่ม 
10. คลิกเมนู Insert เลือก Timeline แล้วเลือกค าสั่ง Keyframe จากนันนจะปรากฏปุ่มที่อยู่ใน

สถานะ Down ขึนนมา  

1 
2 

3 

4 

6.คลิกเมนู Insert >Timeline> 
   Keyframe 

5.สร้ำงปุ่มเม่ืออยู่ในสถำนะปกติ 
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11. ที่เฟรม Hit ให้ท าการสร้างออบเจ็กต์ใสๆ คลุมพืนนที่บริเวณที่ต้องการให้มีการแสสงผล
ของปุ่มค าสั่ง 

12. คลิกที่ Scene1 เพื่อกลับสู่หน้าจอการท างานปกต ิ

8.คลิกเมนู Insert >Timeline > 
Keyframe  

7.ตกแต่งแก้ไขปุ่มในสถำนะที่
มีกำรน ำเมำส์ไปวำง 

10.คลิกเมนู Insert >Timeline > 
  Keyframe 

9.ตกแต่งแก้ไขปุ่มในสถำนะที่มี  
   กำรน ำเมำส์ไปคลิก 
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13. คลิกเมนู Window เลิกค าสั่ง Library ให้ปรากฏเคร่ืองหมายถูก เพื่อเปิสพาเนลไลบรารี 
14. สรากสเ์มาส์ลากปุ่มซมิโบลที่สร้างขึนนมาไว้ที่พืนนงาน 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12.คลิกที่ Scene 1 

11.สร้ำงออบเจ็กต์ใดๆ คลุมพ้ืนที่
บริเวณที่ต้องกำรให้มีกำรแสดงผล 

13.คลิกเมำส์ Window > Library ให ้
      ปรำกฏเครื่องหมำยถูก 
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 15. คลิกเมนู Control เลิกค าสั่ง Test Movie > Test เพื่อทสสอบการท างานของปุ่มทันง 4 
สถานะ  

 
 
 
 
 
 

14.ดรำกส์เมำส์ลำกปุ่มซิมโบลที่ 
      สร้ำงข้ึนมำไว้ที่พ้ืนงำน 

15.คลิกเมนู Control > Test Movie 
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 การสร้างซิมโบลประเภทมูฟว่ีคลิป 
ลักษณะของมูฟวี่คลิป คือ เป็นซิมโบลที่สามารถให้ปรากฏภาพที่มีการเคลื่อนไหวติสต่อกัน 

อย่างต่อเนื่องหรือเรียกว่าแอนิเมชันขึนนมาไส้ และต่อไปนีนเป็นตัวอย่างเบืนองต้นของการสร้างซิมโบล
ในรูปแบบมูฟว่ีคลิป โสยจะท าการสร้างรูปสาวขึนนมา ให้เกิสการหมุนพร้อมมีขนาสเปลี่ยนแปลงไป
จากเสิม 

1. คลิกเมนู Insert เลิกค าสั่ง New Symbol เพื่อท าการสร้างซิมโบลใหม่ 
2. พิมพ์ตันงช่ือซิมโบลในช่อง Name 
3. คลิกเลือก Movie CIip ซิมโบลที่สร้างขึนนจะเป็นมูฟว่ีคลิปมีการเคลือ่นไหวขึนนมา 
4. คลิกปุ่ม OK เพื่อยืนยันค าสั่ง 
5. สร้างออบเจ็กต์ที่ต้องการให้เป็นซิมโบลประเภทมูฟว่ีคลิป 
6. คลิกเฟรมที่ 20 เพื่อท าการสร้างภาพเคลื่อนไหว 
7. คลิกเมนู Insert เลือก Timeline แล้วเลือกค าสั่ง Keyframe จากนันนจะปรากฏคีย์เฟรมขึนนมา

บนเฟรมที่ 25 
 

ปุ่มที่เฟรม Up จะปรำกฏขึ้นมำเม่ืออยู่ใน
สถำนะปกติ ยังไม่มีกำรคลิกเมำส์ใด 

ปุ่มที่เฟรม Over จะปรำกฏขึ้นมำเม่ืออยู่
ในสถำนะที่มีกำรน ำเมำส์ไปวำงบนปุ่ม 

ปุ่มที่เฟรม Down จะปรำกฏขึ้นมำเม่ืออยู่
ในสถำนะที่มีกำรน ำเมำส์ไปคลิกที่ปุ่ม 

เม่ือน ำเมำส์ไปชี้พ้ืนที่บริเวณเฟรม Hit  
จะสำมำรถแสดงผลปุ่มค ำส่ัง 
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8. ให้คลิกขวาที่เฟรม ไหนก็ไส้ระหว่างเฟรมที่ 1- เฟรมที่ 25 เลือกค าสั่ง Create Motion tween 
9. จากนันนให้คลิกเลือกที่ Rotate เปลี่ยนจากค่า None เป็น CW คือให้วัตถุหมุนตามเข็มนาฬิกา  
10. ให้เปลี่ยนตัวเลข ให้เป็น 12  time  เป็นอัตราการหมุน ของวัตถุ 
 

1.คลิกเมนู Insert > New Symbol 

2.พิมพ์ตั้งชื่อซิมโบล 

4.คลิกปุ่ม OK 

3.คลิกเลือก 
Movie Clip 

7.คลิกเมนู Insert > Timeline >Keyframe 

6.คลิกเฟรมที่ 25 

5.สร้ำงออบเจ็กต ์
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11. คลิกปุ่ม Ctrl+Enter  ที่แป้น keyboard จะเป็นการทสสอบมูฟว่ีคลิปเพื่อสูการเคลือ่นไหว
ตามค่าที่ไสก้ าหนสไว้ 

 

9. เลือกค่ำ Rotate เป็น CW 

8. คลิกเลือก Create 
Motion Tween 

10. เปล่ียนค่ำอัตรำกำรหมุน เป็น 12 
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 แปลงออบเจ็กต์ให้เป็นซิมโบล 
การสร้างซิมโบลไม่เพียงแต่ต้องคลิกที่เมนู New Symbol จึงจะสามารถสร้างซิมโบลในรูปแบบ 

ต่างๆไส้เท่านันน แต่หากไส้ท าการสร้างออบเจ็กต์หรือภาพกราฟิกต่าง ๆ เพื่อเก็บไว้ในรูปแบบ
เวกเตอร์และราสเตอร์ขึนนมาแล้ว เราสามารถท าการแปลงออบเจ็กต์เหล่านันนให้กลายเป็นซิมโบล
ประเภทต่างๆ เพื่อเก็บไว้ใช้งานภายหลังก็ไส้เช่นกัน  

1. สร้างและคลิกเลือกออบเจ็กต์ที่ต้องการ 
2. คลิกเมนู Modify> Convert to Symbol เพื่อท าการแปลงออบเจ็กต์ที่สร้างขึนนให้เป็น     

ซิมโบล 
3. พิมพ์ตันงช่ือซิมโบลในช่อง Name 
4. ที่ Behavior ให้คลิกเลือกประเภทซิมโบลที่ต้องการ 
5. คลิกปุ่ม OK เพื่อยืนยันค าสั่ง 
6. คลิกเมนู File > Save เพื่อท าการบันทึกไฟล์ซิมโบลที่ไส้สร้างขึนนเก็บไว้ใช้งานในครันง

ต่อไป 
7. พิมพ์ตันงช่ือไฟล์ในช่อง File name  
8. คลิกปุ่ม Save  ไฟล์งานลงในช่อง Flie name 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.คลิกเมนู Insert > Convert to Symbol 

1.สร้ำงและคลิกเลือกออบเจ็กต์ 
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5.คลิกปุ่ม OK  

3.พิมพ์ตั้งชื่อซิมโบล 

4.คลิกเลือกประเภทซิมโบล 

6.คลิกเมนู File > Save 

7.พิมพ์ตั้งชื่อไฟล์ 

8.คลิกปุ่ม Save 
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 เรียกใช้งานและปรับแต่งอินสแตนซ์ 
ซิมโบลทันง 3 แบบ ที่สร้างขึนนมาแล้วนันน สามารถน าเข้ามาใช้งานไส้โสยไม่จ ากัส เมื่อต้องการ 

ใช้งานเพียงแค่คลิกเลือกน าเข้ามาจาก Library Panel จากนันนจึงท าการปรับแต่งแก้ไขให้มีรูปแบบ 
ขนาส สี ที่แตกต่างกันออกไปเท่านันน ซึ่งจะท าให้ประหยัสเวลาไม่ต้องสร้างออบเจ็กต์ในรูปแบบเสิม 
ขึนนมาหลายๆ ครันง  

1. คลิกเมนู File > Open as Library เพื่อเปิสไฟล์ที่ไส้ท าการสร้างซิมโบลไว้ขึนนมา 
2. สับเบิลคลิกช่ือไฟล์ที่ไส้ท าการบันทึกไว้ 
3. สรากส์เมาส์ลากซิมโบลจาก Library Panel ออกมาใช้งาน จากนันนท าการปรับแต่ง

ขนาสตามตอ้งการ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.คลิกเมนู File > Import >  
Open External Library 

2.ดับเบิลคลิกชื่อไฟล์ 
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4. คลิกที่หน้าต่าง Properties ส้านล่าง 
5. ที่ Color ให้คลิกเลือก Tint สี และระสับความเข้มจางของสีตามต้องการ 

 
 

 
 
 
 
 

 
 
 
 
 
 
 
 

3.ดรำกส์เมำส์ซิมโบล จำกนั้น
ท ำกำรปรับแต่งขนำด 

5.คลิกเลือก Tint สี และระดับควำมเข้มจำงของสี 
4.คลิกหน้ำต่ำง Properties 
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 การใส่ Link ให้กับซิมโบล 
เราสามารถสร้างจุสเช่ือมโยงไปยังเว็บไซต์ ต่อไปนีนจะเรียกว่า ลิงค์ (Link) ไส้ตันงแต่ตอนสร้าง 

ซิมโบล หรือหลังจากแก้ไขซิมโบลไปแล้ว สังรายละเอียสสังนีน 
1. สร้างซิมโบลใหม่คลิกเมนู Insert > New Symbol หรือกสปุ่ม <Clrt+F8> 
2. ใส่ช่ือ Link01 ให้กับซิมโบลลงในช่อง Name 
3. ก าหนสให้เป็นซิมโบลประเภท Button 
4. เลือกค าสั่ง Windows > Actions ให้ปรากฏเครื่องหมายถูก 
5. เลือกที่ค าสั่ง Browser/ Network  สับเบิลคลิกที่ getURL:  

ในช่อง URL: ให้ใส่ช่ือเว็บไซต์ ในที่ให้ใส่ http://www.bkk-software.co.th 
6. ในช่อง Window ให้เลือกเป็น _blank ในช่อง Window เป็นการก าหนสสไตล์การเปิส

หน้าเว็บไซต์ มีให้เลือก 4 แบบ 
_ blank จะก าหนสให้เปิสหน้าเว็บเพจอันใหม่ขึนนมาเสมอ 
_ parent จะก าหนสให้เปิสหน้าเว็บเพจในหน้าต่างหลักหรือกรอบเฟรม 

                                         กรณีที่มีการแบ่งคอลมัน์ 
_ self จะก าหนสให้เปิสหน้าเว็บเพจในกรอบเฟรม ปัจจุบันที่มีลิงค์นีนอยู่ 
_ top จะก าหนสให้เปิสหน้าเว็บเพจใหม่แทนหน้าเว็บเพจปัจจุบันทันงหมส 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.สร้ำงซิมโบลใหม่ 

2.พิมพ์ชื่อลงในช่อง 

3.เลือกประเภทซิมโบล 
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7. กส <Ctrl+Enter> เพื่อทสสอบชินนงานของเรา 

 หน้าต่างไลบรารี (Library Panel) 

หน้าต่างไลบรารีเป็นส่วนประกอบที่ส าคัญตัวหนึ่งของโปรแกรม Flash จ่ึงจ าเป็นที่ต้องเข้าใจ 
ในการท างานหน้าต่างไลบรารี เพื่อความสะสวกในการสร้างภาพเคลื่อนไหว หรือสร้างผลงานต่างๆ 
ส้วย Flash ส่วนประกอบในหน้าต่างมีสังนีน 

 
 
 
 
 
 
 
 
 
 

 แถบชื่อไฟล์ เนื่องจากว่าเมื่อเราเปิสไฟล์หลายไฟล์พร้อมกัน (จะเรียกว่าหลายมูฟว่ีก็ไส้) หน้าต่าง
ไลบรารีปรากฏขึนนมาพร้อมกัน สามารถที่จะแยกไส้ว่าซิมโบลเป็นของมูฟว่ีอันไหน โสยสูจากแถบ
ช่ือไฟล์ 
 เมนู Options ส าหรับจัสการกับรายละเอียสภายในหน้าต่างไลบรารีนีน 

ดับเบิลคลิกที่ getURL 

ใส่เว็บไซต์ 
เลือกเป็น_blank 

เมนู Options 
แถบชื่อไฟล์ 
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 กรอบแสดงตัวอย่าง เมื่อคลิกที่ช่ือซิมโบลจะปรากฏตัวอย่างหน้าตาของซิมโบล พร้อมกับ 
    ทสสอบการท างานของซิมโบลส้วยการคลิกปุ่ม Test ในกรอบนีนไส้ทันที 
 
 
 

 
 
 
 
 
 

 
 
 กรอบแสดงชื่อซิมโบล เมื่อสร้างซิมโบลขึนนมาใหม่ หรือสึงเข้ามาจากภายนอกจะปรากฏช่ือ 
   ซิมโบลกรอบนีนเป็นจุสแรก ก่อนที่จะปรับแต่งคุณสมบัติไส้ต่อไป 
 ปุ่มจัดล าดับ เมื่อหน้าตางไลบรารีประกอบส้วยซิมโบลหลายตัว สามารถคลิกปุ่มเหล่านีนเพื่อ 
   จัสเรียงซิมโบลตามคุณสมบัติ เช่นเรียงตามช่ือ เรียงตามประเภท วันที่ และเวลาที่สร้างขึนน เป็นต้น 
 ปุ่มจัดการหน้าต่างไลบรารี จะมีแถบเลื่อนสูซิมโบลที่ซ่อนอยู่ส้านล่างของหน้าต่างนีน 
 
 
 
 
 
 
 
 
 
 
 
 

ปุ่มกำรท ำงำน 

ปุ่มจัดล ำดับ 

รำยชื่อซิมโบล 
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ไอคอนต่างๆ ที่ปรากฏหน้าช่ือซิมโบลแต่ละตัว และในหน้าต่างไลบรารี สังนีน 

        ไอคอนประจ าตัวของซิมโบลประเภท Graphic  

  ไอคอนประจ าตัวของซิมโบลประเภท Movie Clip  

         ไอคอนประจ าตัวของซิมโบลประเภท Button 

          ปุ่มส าหรับการสร้างซิมโบลใหม่ 

         ปุ่มส าหรับการสร้างโฟล์เสอร์ใหม่ 

         ปุ่มส าหรับการก าหนสคุณสมบัติของซิมโบล  

         ปุ่มส าหรับลบซิมโบลที่เลือก (ที่ขึนนแถบสีที่ช่ือซมิโบล) 
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หน่วยการเรียนรู้ที่ 6 

รู้จักกับ Layer ซีน และ เฟรม 
  มาตรฐานการเรียนรู้  / ตัวชี้วัด 

 กลุ่มสาระการงานอาชีพและเทคโนโลยี   
        สาระที่  3  เทคโนโลยีสารสนเทศและการส่ือสาร

 เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การเรียนรู้ 
การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม  

 ตัวชี้วัด  
1. ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน 

  สาระส าคัญ 
 การสร้าง การแก้ไข และ การลบ  Layer  ซีน  และ เฟรม

  สาระการเรียนรู้ 
 -  ความรู้
    การสร้าง การแก้ไข และ การลบ  Layer  ซีน  และ เฟรม 

-  ทักษะ / กระบวนการ 

1. ศึกษาและอธิบายการใช้ค าสั่ง การเพิ่ม แก้ไข ลบ Layer ซีน และ เฟรม
2. ฝึกปฏิบัติเกี่ยวกับค าสั่งต่าง   ในโปรแกรม  จากนันนลองทสสอบผลลัพธ์ของค าสั่ง

-  คุณลักษณะที่พึงประสงค์ 
1. มีวินัย
2. ใฝ่เรียนรู้
3. มุ่งมั่นในการท างาน
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 การท างานเป็นเลเยอร์ (Layer) เป็นการท างานโสยการแยกส่วนต่าง  ของภาพออกจากกัน
เป็นล าสับขันน ซึ่งในการสร้าง Flash Movie นันน การใช้ Layer จะช่วยท าให้เกิสการเคลื่อนที่อย่าง
สมจริงสมจัง ฉะนันนอาจเรียกไส้ว่าการใช้ Layer ในการสร้างภาพเป็นเร่ืองที่ส าคัญมากในการสร้าง 
Flash Movie 

 ความหมายของ Layer 
 ลักษณะการท างานแบบ Layer เป็นการวางแผ่นใสซ้อนทับกันเป็นล าสับขันนขึนนมาเร่ือย  
โสยแต่ละแผ่นใสเปรียบเหมือนเป็นแต่ละ Layer บริเวณ Layer ที่ไม่มีรูปจะเห็นทะลุถึง Layer ที่อยู่
ข้างล่าง โสยกระบวนการเช่นนีนจะท าให้เกิสเป็นรูป Flash Movie ที่สมบูรณ์ 
 นอกจากนีนแล้ว ในแต่ละ Layer จะแยกการท างานอย่างชัสเจน มีคุณสมบัติต่าง  เป็นของ
ตัวเอง และแก้ไขที่เกิสขึนนในแต่ละ Layer นันนจะไม่ส่งผลต่อ Layer อื่น   
 
 
 
 
 
 
 
รูปแสสงการวาง Layer เข้าส้วยกันจนเกิสเป็นภาพใหม่ 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพแสดงเม่ือสมบูรณ์ 
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 การใช้งาน Layer  
ในการสร้าง Flash Movie ขึนนมานันน แม้จะประกอบ 

ไปส้วย Layer หลาย Layer แต่สามารถท างานไส้เพียงทีละ 
 Layer เท่านันน Layer ที่ก าลังท างานอยู่เรียกว่า Action Layer   
สังเกตไส้จะปรากฏเป็นแถบสีส าที่  Layer นันน และสามารถ 
ก าหนสสถานะต่าง    ของ Layer นันนไส้   เช่น ก าหนสให้ 
แสสงหรือซ่อน  Layer, ก าหนสให้ Layer นันนสามารถปรับ 
แต่งไส้หรือไม่ไส้ ,ก าหนสให้ Layer นันนแสสงเฉพาะเส้น 
โครงร่าง เป็นต้น 

 
 การแสดงหรือซ่อนเลเยอร ์

คลิกในคอลัมน์   Eye ทางขวาของช่ือเลเยอร์หากเลเยอร์ใสแสสงเคร่ืองหมาย  แสสงว่า
ถูกซ่อนอยู่ ให้คลิกซน าเพื่อแสสง  
 เราสามารถคลิกแล้วลากในคอลัมน์  Eye นีนไส้เพื่อแสสงหรือซ่อนทีละหลาย  เลเยอร์ 
หากต้องการแสสง / ซ่อนเลเยอร์ทันงหมส ให้คลิกที่ไอคอน  ที่แถบส่วนหัวของเลเยอร์หรือ กสปุ่ม 
Alt ค้างไว้ แล้ว คลิกในคอลัมน์  Eye  
 
 
 
 
 
 
 
 

 การแสดงโครงร่างของออบเจ็กต์ในเลเยอร์ 
 คลิกในคอลัมน์  Outline ที่อยู่ทางขวาของช่ือเลเยอร์เพื่อแสสงหรือไม่แสสงโครงร่าง
เนืนอหาในเลเยอร์นันน 
 เราสามารถคลิกแล้วลากในคอลัมน์  Outline นีนไส้เพื่อแสสงหรือไม่แสสงทีละหลาย   
เลเยอร์ หากต้องแสสง / ซ่อนเลเยอร์ทันงหมส ให้คลิกที่ไอคอน  ที่แถบส่วนหัวของเลเยอร์ หรือ 
กสปุ่ม Alt ค้างไว้ แล้วคลิกในคอลัมน์  Outline 

แสดงสถานะการท างานของ Layer 

แถบส่วนหัว คอลัมน์ Eye 
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 การเปลี่ยนสีของโครงร่าง 
1. ให้เปิส Properties ขึนนมาซึ่งสามารถที่จะเปิสหน้าต่าง Properties ขึนนมาไส้นันนมีวิธีการ

เปิสส้วยกัน 3 วิธี สังนีน 
* สับเบินลคลิกที่ไอคอนของเลเยอร์ที่อยู่ส้านซ้ายของช่ือเลเยอร์   
* คลิกขวาที่ช่ือเลเยอร์ แล้วคลิกเลือกค าสั่ง Properties  
* คลิกที่เลเยอร์นันน แล้วเลือกค าสั่ง Modify เลือกไปที่  Timeline แล้วเลือกที ่Layer  

 
 
 
 
 
 
 
 
 
 
 
 
 2.   เลือกสีที่ต้องการ 
 3.   เลือก OK  

คอลัมน์ Outline 

แสดงโครงร่างของเนื้อหา
ในเลเยอร์ที่เลือก 

เลือกส ี
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 การปรับความสูงของเลเยอร์ 
 สับเบินลคลิกที่ไอคอน  ที่อยู่ส้านซ้ายของช่ือเลเยอร์ แล้วเลือกขนาสในส่วนของ Layer 
Height และเลือก OK  
 
 
 
 
 
 
 
 
 

 การแก้ไขเลเยอร์ 
 การเลือกเลเยอร ์

 คลิกที่ช่ือเลเยอร์ หรือ คลิกที่เฟรมใส  ของเลเยอร์นันน หรือ เลือกออบเจ็กต์บนสเตจที่อยู่
ในเลเยอร์นันน หากต้องการเลือกหลายเลเยอร์ที่อยู่ติสกัน ให้กสปุ่ม Shift ค้างไว้ แล้วคลิกเลือกหาก
ต้องการเลือกหลายเลเยอร์ที่อยู่ไม่ติสกัน ให้กสปุ่ม Ctrl ค้างไว้ แล้วคลิกเลือก 

 การสร้าง Layer ใหม ่
1. สร้างโสยเลือกเมนู ค าสั่ง Insert  เลือกค าสั่ง Timeline แล้วเลือกที่ Layer สังรูป 

 
 

 - คลิกที่ปุม่  Insert Layer ที่อยู่ส้านล่างพาเนล 
 - คลิกขวาที่ช่ือเลเยอร์ แล้วเลือกค าสั่ง Insert Layer 
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 2. Layer ใหม่จะถูกสร้างขึนนมาเหนือ Layer ที่ก าลังท างานอยู่ โสยมีการก าหนสชื่อ Layer 
โสยอัตโนมัติ 
    
 
 
 
 
 
 

 การเปลี่ยนชื่อเลเยอร ์

 สับเบินลคลิกที่ช่ือเลเยอร์ แล้วพิมพ์ช่ือใหม่ 
 คลิกขวาที่ช่ือเลเยอร์ แล้วเลือกค าสั่ง Properties 
 เลือกเลเยอร์นันน แล้วเลือกเมนูค าสั่ง Modify เลือกค าสั่ง Timeline  แล้วเลือก  Layer  
 
 
 

 
 

 การคัดลอกเลเยอร ์
1. เลือกเลเยอร์ที่จะคัสลอก 
2. เลือกมเมนูค าสั่ง Edit เลือกค าสั่ง Copy Frames 

3. คลิกที่ปุ่ม  Insert Layer เพื่อสร้างเลเยอร์ใหม่ 
4. เลือกเลเยอร์ใหม่นันน แล้วเลือกเมนูค าสั่ง Edit เลือกค าสั่ง Paste Frames 
 การจัดล าดับการจัดวางเลเยอร ์

 ลากเลเยอร์ไปยังต าแหน่งใหม่ที่ต้องการ 
 
 

 
    

พิมพ์ช่ือใหม่ 

ดรากส์เมาส์ลากไปวางยัง
ต าแหน่งที่ต้องการ 
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 การล็อคเลเยอร ์

 คลิกในคอลัมน์  Lock ที่อยู่ทางขวาของช่ือเลเยอร์เพื่อล็อคหรือไม่ล็อคเลเยอร์นันนเรา 
สามารถคลิกแล้วลากในคอลัมน์  Lock นีนไส้เพื่อล็อคทีละหลาย  เลเยอร์ หากต้องการล็อก /   
ไม่ล็อกเลเยอร์ทันงหมส ให้คลิกที่ไอคอน  ที่แถบส่วนหัวของเลเยอร์ หรือ กสปุ่ม Alt ค้างไว้ แล้ว
คลิกในคอลัมน์  Lock  
 

 

 

 

 

 

 

 

 

 

 การลบเลเยอร์  
1. เลือกเลเยอร์ที่จะลบ 

2. คลิกที่ปุ่ม  Delete Layer  ส้านล่างของพาเนล หรือ ลากเลเยอร์นันนไปทินงลงในปุ่ม 
 Delete Layer หรือ คลิกขวาที่ช่ือเลเยอร์ แล้วคลิกค าสั่ง Delete Layer  

 
 
 
 

 

 
 

 โฟลเดอร์ของเลเยอร ์

โฟลเดอร์ของเลเยอร์ (Layer Folder) เป็นส่วนที่ ช่วยในการจัสเลเยอร์ให้เป็นระเบียบโสย
จัสแยกออกเป็นกลุ่ม เช่นเสียวกับการจัสระบบไฟล์ในเคร่ืองของเราในโฟลเสอร์นีนจะสามารถ
บรรจุเลเยอร์ หรือโฟลเสอร์ย่อย  อีกก็ไส้ 

 

คอลัมน์ Lock 

Delete Layer 
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 การสร้างโฟลเดอร์ของเลเยอร ์
 คลิกที่เลเยอร์ใส  แล้วเลือกเมนูค าสั่ง Insert เลือกค าสั่ง Layer Folder  หรือ    คลิกขวาที่ช่ือ  

เลเยอร์ แล้วเลือกค าสั่ง Insert Folder หรือ คลิกปุ่ม  Insert Layer Foldr ที่ส้านล่างของพาเนล
จะปรากฏโฟลเสอร์อยู่เหนือเลเยอร์ที่เราเลือก 
 
 
 
 
 
 
 
 

 การย้ายเลเยอร์เข้าไปไวใ้นโฟลเดอร ์
 สรากส์เมาส์ลากเลเยอร์นันนไปวางที่ช่ือโฟลเสอร์ที่ต้องการ 

 การเปิด-ปิดโฟล์เดอร ์
 คลิกที่เครื่องหมายสามเหลี่ยมหน้าช่ือโฟลเสอร์หากต้องการ 
เปิส-ปิสโฟล์เสอร์ทันงหมส ให้คลิกขวาแล้วเลือกค าสั่ง  Expand All  
Folders เพื่อเปิส หรือ Collapse All Folders เพื่อปิส 
 
 
 
 
 
 
 

 การคัดลอกเนื้อหาในโฟล์เดอร์ของเลเยอร ์

1. คลิกที่เครื่องหมายสามเหลี่ยมหน้าช่ือโฟล์เสอร์ เพื่อเปิสโฟล์เสอร์ 
2. คลิกที่ช่ือโฟลเสอร์ เพื่อเลือกทันงโฟลเสอร์ 

Insert Layer Folder 
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3. เลือกเมนูค าสั่ง Edit เลือกค าสั่ง Copy Frames 
4. เลือกเมนูค าสั่ง  Insert เลอืกค าสั่ง Layer Folder เพื่อสร้างโฟล์เสอร์เลเยอร์ใหม่ 
5. คลิกที่ช่ือโฟลเสอร์ใหม่ที่ไส้ แล้วเลือกเมนูค าสั่ง Edit เลือกค าสั่ง Paste Frames 
 

 การย้ายหรือคัดลอกออบเจ็กต์ระหว่างเลเยอร์ ซนี หรือไฟล์ 
1. เลือกออบเจ็กต์ที่ต้องการจะย้ายหรือคัสลอก 
2. เลือกเมนูค าสั่ง Edit  เลือกค าสั่ง Cut เพื่อย้าย หรือ Edit เลือกค าสั่ง Copy เพื่อคัสลอก 
3. เลือกเลเยอร์ ซีน หรือไฟล์ที่ต้องการจะน าออบเจ็กต์นันนไปไว้ 
4. เลือกเมนูค าสั่ง Edit เลือกค าสั่ง Paste เพื่อน าไปใส่ลงตรงกลางสเตจ หรือ เลือกเมนู

ค าสั่ง Edit เลือกค าสั่ง Paste in Place เพื่อน าไปวางบนสเตจในต าแหน่งเสียวกับที่
ออบเจ็กต์นันนอยู่  

 

 การจัดการซีน (Scene) 
ในการสร้างมูฟว่ีขึนนสักไฟล์หนึ่งนันน เราควรที่จะแบ่งเร่ืองราวออกเป็นฉาก  ที่เรียกว่า ซีน เมื่อ 

ไฟล์มูฟว่ีที่มีหลาย  ซีนแสสงผล มันจะแสสงเรียงตามล าสับที่เราจัสไว้ให้ โสยเฟรมในมูฟว่ีจะถูก
ใส่หมายเลขล าสับเรียงต่อเนื่องกันไป ตัวอย่างเช่น ถ้ามูฟว่ีของเราประกอบส้วย 2 ซีน  ละ 10 เฟรม 
เฟรมในซีนที่ 2 จะเร่ิมที่เฟรมที่ 11-20 เป็นต้น 

 
  พาเนล Scene  

พาเนล Scene จะเป็นส่วนที่ช่วยให้เราจัสการกับซีนไส้อย่าง 
สะสวกไม่ว่าจะเป็นการเพิ่มซีน การลบซีน หรือการเรียงล าสับ
ซีน เราสามารถเปิสใช้พาเนล Scene ไส้ โสยเลือกเมนูค าสั่ง 

Window เลือกค าสั่ง Design Panels แล้วเลือกที่ Scene  
 

 การเพิ่มซีนใหม่  
เลือกเมนูค าสั่ง Insert เลือกค าสั่ง Scene หรือ คลิกที่ปุ่ม    

Add Scene  ส้านล่างของ พาเนล Scene  
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   การเปลี่ยนชื่อซีน  
 ในพาเนล Scene สับเบินลคลิกที่ช่ือซีน แล้วเพิ่มช่ือใหม่ 
 

 การท าซีนซ้ า 
1. ในพาเนล Scene คลิกที่ซีนที่จะท าซน า 
2. คลิกที่ปุ่ม  Duplicate Scene ส้านล่างของพาเนล Scene 

 การไปยังซีนที่ต้องการ 
  เลือกเมนูค าสั่ง View เลือกค าสั่ง Go To  

 
 

หรือ คลิกที่ปุ่ม  Edit Scene ส้านบนขวาของหน้าต่างชินนงาน 

 
 

 การจัดล าดับซีน  
 ในพาเนล Scene ลากซีนนันนไปยังล าสับที่ตอ้งการ 

 การลบซีน  
 คลิกที่ปุ่ม  Delete Scene ส้านล่างของพาเนล  Scene   
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 การจัดการเฟรมใน Timeline  
ในพาเนล Timeline เราสามารถจัสการกับเฟรมและคีย์เฟรมเพื่อสร้างการเคลื่อนไหวไส้

ตาม ที่ เราต้องการ ซ่ึงอาจเป็น 

 การเลือกเฟรม 
ก่อนที่จะจัสการกับเฟรมต่าง  ไส้นันน เราจะต้องเลือกเฟรมที่จะจัสการเสียก่อน ซึ่งเรา

สามารถ เลือกเฟรมไส้ 2 วิธีส้วยกัน ไส้แก่ 
- การเลอืกทลีะเฟรม 

โสยการคลิกที่เฟรมที่ต้องการ 
 

  - การเลอืกเป็นช่วง 
คลิกที่เฟรมแรกที่จะเลือกกสปุม่ Shift ค้างไว้ แล้วคลิกที่เฟรมสุสท้ายของ

ช่วงที่ต้องการ 
    
 
 

 
 

 การคัดลอกเฟรม  

กสปุ่ม Alt ค้างไว้ คลิกที่เฟรมที่จะคัสลอก แล้วลากไปยังต าแหน่งที่จะคัสลอกไปหรือเลือก 
เฟรมที่จะคัสลอก เลือกเมนูค าสั่ง Edit เลือกค าสั่ง Copy Frames แล้วไปเลือกเฟรมที่จะคัสลอกไปไว้ 
และเลือกเมนูค าสั่ง Edit เลือกค าสั่ง Paste Frames  

 
 
    
 

 
 
 
 

คลิกที่เฟรมแรก กด Shift ค้างไว้คลิกที่
เฟรมสุดท้าย 

เลือกเฟรม เลือก Edit 
> Copy Frames 

คลิกที่เฟรมที่จะ
คัดลอกไปไว้ 

เลือก Edit > Paste Frames 
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 การลบเฟรม 
1. เลือกเฟรมหรือคีย์เฟรมที่จะลบ 
2. คลิกขวาแล้วเลือกค าสั่ง  Remove Frame  
 

 
 

 
 
   
 
 
 
 การเปลี่ยนคีย์เฟรมไปเป็นเฟรม 

 เลือกคีย์เฟรมนันน แล้วเลือกเมนูค าสั่ง Modify เลือกค าสั่ง Timeline แล้วเลือกที่  Clear 
Keyframe  คีย์เฟรมนันนรวมทันงเฟรมก่อนหน้าจะถูกแทนที่ส้วยออบเจ็กต์ในเฟรมก่อนหน้านันน 

 
 

 การขยายช่วงเฟรม  
 กสปุ่ม Alt ค้างไว้ แล้วลากคีย์เฟรมสุสท้ายออกไป 

 การย้ายต าแหน่งคีย์เฟรม 
 ลากคีย์เฟรมนันนไปยังต าแหน่งใหม่ 

เลือกเฟรมที่จะลบ เฟรมท่ีเหลืออยู ่
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 การปรับการแสดงเฟรม  

คลิกปุ่ม  ตรงมุมบนขวาของส่วนแสสงเฟรมในพาเนล Timeline 

 
 
เลือก Tiny, Small, Normal, Medium, หรือ Large เพื่อปรับขนาสชอ่งเฟรมจากเล็กไปใหญ่ 
 

 
 

 
 

 
 

 
 

 
 
 

Tiny 

Small 

Normal 

Medium 

Large 
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 การดูผลการแสดงมูฟว่ี 
การสูผลการแสสงจากเมนู Control 

 
 
 

เลือก Preview เพ่ือแสดงรูปออบเจ็กต์ในแต่ละเฟรมด้วย 

เลือก Preview in Content เพ่ือแสดงทั้งสเตจในแต่ละเฟรม 
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ความหมายค าสั่งต่าง  ในเมนู Control 
     

ค าสั่ง ค าอธิบาย 
Play แสสงผลซีนบนสเตจ 
Rewind ถอยกลับ 
Go To End ไปยังซีนสุสท้าย 
Step Forward One Frame เลื่อนเสินหน้าทีละเฟรม 
Step Backward One Frame ถอยหลังทีละเฟรม 
Test Movie แสสงผลมูฟว่ีในบราวเซอร์ 
Debug Movie แก้ไขมูฟว่ี 
Test Scene แสสงผลซีนในบราวเซอร์ 
Loop Playback แสสงผลแบบวนรอบ 
Play All Scenes แสสงผลทุกซีน 
Enable Simple Frame Actions ให้ทสลองแอ็คชั่นที่ก าหนสไว้ในเฟรมไส้ 
Enable Simple Buttons ให้ทสลองกสปุ่มไส ้
Mute Sounds ปิสเสียงขณะแสสงผล 

 การดูผลการแสดงด้วย Controller  
เปิสใช้แผงควบคุม โสยเลือกเมนูค าสั่ง Window เลือกค าสั่ง  Toolbars เลือกค าสั่ง Controller 
 
 
 
 
 
 
เร่ิมแสสงผลให้คลิกที่ปุ่ม Play  
หยุสการแสสงผล ให้คลิกที่ปุ่ม Step Forward เพื่อเสินหน้า  หรือคลิกที่ปุม่  Step Backward เพื่อถอย
หลัง หรือกสปุ่ม < และ > บนแป้นพิมพ ์
 
 

Stop 

Go to first frame 

Step back one frame  

Play 
Step Forward one Frame 

Go to last frame 
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 การดูผลการแสดงด้วยค าสั่ง Test Movie 

 ถึงแม้ว่าเราจะสามารถสูผลการแสสงของมูฟวี่ท่ีเราสร้างขึนนไส้ทันทีภายในไฟล์ชินนงานที่เรา
ก าลังสร้างอยู่นันนก็ตาม แต่จะมีการเคลื่อนไหวบางอย่างรวมทันงการเคลื่อนไหวที่ต้องมีการโต้ตอบ
จะไม่สามารถแสสงผลไส้ภายในชินนงานจนกว่าเราจะสร้างให้เป็นไฟล์ Flash movie เสียก่อน สังนันน
ในการแสสงผลการเคลื่อนไหวเหล่านีน เราจะต้องใช้ค าสั่ง Test Movie ซึ่งจะท าหน้าที่ในการสร้าง
ไฟล์ Flash movie จากไฟล์ชินนงานขณะนันนและแสสงผลให้ทันที 
 เลือกเมนูค าสั่ง Control เลือกค าสั่ง Test Movie เพื่อแสสงผลทันงมูฟว่ี หรือ เลือกเมนูค าสั่ง 
Control เลือกค าสั่ง Test Scene เพื่อแสสงผลเฉพาะซีนขณะนันน ไฟล์ .swf ที่ไส้จะอยู่ในโฟล์เสอร์
เสียวกับไฟล์ .fla  

 การขอดูผลงานการแสดงในเว็บบราวเซอร์ 

 เราสามารถขอสูผลการแสสงของไฟล์ชินนงานขณะนันนในเว็บบราวเซอร์ไส้ทันที โสยเลือก
เมนูค าสั่ง File เลือกค าสั่ง Publish Preview เลือกค าสั่ง HTML  
 โปรแกรมจะท าการสร้างไฟล์ Flash movie (.swf) และแสสงผลในเว็บบราวเซอร์ที่มีอยู่ใน
ระบบเคร่ืองมือของเราส้วยโปรแกรม Flash Player ไฟล์ .swf       ที่ไส้จะอยู่ในโฟล์เสอร์เสียวกับ
ไฟล์ .fla 
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หน่วยการเรียนรู้ที่ 7 

  การสร้าง Animation 
  มาตรฐานการเรียนรู้ / ตัวชี้วัด  

      กลุ่มสาระการงานอาชีพและเทคโนโลยี   
        สาระที่  3  เทคโนโลยีสารสนเทศและการส่ือสาร 

          เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การเรียนรู้  
การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม                   
       ตัวชี้วัด   
            1.   ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน 

    สาระส าคัญ 
               รู้จักกับ ประเภทของ Animation 

และการสร้าง Animation ในแบบต่างๆ 

    สาระการเรียนรู้ 
        -  ความรู้ 
             1.  รู้จักกับประเภทของ Animation 
          2.  สามารถสร้าง Animation ในแบบต่างๆ ได้ 
         -  ทักษะ / กระบวนการ 

               1.  ศึกษาและอธิบายการใช้ค าสั่ง การสร้าง Animation 
               2.  ฝึกปฏิบัติเกี่ยวกับค าสั่งต่าง ๆ ในโปรแกรม จากนันนลองทดสอบผลลัพธ์ของค าสั่ง 
         -  คุณลักษณะที่พึงประสงค์ 
               1.  มีวินัย 
               2.  ใฝ่เรียนรู้ 
               3.  มุ่งมั่นในการท างาน 
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 แอนิเมชัน (Animation) เป็นการสร้างออบเจ็กต์ให้มีการเคลื่อนไหว มักนิยมใช้ประกอบใน
ชินนงานทั่วไป ไม่ว่าจะเป็นเว็บเพจ, เกม , หรือเอกสารสมัยใหม่ โปรแกรม Flash ที่เราก าลังใช้อยู่นีน 
เป็นโปรแกรมที่ดีโปรแกรมหนึ่งที่สามารถสร้างงานแอนิเมชันได้อย่างง่ายดาย และน าไปใช้กัน
อย่างแพร่หลาย 
 ส าหรับในเร่ืองนีนเราจะได้เรียนรู้ขันนตอนการสร้างแอนิเมชันในรูปแบบต่างๆ ทันงหมด เช่น 
หากต้องการน าออบเจ็กต์หรือภาพหลายๆ ภาพมาเรียงต่อกันเป็นผลงานแอนิเมชันก็สามารถท าได้
ด้วย Frame by Frame เมื่อต้องการสร้างแอนิเมชันให้มีการเคลื่อนไหวสามารถท าได้ด้วย Classic 
Tweening หากมีออบเจ็กต์ตันงแต่ 2 ชินนและต้องการแปลงจากชินนหนึ่ งเป็นอีกชินนหนึ่ งให้ใช้ 
Tweening Shape หรือต้องการสร้างแอนิเมชันให้เคลื่อนไหวไปตามเส้นไกด์สามารถท าได้ด้วย 
Guide Layer และการสร้างแอนิเมชันในลักษณะ Mask Layer ใช้ในกรณีเมื่อต้องการสร้างผลงาน
แอนิเมชันในลักษณะเหมือนมีแสงไฟก าลังหมุนและส่องลงบนภาพ 

ชนิดของแอนิเมชัน 
 การสร้างแอนิเมชันภาพต่อเน่ืองด้วย Frame by Frame  

การสร้างแอนิเมชันในลักษณะ Frame by Frame  เราจะต้องมีออบเจ็กต์ ภาพ หรือไฟล์งาน 
ตันงแต่ 1 ไฟล์เป็นต้นไป และท าการ Insert Keyframe เพื่อแทรกข้อมูลแต่ละชินนลงในคีย์เฟรม 
หลังจากได้แทรกข้อมูลเรียบร้อยแล้ว จึงท าการทดสอบการแสดงผล โปรแกรมก็จะท าการเล่น
แสดงข้อมูลทันงหมดให้อย่างต่อเนื่องจนกลายเป็นผลงานแอนิเมชันขึนนมา ซึ่งสามารถเปรียบเทียบ
การท างานได้กับการท างานของฟิล์มภาพยนตร์จะท าการฉายเฟรมหนังแต่ละเฟรมจนกลายเป็น
ภาพยนตร์ขึนนมา 
 ในที่นีน เราจะมาลองสร้างภาพผีเสืนอบิน ซึ่งทุกๆ เฟรมจะเปลี่ยนท่วงท่าและต าแหน่งไปดัง
รูป 

 
 
            1. เลือกที่เลเยอร์ที่จะสร้างภาพเคลื่อนไหวแล้วคลิกที่เฟรมในเลเยอร์นันนที่จะเร่ิมสร้างใน
ที่นีน ให้สร้างไฟล์ใหม่ และคลิกที่เฟรมแรกของ Layer 1 

เฟรม 1 
เฟรม 6 

เฟรม 3 

เฟรม 2 
เฟรม 4 

เฟรม 5 
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 2. หากเฟรมนันนยังไม่เป็นคีย์เฟรม ให้เลือกเมนูค าสั่ง Insert เลือกค าสั่ง Keyframe  

 
 

 3. สร้างภาพแรกของการเคลื่อนไหวขึนนในเฟรมนันน โดยอาจวาดขึนนเองหรือน าจากไฟล์อืน่
เข้ามาใช้ด้วยเมนูค าสั่ง File เลือกค าสั่ง Import ก็ได้ 
 4. คลิกที่เฟรมถัดไป แล้วเลือกเมนูค าสั่ง Insert เลือกค าสั่ง Keyframe  
 5. สร้างภาพถัดไปของการเคลื่อนไหวหากน าเข้าจากไฟล์ อย่าลมืลบรูปเก่าออกด้วย 
 6. ท าขันนตอนที่ 4 และ 5 ซน าจนครบทุกเฟรมของการเคลื่อนไหว 
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เลือกเมนูค าสั่ง Control  เลือกค าสั่ง Play เพื่อดูผล และก็บันทกึภาพเก็บไว้ในชื่อ Butterfly   
 
 

 การปรับการเคล่ือนไหวด้วย Onion skinning  
 Onion skinning เป็นส่วนที่ช่วยให้เราสามารถเห็นภาพในเฟรมก่อนหน้าหรือหลังเฟรม
ขณะนันน หรือทุกๆ เฟรมพร้อมๆ กันได้ โดยไม่ต้องไปเลือกเฟรมกลับไปกลับมา ท าให้สามารถ
ปรับแต่งภาพในแต่ละเฟรมให้มีการเคลื่อนไหวอย่างนุ่มนวลได้อย่างสะดวก 
 ส่วนของ Onion skinning นีนจะอยู่ในตอนล่างของพาเนล Timeline  
 
 
 
 
 
 
 
 
 
 
 
 

Onion Skin  
Onion Skin Outlines 

Edit Multiple Frames 
Modify Onion Markers 
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การขอดูหลายๆ เฟรมพร้อมกัน 
1. คลิกที่เฟรมหลักที่จะด ู
2. คลิกที่ปุ่ม  Onion Skin 
โปรแกรมจะแสดงภาพในเฟรมก่อนหน้าเฟรมนันนให้ หากต้องปรับจ านวนเฟรมที่จะดู ให้ 

ลากส่วนของ Start Onion Skin และ End Onion Skin marker ซึ่งอยู่ในแถบหัวของพาเนล Timeline  

 
 
 
 การปรับการแสดงของ Onion Skinning  
 การแสดงกรอบเฟรมแทนภาพ ให้คลิกที่ปุ่ม  Onion Skin Outlines หากต้องการปรับ
ต าแหน่งภาพในเฟรม ให้ลากกรอบเฟรมนันน หากต้องการแก้ไขภาพในเฟรมใดๆ ก็ได้ ให้คลิกที่  
Edit Multiple Frames  
 

 
 
 

Start Stop 
Onion Skin Marker 

Onion Skin Outlines 
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 การปรับการแสดง Onion Skin Marker 
คลิกที่ปุ่ม  Modify Onion Marker แล้วลักษณะการแสดงผลจากเมนู  
 
 
 
 
 
 
 

 การสร้างแอนิเมชันภาพเคล่ือนไหว ด้วย Classic  Motion Tweening  

การสร้างแอนิเมชันในลักษณะ Classic Motion Tweening คือ การสร้างแอนิ เมชันโดยใช้
ออบเจ็กต์เพียง 

แสดง Onion Skin Marker ในแถบหัวของพาเนล Timeline ตลอด
ไม่ว่าจะเลือกใช้ Onion Skinning หรือไม่ก็ตาม 

ล็อคไม่ให้ Onion Skin Marker เล่ือนตามเฟรมที่เลือก 

แสดง 2 เฟรมก่อนหน้าและถัดไปจากเฟรมที่เลือก 
แสดง 5 เฟรมก่อนหน้าและถัดไปจากเฟรมที่เลือก 
แสดงทุกเฟรม 

Edit Multiple Frames 

คลิกทีเ่ฟรมที่จะแก้ไข
แล้วคลิกปุ่ม Edit  
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ชินนเดียว จากนันนจึงส่ังให้มีการเคลื่อนไหวและการเปลี่ยนแปลงเกิดขึนนมาที่ออบเจ็กต์นันน 
      ดังตัวอย่างต่อไปนีนจะท าการสร้างแอนิเมชันในลักษณะ Classic Tweening คือ ให้รถมีการแล่น
มาถึงเฟรมที่ 5 และมีขนาดใหญ่ขึนน จากนันนในเฟรมที่ 10 ให้จานบินคันนีนมีขนาดเล็กลง ถูกหมุน
กลับด้าน และมีสีลดลงไปจากเดิมส าหรับขันนตอนการท างานสามารถท าได้ ดังนีน 

1. สร้างออบเจ็กต์ (รูปรถ) ไว้ในเฟรมที่ 1  
2. คลิกขวาเฟรมที่ 5 และเลือกค าสั่ง Insert Keyframe เฟรมทันงหมดจะมีความยาวจ านวน 

5 เฟรม 
3. คลิกขวาเฟรมที่ 10 และเลือกค าสั่ง Create Classic Tween เพื่อสร้างการเคลื่อนไหว

จนถึงเฟรมที่ 10 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 

4. เลื่อนวัตถุลงมาข้างล่างและคลกิปุ่ม Free Transform Tool  ที่ทูลบ็อกซ ์
5. ดรากส์เมาส์ท าการขยายขนาดตามต้องการ 

2.สร้างออบเจ็กต์ไว้ในเฟรมที่ 10
และ เลือกค าส่ัง Insert keyframe 

1.สร้างออบเจ็กต์ไว้ในเฟรมที่ 1 

3.คลิกเมาส์ขวาเฟรมที่ 10 และเลือก
ค าส่ัง Create Classic Tween 



 135 

6. คลิกเมาส์ขวาเฟรมที่ 15 และเลือกค าสั่ง Insert Keyframe จากนันนจะปรากฏคีย์เฟรม
ขึนนมาบนเฟรมที่ 15 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. ดรากส์เมาส์ท าการย่อขนาดให้เล็กลงไปจากเดิม 
8. คลิกเมนูค าสั่ง Modify เลือกค าสั่ง Transform  เลือกค าสั่ง  Flip Horizontal จากนันน

ออบเจ็กต์ จะถูกหมุนกลับด้านไป 
9. คลิกหน้าต่างค าสั่ง Properties  
10. ที่ Color ให้คลิกเลือก Alpha จากนันนออบเจ็กต์ จะมีสีลดลงไปจากเดิม 

5.ดรากส์เมาส์ท าการขยายขนาด 

4.คลิกปุ่ม Free Transform Tool 

6.คลิกเมาส์ขวาเฟรมที่ 15 และ เลือก
ค าส่ัง Insert Keyframe 



 136 

11. คลิกขวาที่ keyframe  ที่ 15 เลือก Create Classic Tween 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.คลิกเมนู Modify > Transform 
> Flip Horizontal 

7.ดรากส์เมาส์ท าการย่อขนาด 

9.คลิกหน้าต่าง Properties 

10.คลิกเลือก Alpha  

ปรับค่า Alpha ตามต้องการ 
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จากนันนลองทดสอบภาพแอนิเมชันที่เราสร้างขึนนมาโดยการ  
กด <Ctrl+Enter> 
 

 การสร้างแอนิเมชันแปลงรูปโฉมรูปด้วย Tweening Shape 
การสร้างแอนิเมชันในลักษณะ Tweening Shape คือ การสร้างแอนิเมชันโดยใช้ออบเจ็กต์ หรือ 

ภาพ 2 ชินนโดยชินนแรกจะวางอยู่ที่ต าแหน่งเร่ิมต้นของเฟรม และอีกชินนหนึ่งจะวางอยู่ที่ต าแหน่ง
สุดท้ายของเฟรม จากนันนจึงสั่งให้มีการ รวมออบเจ็กต์ หรือภาพทันง 2 ชินนเข้าด้วยกัน และเมื่อท าการ
แสดงผลภาพหนึ่งก็จะแปลงกลายเป็นอีกภาพหนึ่ง  

ดังตัวอย่างต่อไปนีนจะท าการสร้างแอนิเมชันในลักษณะ Tweening Shape โดยเร่ิมแรกจะน า 
ออบเจ็กต์ที่  1 ไว้เฟรมที่  1 และท าการ Insert Keyframe เพื่อวางออบเจ็กต์ที่  2 ไว้ในเฟรมที่  10 
จากนันนจะรวมออบเจ็กต์ทันง 2 เข้าด้วยกัน เมื่อท าการเล่นแสดงแอนิเมชัน จากออบเจ็กต์ที่  1 จะ
กลายเป็นออบเจ็กต์ที่ 2 ให้โดยอัตโนมัติส าหรับขันนตอน การท างานสามารถท าได้ดังนีน 

1. สร้างออบเจ็กต์ ไว้ในเฟรมที่ 1 
2. คลิกเมาส์ขวาเฟรมที่ 10 และเลือกค าสั่ง Insert Keyframe จากนันนจะปรากฏคีย์เฟรม

ขึนนมาบนเฟรมที่ 10  
3. เปลี่ยนรูปทรงใหม่ให้แตกต่างจากรูปภาพที่อยู่ใน เฟรมที่ 1  
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4. คลิกหน้าต่างค าสั่ง Properties คลิกที่ Tween ให้คลิกเลือก Shape จากนันนเมื่อท าการ
แสดงผลออบเจ็กต์ที่ 1 จะถูกรวมและแปลงเป็นออบเจ็กต์ที่ 2 ให้โดยอัตโนมัติ  

 
 
 
 
 

1.สร้างออบเจ็กต์ไว้ในเหรมที่ 1 

2.คลิกเมาส์ขวาเฟรมที่ 10 และ   
   เลือกค าส่ัง Insert Keyframe 

3. เปล่ียนรูปทรงใหม่ให้แตกต่างจาก
รูปภาพเดิม 
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จากนันนลองทดสอบภาพแอนิเมชันที่เราสร้างขึนนมาโดยการ กด <Ctrl+Enter> 
 
 
 
 
 
 
 
 
 

 การสร้างแอนิเมชันตามเส้นไกด์ด้วย Guide Layer  
การสร้างแอนิเมชันในลักษณะ Guide Layer คือ การสร้างแอนิเมชันโดยให้ออบเจ็กต์ 

เปลี่ยนแปลงเคลื่อนที่ไปตามเส้นไกด์ ส าหรับขันนตอนการสร้างแอนิเมชันในลักษณะนีน จะต้องท า
การคลิกปุ่ม Add Classic Guide ที่ไทม์ไลน์จากนันนสร้างเส้นไกด์ที่ใช้ในการควบคุมทิศทางการว่ิง
ของออบเจ็กต์ขึนนมา 

5.คลิกเลือก Create shape tween 

การแสดงผลออบเจ็กต์ที่ 1 
จะถูกรวมและแปลงเป็น
ออบเจ็กต์ที่ 2 
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ดังตัวอย่างต่อไปนีนจะท าการสร้างแอนิเมชันในลักษณะ Guide Layer คือ ให้ใบไม้ไป 
ตามเส้น Guide ที่ได้วาดไว้  

1. สร้างออบเจ็กต์ ไว้ในเลเยอร์ที่ 2 
2. คลิกเมาส์ขวาเฟรมที่ 20 และเลือกค าสั่ง Insert keyframe เฟรมทันงหมดจะมีความยาว

จ านวน 20 เฟรม 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. คลิกเมาส์ขวาที่เฟรมที่ 20 และเลือกค าสั่ง Create Classic Tween  เพื่อสร้างการ
เคลื่อนไหวจนถึงเฟรมที่ 20 

 

2.คลิกเมาส์ขวาเลือกค าส่ัง 
Insert keyframe 

1.สร้างออบเจ็กต ์
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4. คลิกขวาที่ เลเยอร์ 2 เลือกค าสั่ง   Add Classic Guide ที่ไทม์ไลน์ จากนันนจะปรากฏ      
เลเยอร์ใหม่ ขึนนมาจ านวน 1 เลเยอร์ สามารถสังเกตได้ว่า Layer 2 ได้ถอยเยืนองเข้าไป 1 
แท็บ ซึ่งหมายถึง Layer 2 ได้ถูกไกด์เรียบร้อยแล้ว  

5. คลิกปุ่ม Pencil Tool ที่ทูลบ็อกซ์  
6. ดรากส์เมาส์สร้างเส้นพาธที่ต้องการให้เป็นแนวว่ิงของออบเจ็กต ์

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. คลิกปุ่ม Arrow Tool    ที่ทูลบ็อกซ ์
8. ดรากส์เมาส์ย้ายออบเจ็กต์มาไว้ยังต าแหน่งสุดท้ายของเส้นไกด์ 

 

5.คลิกปุ่ม Pencil Tool 

4.คลิกขวาเลือกค าส่ัง Add 
Classic Guide 

6.ดรากส์เมาส์สร้างเส้นพาธ 



 142 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ปรับทิศทางการเคลือ่นทีใ่ห้สมจริง 
 จากตัวอย่างที่ผ่านมาเมื่อทดสอบดูการเคลื่อนที่ของออบเจ็กต์ทันงหมด จะสังเกตเห็นว่า
ออบเจ็กต์มีการเคลื่อนที่ไปตามเส้นไกด์ในทิศทางแนว 180 องศา ซึ่งท าให้ดูไม่สมจริงเท่าที่ควร 
 ดังนันนคุณสามารถสั่งค าสั่ง Orient to path เพื่อให้ออบเจ็กต์เคลื่อนที่ไปตามเส้นพาธที่สร้าง
ขึนน จากนันนจึงท าการหมุนออบเจ็กต์ให้เอียงไปตามทิศทางการเคลื่อนที่ของเส้นพาธ และเมื่อท าการ
ทดสอบการแสดงผลแอนิเมชัน ผลงานที่สร้างขึนนก็จะมีการเคลื่อนที่ได้อย่างสมจริงมากขึนน 

1. คลิกเมนูค าสั่ง  Window เลือกค าสั่ง Properties ให้ปรากฎเครื่องหมายถูก 
2. คลิกเฟรมที่ 1 ของ Layer 1 เพื่อเลือกออบเจ็กต์ ต าแหน่งแรกสุด ขณะที่อยู่ในเลเยอร์ 2  
3. คลิกให้ปรากฏเคร่ืองหมายถูกที่ Orient to path เพื่อให้ออบเจ็กต์เคลื่อนที่ไปตามเส้น

พาธที่สร้างขึนน 

4. คลิกปุ่ม Free Transform Tool    ที่ทูลบ็อกซ์ 
5. ดรากส์เมาส์หมุนออบเจ็กต์ไปในทิศทางเดียวกับเส้นพาธ 

 
 
 
 

7.คลิกปุ่ม Arrow Tool 

9.ดรากส์เมาส์ย้ายออบเจ็กต ์
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6. คลิกเฟรมที่ 15 ของ Layer 1 เพื่อเลือกออบเจ็กต์ ต าแหน่งสุดท้ายขณะที่อยู่ในเลเยอร์ 1 
7. คลิกให้ปรากฏเคร่ืองหมายถูกที่ Orient to path เพื่อให้ออบเจ็กต์เคลื่อนที่ไปตามเส้น

พาธที่สร้างขึนน 
8. ค ลิ ก ปุ่ ม  Free Transform Tool   ที่ทูลบ็อกซ์ดรากส์เมาส์หมุนออบเจ็กต์ไปใน

ทิศทางเดียวกันกับเส้นพาธ 

คลิกเฟรมที่ 1 ของ Layer 2 

ดรากส์เมาส์หมุนออบเจ็กต์ 

คลิกให้ปรากฏเครื่องหมายถูก
ท่ี Orient to path 

คลิกปุ่ม Free Transform Tool 
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จากนันนลองทดสอบภาพแอนิเมชันที่เราสร้างขึนนมาโดยการ กด <Ctrl+Enter> 

 
 
 

คลิกเฟรมที่ 20 ของ Layer 2 

คลิกปุ่ม Free Transform Tool 

ดรากส์เมาส์หมุนออบเจ็กต์ 
คลิกให้ปรากฏเครื่องหมายถูก
ท่ี Orient to path 
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 สร้างแอนิเมชันส่องไฟลงบนภาพด้วย Mask Layer  
การสร้างแอนิเมชันในลักษณะ Mask Layer คือ การสร้างแอนิเมชันโดยแสดงภาพภายใน 

ขอบเขตที่ก าหนดไว้ซึ่งมีลักษณะเหมือนกับการส่องไฟลงบนเลเยอร์ที่ได้ถูก Mask ไว้ 
 ดังนันนจึงต้องมีอย่างน้อย 2 เลเยอร์ เลเยอร์หนึ่งไว้ส าหรับใส่ข้อมูลที่จะถูก Mask เช่น 
ออบเจ็กต์ ภาพ ซ่ึงสามารถเห็นข้อมูลที่อยู่ในเลเยอร์นีนได้ ก็ต่อเมื่อได้มีการน าข้อมูลของอีกเลเยอร์
หนึ่งจะท าการ Mask มาวางซ้อนทับหรือเคลื่อนที่ผ่าน จึงสามารถเปรียบได้ว่าเลเยอร์ที่จะท าการ 
Mask นีน เป็นเสมือนล าแสงไฟที่ส่องลงไปยังข้อมูลของเลเยอร์ที่จะถูก Mask นั่นเอง 
 ตัวอย่างต่อไปนีนจะท าการสร้างแอนิเมชันในลักษณะ Mask Layer โดยเลเยอร์ ที่ 1 ที่จะถูก 
Mask ได้มีข้อมูลเป็นรูปวงกลมก็จะเคลื่อนส่องผ่านไปที่รูปภาพ ส าหรับขันนตอนการท างานสามารถ
ท าได้ ดังนีน 

1. คลิกเมนูค าสั่ง  Modify เลือกค าสั่ง Document จากนันนจะปรากฏไดอะล็อกบอ็กซ์ 
Document Properties ขึนนมา 

2. ที่ Background Color ให้คลิกเลือกสเีทา จากนันนที่ฉากหลังจะมีพืนนเป็นสีด า 
3. คลิกปุ่ม OK เพื่อยืนยันค าสั่ง 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเมนู Modify > Document 

คลิกเลือกสีเทา 

คลิกปุ่ม OK 
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4. คลิกเมนูค าสั่ง File เลือกค าสั่ง Import แล้วเลือก Import to stage เพื่อน าไฟล์ภาพ ที่
ต้องการเข้ามา 

5. คลิกเมาส์ขวาเฟรมที่ 30 และเลือกค าสั่ง Insert  Frame เฟรมทันงหมดจะมีความยาว
จ านวน 30 เฟรม 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

6. คลิกปุ่ม Insert Layer   ที่ไทม์ไลน์ จากนันนจะปรากฏเลเยอร์ใหม่ ขึนนมาจ านวน 1 เล
เยอร์ 

7. สร้างออบเจ็กต์ ไว้ใน Layer  2  

คลิกเมนู File > Import >Import to Stage 

คลิกเมาส์ขวาเฟรมที่ 30 และ 
เลือกค าส่ัง Insert  Frame 
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8. คลิกเมาส์ขวาเฟรมที่ 30 เลือก Insert Keyframe และเลือกค าสั่ง Create Classic Tween 
เพื่อสร้างการเคลื่อนไหวจนถึงเฟรมที่ 30 

9. ดรากส์เมาส์ย้ายออบเจ็กต์ไปอีกด้านหนึ่งของออบเจ็กต์ที่อยู่ใน Layer 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

สร้างออบเจ็กต์ไว้ใน Layer 2 

คลิกปุ่ม Insert Layer  

คลิกเมาส์ขวาเฟรมที่ 30  
เลือก Insert Keyframe
และเลือกค าส่ัง Create  
Classic Tween 

 
 
 
 
 

ดรากส์เมาส์ย้ายออบเจ็กต์ 
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10. คลิกเมนูค าสั่ง  Window เลือกค าสั่ง Properties ให้ปรากฏเครื่องหมายถูก 
11. คลิกเฟรมไหนก็ได้ระหว่างเฟรมที่ 1 ถึง เฟรม 30 ของ Layer 2 เพื่อเลือกออบเจ็กต์ 

ต าแหน่งแรกสุดที่อยู่ในเลเยอร์ 2 
12. ที่ Rotate  ให้คลิกเลือก CW เพื่อให้ลักษณะการหมุนเป็นแบบตามเข็มนาฬิกา  
13. พิมพ์จ านวนที่ต้องการให้มีการหมุน เป็น 3 Times ออบเจ็กต์จะถูกหมนุตามเข็มนาฬิกา

ไปเป็นจ านวน 3 รอบ 
14. คลิกเมาส์ขวาที่เลเยอร์ 2 เลือกค าสั่ง Mask จากนันนออบเจ็กต์ในเลเยอร์ที่ 1 ที่ได้ถูก 

Mask ไว้อยู่ จะปรากฏขึนนมาเฉพาะบริเวณที่ออบเจ็กต์ ในเลเยอร์ 2 วางซ้อนทับไว้อยู่
เท่านันน  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเฟรมไหนก็ไดข้อง Layer 2  

คลิกเลือก CW  พิมพ์จ านวนที่ต้องการให้มีการหมุน 

คลิกเมาส์ขวาที่เลเยอร์ 2 
เลือกค าส่ัง Mask  
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จากนันนทดสอบภาพแอนิเมชันที่เรา Mask Layer ขึนนมาโดยการ กด <Ctrl+Enter> 
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หน่วยการเรียนรู้ที่ 8 

  การก าหนดสร้างการเชื่อมโยงและการใส่เสียงประกอบ 
  มาตรฐานการเรียนรู้ / ตัวชี้วัด  

    กลุ่มสาระการงานอาชีพและเทคโนโลยี   
        สาระที่  3  เทคโนโลยีสารสนเทศและการส่ือสาร 

          เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การเรียนรู้  
การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม                   
       ตัวชี้วัด   
            1.   ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน 

    สาระส าคัญ 
               การใส่ค าสั่ง ในการเช่ือมโยง ซีน การเช่ือมโยงช้ินงานต่างไฟล์ หรือเช่ือมโยงเว็บไซต์ 
และการใส่เสียงประกอบช้ินงาน 

    สาระการเรียนรู้ 
        -  ความรู้ 
             1.  รู้จักกับค าสั่งในการเช่ือมโยง  
          2.  การใช้ค าสั่งแทรกเสียงประกอบช้ินงาน 
         -  ทักษะ / กระบวนการ 

               1.  ศึกษาและอธิบายการใช้ค าสั่ง การเช่ือมโยง และการแทรกเสียง 
               2.  ฝึกปฏิบัติเกี่ยวกับค าสั่งต่าง   ในโปรแกรม จากนั้นลองทสสอบผลลัพธ์ของค าสั่ง 
         -  คุณลักษณะที่พึงประสงค์ 
               1.  มีวินัย 
               2.  ใฝ่เรียนรู้ 
               3.  มุ่งมั่นในการท างาน 
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 ภายหลังจากที่ไส้มีการสร้างแอนิเมชันในรูปแบบต่าง  ขึ้นมาแล้ว เราอาจมีความต้องการที่
จะน าผลงานเหล่านั้นมาท าการเช่ือมโยงไปมา เช่น เมื่อคลิกที่ปุ่มใส  แล้วก าหนสให้เช่ือมโยง
ปรากฏผลงานแอนิเมชันอีกผลงานหนึ่งที่ไส้สร้างไว้ขึ้นมา ก าหนสให้เช่ือมโยงไปยังเว็บไซต์ใส  ที่
ต้องการ หรือก าหนสให้เช่ือมโยงไปยังซีนข้อมูลอีกซีนหนึ่งก็ไส้เช่นกัน และเมื่อท าการใส่ 
ActionScipt ก็จะท าให้ผลงานมีความสมบูรณ์เต็มเปี่ยมส้วยประสิทธิภาพมากย่ิงขึ้น  
 ส าหรับในเร่ืองนี้เราจะไส้เรียนรู้ขั้นตอนการสร้างแอนิเมชันในรูปแบบใหม่   โสยอาศัย
พื้นฐานของเร่ืองก่อนหน้านี้ พร้อมทั้งท าการเช่ือมโยงผลงานแอนิเมชันเหล่านั้นเข้าส้วยกัน และ
เพื่อให้ผลงานมีความสมบูรณ์มากย่ิงขึ้น เราจะไส้เรียนรู้ ค าสั่ง ActionScipt เบื้องต้น ที่ใช้ควบคุม
ก าหนสการท างานส้านต่าง  ให้กับผลงาน เช่นก าหนสให้หยุสเล่นผลงาน แอนิเมชันเมื่อถึงเฟรมที่
ก าหนส ก าหนสให้เช่ือมโยงไปยังเว็บไซต์ต่าง   

 การเชื่อมโยงระหว่าง Movie 
ผลงานที่สร้างขึ้นภายในอาจมีการเช่ือมโยงข้อมูลมากมายจนกลายเป็นผลงานชิ้นหนึ่งขึ้นมา  

เช่น อาจมีการสร้างปุ่มขึ้นมาให้ผู้เข้าชมไส้ใช้ส าหรับคลิกโต้ตอบ เพื่อเช่ือมโยงไปยังข้อมูลหรือ
เว็บไซต์ต่าง  ซึ่งการท างานสังกล่าวเป็นการท างานในลักษณะ Interactive 
       ส าหรับตัวอย่างต่อไปนี้จะท าการสร้างเลเยอร์ขึ้นมา 3 เลเยอร์ โสยเลเยอร์ที่ 1 เป็นไฟล์ภาพ
รูปภาพพร้อมกับปุ่มคลิก 1 ปุ่ม เลเยอร์ที่ 2 เป็นไฟล์ภาพพร้อมกับปุ่มคลิก 2 ปุ่ม และเลเยอร์ที่ 3 
สร้างขึ้นเพื่อใช้ส าหรับสั่งค าสั่ง Actions ต่าง  เช่น ค าสั่ง stop ที่ใช้ในการหยุสแสสงข้อมูลเมื่อถึง
เฟรมที่ก าหนส ค าสั่ง goto เพื่อให้เล่นไปยังเฟรมที่ก าหนสเมื่อมีการคลิกเมาส์เกิสขึ้น รวมถึงส่ังให้
เช่ือมโยงไปยังเว็บไซต์ที่ก าหนสไว้ 
 ลักษณะการท างานคือ เมื่อมีการคลิกปุ่มที่อยู่ในเลเยอร์ 1 จะให้ท าการเช่ือมโยงไปยังเลเยอร์ 
2 และเมื่อมีการคลิกบนปุ่มที่ 1 ของเลเยอร์ 2 จะให้กลับสู่เลเยอร์ 1 แต่หากคลิกปุ่มที่ 2 แทน ก็จะให้
ท าการเช่ือมโยงไปสู่เว็บไซต็ที่ก าหนสไว้ 

1. คลิกเมนูค าสั่ง File เลือกค าสั่ง Import และ Import to Stage เพื่อน าไฟล์รูปภาพที่ 1 ที่
ต้องการเข้ามาใช้งาน 

2. คลิกเมาส์ขวาเฟรมที่ 5 และเลือกค าสั่ง Insert frame เฟรมทั้งหมสจะมีความยาวจ านวน 
5 เฟรม 
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3. สรากส์เมาส์สร้างปุ่ม 1 ปุ่ม เพื่อใช้คลิกไปสู่ไฟลภ์าพที่ 2  
4. คลิกปุ่ม Insert Layer  ที่ไทมไ์ลน์ นั้นจะปรากฏเลเยอร์ใหม่ ( คือ เลเยอร์ 2 ) ขึ้นมา

จ านวน 1 เลเยอร์ 
5. คลิกเมนูค าสั่ง File เลือกค าสั่ง Import และ Import to Stage เพื่อน าไฟล์ภาพที่ 2 ที่

ต้องการเข้ามาใช้งาน จากนั้นไฟล์ภาพที่ 2 จะวางซ้อนทับอยู่บนไฟล์ภาพที่ 1 
 

คลิกเมนู File > Import 

คลิกเมาส์ขวาเฟรมที่ 5 และ
เลือกค าส่ัง Insert Frame 



 153 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. สรากส์เมาส์สร้างปุ่ม 2 ปุ่ม เพื่อใช้คลิกไปสู่ไฟล์ภาพที่ 1 และคลิกไปสู่เว็บไซต์ที่
ก าหนส 

7. สับเบิ้ลคลิก Layer 2 และสรากส์เมาส์ลากมาไว้เฟรมที่ 10 เพื่อวางภาพที่ 2 ในเลเยอร์ 2 
ต่อท้ายช้ินงาน (ภาพที่ 1) ในเลเยอร์ที่ 1 

8. คลิกปุ่ม  Insert Layer   ที่ไทม์ไลน์ จากนั้นจะปรากฏเลเยอร์ใหม่ (คือ Layer 3 ) 
ขึ้นมาจ านวน 1 เลเยอร์ 

ดรากส์เมาส์สร้างปุ่ม 1 ปุ่ม 

คลิกปุ่ม Insert Layer 

คลิกเมนู File > Import 
> Import to Stage  
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9. คลิกเมนูค าสั่ง Window  เลือกค าสั่ง Development Panels เลือก Actions ให้ปรากฏ
เครื่องหมายถูก จากนั้นจะปรากฏ Actions Panel ขึ้นมา 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 
 

ดับเบ้ิลคลิก Layer 2 จากนั้นให้ 
ดรากส์เมาส์ลากมาไว้เฟรมที่ 10 

ดรากส์เมาส์สร้างปุ่ม 2 ปุ่ม 

คลิกปุ่ม Insert Layer 

คลิกเมน ู Window > Actions 
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10. คลิกเลือก Global Function แล้วเลือก Timeline control แล้วเลือกค าสั่ง Stop สับเบิ้ล
คลิกที่ค าสั่ง stop เพื่อหยุสการแสสงผลเมื่อเล่นมาถึงเฟรมนี้ 

11. คัสลอกค าสั่ง stop จากเฟรมที่ 1 มาไว้เฟรมที่ 5 เพื่อก าหนสจุสหยุสของข้อมูลเฟรม
สุสท้ายในเลเยอร์ที่ 1 

12. คัสลอกค าสั่ง stop จากเฟรมที่ 1 มาไว้เฟรมที่ 10 เพื่อก าหนสจุสหยุสของข้อมูลใน 
เลเยอร์ที่ 2 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

คัดลอกค าส่ัง stop  
มาไว้เฟรมที่ 5 

ดับเบ้ิลคลิกที่ค าส่ัง stop 

ดรากส์เมาส์ค าส่ัง stop มาไว้เฟรมที่ 10 
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13. กลับมาที่เลเยอร์ที่ 1 คลิกปุ่ม ซึ่งแสสงเป็นช่วงจังหวะในการแสสงข้อมูลในเลเยอร์ที่ 2  
14. คลิกเลือก Global function เลือก Movie Control แล้วสับเบิ้ลคลิกค าสั่ง on แล้วใส่ค่าใน

วงเล็บเป็น release  
 
 
 
 
 
 
 
 
 
 
 

15. แล้ วคลิ ก เลื อก  Global function เลื อก  Timeline Control แล้ วสั บ เบิ้ ล คลิ กค าสั่ ง 
gotoAndPlay เพื่อก าหนสการท างานหลังจากคลิกที่ปุ่มแล้ว 

16. ในวงเล็บให้พิมพ์หมายเลขเฟรมเป็น 10 เมื่อคลิกที่ปุ่มก็จะเช่ือมโยงเข้าสู่เฟรมที่ 10 
ในเลเยอร์ที่ 2  ตัวอย่าง gotoAndPlay (10) เป็นต้น 

 
 
 
 
 
 
 
 

17. คลิกปุ่มที่ 1 ใน Layer 2 
18. คลิกเลือก Global function เลือก Movie Control แล้วสับเบิ้ลคลิกค าสั่ง on แล้วใส่ค่าใน

วงเล็บเป็น release  

คลิกที่ปุ่ม ในเลเยอร์ที่ 1  

ดับเบ้ิลคลิกที่ค าส่ัง on เลือก release 

ดับเบ้ิลคลิกที่ค าส่ัง gotoAnd Play พิมพ์หมายเลขของเฟรม 
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19. แล้ วคลิ ก เลื อก  Global function เลื อก  Timeline Control แล้ วสั บ เบิ้ ลคลิ กค าสั่ ง 
gotoAndPlay เพื่อก าหนสท างานหลังจากคลิกที่ปุ่มแล้ว 

20. ในวงเล็บให้พิมพ์หมายเลขเฟรมเป็น 1 เมื่อคลิกที่ปุ่มก็จะเช่ือมโยงเข้าสู่เฟรมที่ 1 ใน  
เลเยอร์ที่ 1ตัวอย่าง gotoAndPlay (1) เป็นต้น 
 

 
 
 
 
 
 
 
 
 

21. คลิกปุ่มที่ 2 ใน Layer 2  
22. คลิกเลือก Global function เลือก Movie Control แล้วสับเบิ้ลคลิกค าสั่ง on แล้วใส่ค่าใน

วงเล็บเป็น release  
23. คลิกเลือกค าสั่ง Browser/Network  สับเบิ้ลคลิกที่ค าสั่ง getURL เพื่อก าหนสเว็บไซต์ที่

ต้องการเช่ือมโยง 
24. ช่อง URL ให้พิมพช่ื์อเว็บไซต์ที่ต้องการเช่ือมโยงเป็น http://www.bkk-software.co.th 

 
 
 
 
 
 
 
 
 
 

คลิกปุ่มที่ 2 

ดับเบ้ิลคลิกที่ค าส่ัง getURL 

พิมพ์ชื่อเว็บไซต์ 

คลิกปุ่มที่ 1 

ดับเบ้ิลคลิกที่ค าส่ัง goto 

พิมพ์หมายเลขเฟรม 

http://www.bkk-software.co.th/
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 การเชื่อมโยงระหว่าง SCENE 

ซีน (Scene) เปรียบเสมือนเร่ืองราวของฉากละครแต่ละฉาก สังนั้นหากต้องการให้ผลงานของ 
เราเป็นที่น่าสนใจย่ิงขึ้น เพียงแค่คลิกเมนูค าสั่ง Insert เลือกค าสั่ง Scene เราก็ไส้ซีนใหม่ที่สามารถ
สร้างข้อมูลแต่ละฉากไส้อีกมากมาย จากนั้นจึงน าซีนเหล่านั้นมาท าการเช่ือมโยงให้เกิสเป็นมูฟว่ี
ขึ้นมา 

เมื่อน าไปใช้กับอินเทอร์เน็ตมูฟว่ีที่สร้างขึ้นจะถูกแบ่งเวลาในการโหลสภาพออกเป็นช่วง  ตาม 
จ านวนซีนที่สร้างไว้ซึ่งส่งผลกับความเร็วในการโหลสข้อมูล เพราะจะท าการโหลสเฉพาะข้อมูลใน
ซีนที่ 1 ขึ้นมา และเมื่อเล่นจนถึงเฟรมสุสท้าย หรือมีการคลิกที่ปุ่ม จึงค่อยท าการโหลสข้อมูลในซีน
ที่ 2 ขึ้นมา 
 
ขั้นตอนในการเชื่อมโยงระหว่างซีนก็คือให้เราสร้างซีนขึ้นมา 2 ซีนก่อน 

 เร่ิมสร้างซีนที่ 1  
1. ให้เลือกเมนูค าสั่ง File เลือกค าสั่ง Import  เข้ามาไว้บนเฟรมที่ 1 และท าเป็น Symbol  

โสยเลือกเมนูค าสั่ง Insert  เลือกค าสั่ง Convert to Symbol เลือกเป็น Graphic ตั้งช่ือว่า 
Pic1 แล้วคลิกที่ปุ่ม OK  

 
 
 
 
 
 
 
 
 
 
 
 

1 
ใส่ชื่อ 

เลือกเป็น Graphic 

คลิก OK 
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2. คลิกเมาส์ขวาเฟรมที่ 10 และเลือกค าสั่ง Insert Keyframe จากนั้นจะปรากฏคีย์เฟรม
ขึ้นมาบนเฟรมที่ 10 

 

 

3. คลิกเมาส์เฟรมที่ 10 และเลือกเมนูค าสั่ง Window เลือกค าสั่งProperties จากนั้นให้คลิก
ที่รูปภาพและใน Properties ในช่อง  Color เลือกเป็น Alpha ปรับค่าให้เป็น 0%  

 

 

 
 
 
 
 
 
 
 
 

เลือกเป็น Alpha  

ปรับค่าให้เป็น 0% 
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4. ให้คลิกเมาส์ขวาที่เฟรมที่ 1 เลือกค าสั่ง Create Classic Tween  

 
 

5. คลิกเมาส์ขวาที่เฟรมที่ 11 เลือกค าสั่ง Insert Keyframe จะปรากฏ Keyframeขึ้นมา  
6. คลิกเมาส์ขวาที่เฟรมที่ 20 เลือกค าสั่ง Insert Keyframe จากนั้นให้คลิกที่รูปภาพ 1 คร้ัง 

ให้คลิกหน้าต่าง Properties ขึ้นมาและตรงช่อง Color เลือกเป็น Alpha ปรับค่าให้เป็น 
100% 

 
 
 
 
 
 
 
 
 
 
 
  

เลือก Alpha 

ปรับค่าให้เป็น 100% 
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7. ให้กลับมาที่เฟรมที่ 11 คลิกเมาส์ขวาที่เฟรมที่ 11 เลือกค าสั่ง Create Motion Tween  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

8. คลิกเมาส์ขวาที่เฟรมที่ 25 เลือกค าสั่ง Insert Keyframe และสร้างปุ่มบนสเตจขึ้นมา 1 
ปุ่ม เพื่อที่จะสามารถคลิกไปยังซีนที่ 2 

 
 
 
 
 
 
 
 
 
 
 
 

คลิกเมาส์ขวาที่เฟรมที่ 11 
เลือก Create Motion Tween 

สร้างปุ่มข้ึนมา 1 ปุ่ม 
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9. สร้าง Layer ขึ้นมา อีก 1 Layer  โสยคลิก      จากนั้นให้คลิกเมาส์ขวาที่เฟรมที่ 25 
ในเลเยอร์ที่ 2เลือกค าสั่ง Insert Keyframe เพื่อที่ใส่ค าสั่งในเฟรมนี้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. ให้เลือกเมนูค าสั่ง Window เลือกค าสั่ง  Actions  
11. เลือกค าสั่ง Global Functions แล้วเลือก Timeline Control และสับเบิ้ลคลิกที่ค าสั่ง Stop 

เพื่อที่จะให้ภาพเคลื่อนไหวหยุสเฟรมที่ 25 ให้เราสามารถที่จะคลิกปุ่มที่สร้างขึ้นเพื่อ
เช่ือมโยงไปยังซีนที่ 2 

 
 
 
 
 
 
 
 
 
 

คลิกเพ่ือสร้างเลเยอร์ใหม่ 

คลิกเมาส์ขวาที่เฟรมที่ 25 
เลือก Insert Keyframe 

ดับเบ้ิลคลิกที่ค าส่ัง Stop 

คลิกเลือกเฟรมที่ 25 

ค าส่ัง Stop 

ค าส่ังจะปรากฏใน 
Frame ที่ 25 
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12. คลิกเลือกปุ่มที่จะใส่ค าสั่งเพื่อเมื่อคลิกแล้วข้ามไปเล่นในซีนที่ 2  
13. คลิกเลือก Global function เลือก Movie Control แล้วสับเบิ้ลคลิกค าสั่ง on แล้วใส่ค่าใน

วงเล็บเป็น release  
 
 
 
 
 
 
 
 
 
 
 
 

14. แล้ วคลิ ก เลื อก  Global function เลื อก  Timeline Control แล้ วสั บ เบิ้ ลคลิ กค าสั่ ง 
gotoAndPlay เพื่อก าหนสท างานหลังจากคลิกที่ปุ่มแล้ว 

15. ในวงเล็บให้พิมพ์ช่ือ Scene เมื่อคลิกที่ปุ่มก็จะเช่ือมโยงเข้าสู่  Scene ที่ 2 ในเฟรมที่ 1 
ตัวอย่าง gotoAndPlay (“Scene 2”, “1”) เป็นต้น 

 
 
 
 
 
 
 
 
 
 
 

คลิกที่ปุ่ม 

คลิกที่ค าส่ัง on 

ดับเบ้ิลคลิกที่ค าส่ัง gotoAndPlay 

ใส่ชื่อ Scene และ Frame Number 
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   การสร้างซีนที่ 2  
1. คลิกเมนูค าสั่ง  Insert เลือกค าสั่ง Scene จะปรากฏซีนใหม่เพื่อใช้สร้างข้อมูลที่จะน ามา

เช่ือมโยงเข้าเป็นมูฟว่ีขึ้นมา 
 

 
 

2. คลิกเมนูค าสั่ง Modify เลือกค าสั่ง Document จะปรากฏไสอะล็อกบ็อกซ์ Document 
Properties ขึ้นมา 

3. ที่ Background Color ให้คลิกเลือกค่าสีเทาจากนั้นที่ฉากหลังจะเปลี่ยนเป็นสีเทาและ
คลิกปุ่ม OK เพื่อยืนยันค าสั่ง 
 

 
 
 
  
 
 
 
 
 
 
 
 
 

คลิกเลือกค าส่ัง Insert > Scene 

คลิก Modify > Document 

เลือกBackground Color 
ให้เป็นสีเทา 
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4. คลิกเมนู File > Import > Import to Stage เพื่อน าไฟล์ภาพที่ต้องการขึ้นมา 
5. คลิกเมาส์ขวาเฟรมที่ 20 เลือกค าสั่ง Insert Frame  

 
 
 
 
 
 
 
 
 
 
 
 
 

6. คลิกปุ่ม Insert Layer    ที่ไทม์ไลน์ จากนั้นจะปรากฏเลเยอร์ใหม่ขึ้นมา 
 
   
 
 
 
 

7. สร้างออบเจ็กต์ไว้ใน Layer 2  
8. คลิกเมาส์ขวาเฟรมที่ 20 เลือก Insert Keyframe และเลือกค าสั่ง Create Motion Tween 
 
 
 
 
 
 

น าไฟล์ภาพมา 

คลิกเมาส์ขวาเลือก 
Insert Frame  

คลิก Insert Layer 
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9. สรากส์เมาส์ลากออบเจ็กต์ไปอกีส้านหนึ่งของออบเจ็กต์ที่อยู่ในเลเยอร์ 1 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเมาส์ขวาเฟรมที่ 20 เลือก 
Insert Keyframe และ  
Create Classic Tween 

สร้างออบเจ็กต์ในเลเยอร์ที่ 2 

ดรากส์เมาส์ลากเคล่ือนย้ายออบเจ็กต์ 
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10. คลิกเมาส์ขวาที่เลเยอร์ 2 เลือกค าสั่ง Mask จากนั้นออบเจ็กต์ในเลเยอร์ที่ 1 ที่ไส้ถูก 
Mask ไว้อยู่ จะปรากฏขึ้นมาเฉพาะบริเวณที่ออบเจ็กต์ ในเลเยอร์ที่ 2 วางซ้อนทับไว้อยู่
เท่านั้น 

 
 
 
 
 
 
 
 
 
 
เมื่อไส้ท าการเช่ือมโยนระหว่างซีนเสร็จเรียบร้อยแล้วให้ลองทสสอบสูว่าแต่ละซีนท างานตามปกติ 
โสยลองกสคีย์บอร์สปุ่ม < Ctrl+Enter > 

คลิกเมาส์ขวา Layer 2 
เลือกค าส่ัง Mask 

ออบเจ็กต์ที่ 1ได้ถูก Mask ไว้  
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 ใส่เสียงประกอบผลงาน 
 ผลงานแอนิเมชันที่สร้างขึ้นทั้งหมส เมื่อน าไปแสสงบนเว็บไซต์อาจสูธรรมสาเกินไป ทั้งนี้
อาจเนื่องมาจากเพราะขาสเสียงสนตรีหรือเสียงเพลงประกอบในระหว่างการแสสงผลงานนั่นเอง 
สังนั้นหากมีไฟล์เพลงอันแสนไพเราะ ก็สามารถน ามาประกอบในผลงานไส้ตามต้องการ 
 โสยไฟล์เสียงหรือไฟล์เพลงที่รองรับสามารถน าเข้ามาท างานร่วมกับโปรแกรมไส้ อาทิเช่น 
ไฟล์นามสกุล >MP3 ที่รองรับกับระบบปฏิบัติการวินโสวส์ ไฟล์นามสกุล .AIFF ที่รองรับส าหรับ
ระบบปฏิบัติการแมคอินทอซ ไฟล์นามสกุล .MP3 ที่รองรับกับระบบปฏิบัติการวินโสวส์และแมค
อินทอซ 
 แต่ข้อพึงระวังส าหรับการน าไฟล์เสียงมาใช้งาน คือ ผลงานที่ไส้จะมีขนาสไฟล์ที่ใหญ่ขึ้น 
ท าให้อาจเปลืองเวลาในการโหลสข้อมูล สังนั้นจึงควรพิจารณาเมื่อต้องการที่จะน าไฟล์เสียงมาใช้
งานประกอบลงในผลงานส้วย และส าหรับในที่นี้ จะขออธิบายวิธีการน าไฟล์เสียงเข้ามาใช้งานไส้ 2 
รูปแบบ คือ วิธีการน าไฟล์เสียงลักษณะเป็นสนตรีประกอบตลอสช่องการแสสงผลงาน 

 การใส่เสียงลงในมูฟว่ี 
การน าไฟล์เสียงมาประกอบลงในออบเจ็กต์ช้ินงานต่าง  ไม่ว่าจะเป็น ปุ่ม ภาพ ข้อความ ฯลฯ  

สามารถท าไส้อย่างง่ายสาย โสยไฟล์เสียงที่น าเข้ามาประกอบนั้นอาจเป็นไฟล์เสียงเอฟเฟ็กต์ที่
ต้องการให้เล่นหลังจากมีการท างานต่าง  เกิสขึ้น 

เพื่อความสมบูรณ์ของการเคลื่อนไหวที่เราสร้างขึ้น เราสามารถที่จะใส่เสียงประกอบเข้าไปใน
เฟรมไส้อีกส้วย โสยเสียงที่จะน ามาใช้ไส้นั้นจะต้องถูกจัสเก็บไว้ในไลบราร่ีเสียก่อน และต้องแยก
อยู่คนละเลเยอร์กับการเคลื่อนไหว 

1. ให้เปิสไฟล์งานที่เราสร้างเอาไว้ก่อนหน้านั้นมาแล้วจากนั้นให้ คลิกเมนูค าสั่ง File เลือก
ค าสั่ง Import  แล้วเลือก Import to Library จะปรากฏไสอะล็อกบ็อกซ์ Import to Library 
ขึ้นมา  

2. สับเบิ้ลคลิกไฟล์เสียงที่ต้องการเล่นเมื่อมีการคลิกที่ปุ่ม จากนั้นไฟล์เสียงจะถูกเก็บอยู่ใน 
Library Panel  
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3. ใช้ไฟล์เสียงที่โปรแกรมจัสเตรียมไว้ให้ โสยคลิกเลือกเมนูค าสั่ง  Window เลือกค าสั่ง 
Common Libraries เลือกค าสั่ง Sounds  

 

เลือกค าส่ัง File >Import > Import to Library 

 
 
 
fi 

เลือก Sound ที่ต้องการ 
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4. ในพาเนล TimeLine สร้างเลเยอร์ใหม่ เพื่อใส่เสียง โสยเลือกเมนูค าสั่ง Insert เลือกค าสั่ง 
Layer ให้ตั้งช่ือว่า Sound    

 

 
 
5. เลือกเลเยอร์ของเสียงนั้น แล้วลากไฟล์เสียงจากพาเนล Library มาใส่ลงในสเตจเสียงนั้น

จะถูกบรรจุเข้าในเลเยอร์ขณะนั้น 
 
 
 
 
 
 

6. ในพาเนล Timeline คลิกที่เฟรมของเสียง แล้วตั้งค่าของเสียงไส้ในพาเนล Properties 

 
 

คล่ืนเสียงของไฟล์เสียง 
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 ในส่วนของ Effect เลือกเอ็ฟเฟ็คในการเล่นเสียงตามต้องการ ซ่ึงอาจเป็น 
 
 
 
 
 
 
 
 
 
None    ไม่ใส่เอ็ฟเฟ็ค 
Left Channel   เสียงออกเฉพาะล าโพงซ้ายเท่านั้น 
Right Channel  เสียงออกเฉพาะล าโพงขวาเท่านั้น 
Fade Left to Right สลับเสียงจากล าโพงส้านหนึ่งไปยังอีกส้านหนึ่ง  
Fade Right to Right สลับเสียงจากล าโพงส้านหนึ่งไปยังอีกส้านหนึ่ง 
Fade In   เสียงค่อย  สังขึ้น 
Fade Out  เสียงค่อย  เบาลง  
Custom   ปรับแต่งเอง 
 
 เลือกการเกิสเสียงจากส่วนของ Sync ซึ่งอาจเป็น 
 
 
 
 
 
Event  เกิสเสียงตามเหตุการณ์ที่เกิสขึ้น เช่น เมื่อคลิกปุ่ม 
Start  เหมือน Event แต่ไม่สามารถเกิสเสียงจากหลาย อินสแตนซ์พร้อม  กันไส้ 
Stop  การปิสเสียง 
Stream เกิสเสียงแบบกระแสเสียงที่อ่านไปเล่นไปไม่ต้องรอให้อ่านจบไฟล์ก่อน มักใช้ใน

เว็บเพจ 
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 เราสามารถก าหนสจ านวนรอบในการเกิสเสียงในส่วนของ Loop  
 
 
 
 

 การใส่เสียงเฉพาะเฟรม 
ในที่นี้ เราจะใส่เสียงให้เฟรมสุสท้ายของ มูฟว่ีเรา 
 
 

1. เลือกค าสั่งเมนู File เลือกค าสั่ง Import  
แล้วเลือก Import to Library เพื่อน าไฟล์เสียง 
มาใส่ในไลบรารี่ 

 
 
 
 

2. ในเลเยอร์ Sound คลิกที่เฟรมสุสท้าย แล้วเลือกเมนูค าสั่ง Insert เลือกค าสั่ง Keyframe 

 
 

3. ในส่วนของ Sound  ในพาเนล Properties คลิกเลอืกเสียงที่ต้องการ 

 

ใส่จ านวนรอบที่ต้องการให้เกิดเสียง 
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 การใส่เสียงให้กับปุ่ม  
สามารถใส่เสียงให้กับปุ่มในภาวะต่าง  ไส้ เช่น ให้เกิสเสียงเมื่อคลิกที่ปุ่มนั้น ซ่ึงจะกระท าไส้
สังนี้ 

1. ก่อนอืน่ จะต้องน าไฟล์เสียงที่จะใช้เข้ามาไว้ในโปรแกรมเสียก่อนส้วยคลิกเลือกค าสั่ง
เมนู File เลือกค าสั่ง Import แล้วเลือก Import to Library เพื่อน าไฟล์เสียงมาใส่ใน
ไลบรารี ่

2. ในพาเนล Library เลือกปุ่มที่จะใส่เสียง แล้วสับเบิ้ลคลิกปุ่มที่ต้องการใส่เสียง 
3. ในพาเนล Timeline สร้างเลเยอร์ใหม่เพื่อใส่เสียง ให้ตั้งช่ือว่า Sound 

 
 

4. ในเลเยอร์ของเสียงนั้น ให้คลิกที่เฟรมในภาวะที่จะใส่เสียง 
ตัวอย่างเช่น ถ้าต้องการให้เกิสเสียงเมื่อคลิกปุ่ม ให้คลิกที่เฟรมตรงภาวะ Down เป็นต้น 
แล้วให้คลิกเมาส์ขวาตรงเฟรม Down แล้วเลือกเมนูค าสั่ง Insert เลือกค าสั่งKeyframe  
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5. ในพาเนล Properties เลือกเสียงในส่วนของ Sound 
 
 
 
 
 
 
 
 
 
 
 
 

6. ตั้งค่าต่าง  ในการเกิสเสียง 
 
 
 
 
 
 
 
 
เมื่อก าหนสเสียง ในปุ่มเรียบร้อยแล้วให้ทสสอบค่าโสยลองกสคีย์บอร์สปุ่ม < Ctrl+Enter > 
 

 
 

เลือกเทคนิคในการเกิดเสียง 

เลือกว่าจะให้เกิดเสียงเม่ือใด 

แก้ไขเสียง 
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หน่วยการเรียนรู้ที่ 9 

เร่ือง   การน าไฟล์ช้ินงานของ Flash CS5 ไปใช ้

  มาตรฐานการเรียนรู้ / ตัวชี้วัด 

     กลุ่มสาระการงานอาชีพและเทคโนโลยี   
        สาระที่  3  เทคโนโลยีสารสนเทศและการส่ือสาร 

          เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล   การเรียนรู้  
การสื่อสาร   การแก้ปัญหา การท างาน  และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล  มีคุณธรรม                   
       ตัวชี้วัด   
            1.   ใช้เทคโนโลยีสารสนเทศน าเสนองานในรูปแบบที่เหมาะสมกับลักษณะงาน 

    สาระส าคัญ 
               การแปลงไฟล์อยู่ในรูปแบบที่น  าไปใช้งานได้ เช่น การแปลงไฟล์เป็น swf เป็นไฟล์ avi   
หรือ ไฟล์ html 

    สาระการเรียนรู้ 
        -  ความรู้ 
             1. การแปลงไฟล์ให้อยู่ในรูปแบบที่สามารถใช้งานได้เลย 
          2.  แปลงไฟล์ให้เป็นประเภท swf  , avi หรือ html 
         -  ทักษะ / กระบวนการ 

               1.  ศึกษาและอธิบายการใช้ค าสั่ง การแปลงไฟล์ชิ นงาน 
               2.  ฝึกปฏิบัติเกี่ยวกับค าสั่งต่าง   ในโปรแกรม จากนั นลองทดสอบผลลัพธ์ของค าสั่ง 
         -  คุณลักษณะที่พึงประสงค์ 
               1.  มีวินัย 
               2.  ใฝ่เรียนรู้ 
               3.  มุ่งมั่นในการท างาน 
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หลังจากที่เราสร้างไฟล์ชิ นงานของเราเรียบร้อยแล้ว และพร้อมที่จะน าผลงานนี ใช้ ซึ่งโดย
ปกติโปรแกรมจะน าไฟล์ชิ นงานนี ไปสร้างเป็นไฟล์ Flash SWF และ ไฟล์ HTML ที่สามารถน าไป
แสดงผลบนเว็บบราวเซอร์ได้ทันที 
 สามารถเลือกให้โปรแกรมท าการสร้างไฟล์ผลงานในแบบ GIF , JPEG,  PNG, Projector
และ QuickTime เพื่ อใช้ร่วมกับไฟล์  HTML เพื่อแสดงผลในบราวเซอร์ในกรณีที่ ผู้ชมไม่มี
โปรแกรม Flash Player 6 ติดตั งอยู่ในระบบได้ 
 นอกจากนี   ยังอาจจะน าเนื อหาในไฟล์ชิ นงานของเรา ซึ่งอาจเป็นทั งมูฟว่ีหรือเฉพาะบาง
เฟรมหรือบางออบเจ็กต์ ไปสร้างเป็นไฟล์ภาพนิ่งในรูปแบบต่าง  เพื่อน าไปใช้  และแก้ไขใน
โปรแกรมอื่นได้อีกด้วย 

 การสร้างไฟล์ผลงานของ Flash ด้วยค าสั่ง Publish 
การสร้างไฟล์ผลงานของ Flash จะมีอยู่ด้วยกัน 2 ขั นตอน คือ 

1. ท าการเลือกชนิดของไฟล์ผลงานที่ต้องการและท าการตั งค่าให้กับไฟล์ชนิดนั น  เมนู
ค าสั่ง File เลือกค าสั่ง Publish Settings 

2. ท าการสร้างไฟล์ผลงานด้วยเมนูค าสั่ง File เลือกค าสั่ง Publish  

  การต้ังค่าส าหรับไฟล์ผลงานของ Flash  
1. ท าการบันทึกไฟล์ชิ นงานเสียก่อน 
2. เลือกค าสั่ง File > Publish Setting 
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3. ในส่วนของ Type เลือกชนิดของไฟล์ที่ต้องการสร้างโดยปกติโปรแกรมจะเลือกชนิด

ของไฟล์เป็น Flash (.swf) และ HTML (.html) ให้โดยอัตโนมัติ ทั งนี เพราะโปรแกรม
จะต้องใช้ไฟล์ชนิดนี ในการแสดงผลบนบราวเซอร์ 

 Flash    ไฟล์ที่ได้มีนามสกุล .swf ซึ่งเป็นไฟล์มูฟว่ีในรูปแบบ Flash 
 HTML   ไฟล์ที่ได้มีนามสกุล .html ซึ่งเป็นไฟล์ที่น าไปใช้งานบนอินเทอร์เน็ต 
 GIF Image   ไฟล์ที่ได้มีนามสกุล .gif ซึ่งเป็นภาพเคลื่อนไหว 
 JPEG Image   ไฟล์ที่ได้มีนามสกุล .ipg ซึ่งเหมาะส าหรับภาพที่ต้องการให้มีความ 
         โปร่งใส 
 Windows Projector  ไฟล์ที่ได้มีนามสกุล .exe ซึ่งเป็นไฟล์ที่น าไปใช้งานกับวินโดวส์ 
 Macintosh Projector  ไฟล์ที่ได้มีนามสกุล .hqx ซึ่งเป็นไฟล์ที่น าไปใช้งานกับเครื่อง 

แมคอินทอช  
4. หากต้องการตั งช่ือไฟล์ ให้คลิกยกเลิกการเลือกในหัวข้อ Use Default name แล้วพิมพ์

ช่ือไฟล์ลงในช่อง Filename ของชนิดของไฟล์นั น  สามารถใส่ต าแหน่งของไฟล์ใน
ดิสก์ได้ด้วย เช่น C:\Folder\filename.swf 

5. คลิกที่แท็บชนิดของไฟล์เพื่อไปตั งค่าตามชนิดของไฟล์ที่เลือก 
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6. เมื่อเรียบร้อยแล้ว คลิกที่ปุ่ม Publish เพื่อสร้างไฟล์ตามชนิดที่ก าหนดหรือ เลือกปุ่ม 
OK เพื่อบันทึกการตั งค่านี ไว้ก่อน แล้วไปท าการสร้างไฟล์ตามที่ก าหนดในภายหลัง
ด้วยเมนูค าสั่ง File เลือกค าสั่ง Publish 

 การต้ังค่าส าหรับไฟล์แบบ Flash movie 
 การน าเสนอผลงานนามสกุล .swf ซึ่งเป็นไฟล์มูฟว่ีในรูปแบบ Flash ช่วยให้คุณสามารถ
ก าหนดค่าต่าง  เช่น ก าหนดป้องกันไม่ให้ผู้ชมดาวน์โหลดไฟล์ไปใช้งาน ก าหนดรหัสผ่านเพื่อ
ป้องกันผู้บุกรุก ก าหนดการบีบอัดไฟล์เสียง ได้ตามต้องการ ส าหรับขั นตอนการก าหนดค่า
คุณสมบัติมีดังต่อไปนี  

1. คลิกแท็บ Flash เพื่อน าเสนอผลงานนามสกุล .swf ซึ่งเป็นไฟล์มูฟว่ีในรูปแบบ Flash  
2. คลิกเลือกเวอร์ชันของโปรแกรม Flash ที่ต้องการน าไฟล์ข้อมูลไปใช้งาน จากส่วน 

Version  
3. คลิกให้ปรากฏเครื่องหมายถูกจากส่วนของ Options เพื่อก าหนดค่าคุณสมบัติที่ต้องการ 

 Generate Size report  สร้างไฟล์ .txt ซึ่งเป็นไฟล์ข้อความที่ใช้บอกรายละเอียด 
   แสดงขนาดของไฟล์ในแต่ละเฟรม  

 Protect from Import  ป้องกันไม่ให้ผู้ชมดาวน์โหลดไฟล์ไปใช้งาน 
 Omit Trace Actions  ป้องกันไม่ให้แสดงหน้าต่างแสดงข้อความที่ก าหนด 
 Debugging Permitted ป้องกันการเข้ามาแก้ไขข้อมูล 
 Compress Movie   บีบอัดไฟล์มูฟว่ีให้มีขนาดเล็กลง และลดเวลาในการ 

โหลดข้อมูลลง 
 Optimize for Flash              เลือกเพื่อแปลงไฟล์พร้อมปรับปรุง 
    Payer 6 r65                          ActionScript ให้สารมารถใช้ได้กับ Flash Player  

เวอร์ช่ัน 6 ได้ดีขึ น (เราต้องเลือกพับลิซเป็น Flash Player  
เวอร์ช่ัน 6 ก่อน) 

 Export hidden layers ในกรณีที่มีการซ่อนเลเยอร์ไว้ ให้เอ็กซ์พอร์ตเลเยอร์ที่
ถูกซ่อนอยู่ด้วย 

        Export SWC  ในกรณีที่มีการใช้คอมโพเนนต์ (เฉพาะไฟล ์ 
        ActionScript 3.0)เราสามารถเลือกเอก็ซ์พอร์ตไฟล์ 

คอมโพเนนต์ (.swc) ด้วย 
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4. เมื่อคลิกเคร่ืองหมายถูกที่ Debugging Permitted จะปรากฏ Password ขึ นมาเพื่อให้
พิมพ์รหัสผ่านที่ต้องการ 

5. ดรากส์เมาส์ก าหนดคุณภาพของภาพบิตแมปจากส่วนของ JPEG Quality โดยหาก
ก าหนดค่าตัวเลขมากภาพจะมีคุณภาพสูง และไฟล์ที่ได้จะมีขนาดใหญ่ 

6. คลิกก าหนดการบีบอัดไฟล์เสียงที่ เล่นตามเฟรมที่ก าหนดไว้ จากส่วนของ Audio 
Stream 

7. คลิกก าหนดการบีบอัดไฟล์เสียงที่เล่นอย่างต่อเนื่อง จากส่วนของ Audio Event 
8. คลิกให้ปรากฏเคร่ืองหมายถูกที่ Override Sound Settings เพื่อใส่ค่าคุณภาพของไฟล์

เสียงที่ได้ก าหนดไว้แทนค่าอื่น  ที่ได้เคยก าหนดไว้ 
9. คลิกปุ่ม   เพื่อจัดตั งส่งออกผลงานตามค่าที่ก าหนดไว้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกเลือกเวอร์ชัน 

คลิกให้ปรากฏ
เครื่องหมายถูก 

พิมพ์รหัสผ่าน 

ดรากส์เมาส์ก าหนด
คุณภาพของภาพบิตแมป 

คลิกให้ปรากฏเครื่องหมายถูก 

คลิกก าหนดการบีบอัดไฟล์เสียงที่เล่นตามเฟรม 

คลิกก าหนดการบีบอัดไฟล์เสียงที่เล่นอย่างต่อเนื่อง 

คลิกปุ่ม Publish 
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การต้ังค่าส าหรับไฟล์แบบ HTML 
การน าเสนอผลงานในรูปแบบ HTML เปน็ไฟล์ที่สามารถน าไปใช้งานบนอินเทอร์เน็ตได้ ซ่ึงค่า 

คุณสมบัติต่าง  จะเกี่ยวข้องกับการแสดงผลบนบราวเซอร์ เช่น ขนาดหน้าต่างบราวเซอร์ ลักษณะ
การจัดวาง รูปแบบการแสดงผล ส าหรับขั นตอนการก าหนดค่าคุณสมบัติดังต่อไปนี  

1. คลิกแท็บ HTML เพื่อน าเสนอผลงานนามสกุล .html ซึ่งเป็นไฟล์ที่น าไปใช้งานบน
อินเทอร์เน็ต 

2. คลิกเลือกรูปแบบที่ต้องการให้แสดงผลงานบราวเซอร์ จากส่วน Template 
3. คลิกเลือกก าหนดความกว้างยาวของมูฟว่ีที่ต้องการให้แสดงบนบราวเซอร์ จากส่วนของ 

Dimensions  
 Match Movie  ให้แสดงเท่ากับขนาดของมูฟวี่ท่ีสร้างขึ นมา 
 Pixels  ก าหนดความกว้างความยาวของมูฟวี่เป็นเซล 
Percent ก าหนดความกว้างความยาวของมูฟวี่เป็นเปอร์เซ็นต์ของหน้าต่าง 

บราวเซอร์ 
4. คลิกให้ปรากฏเคร่ืองหมายถูกจากส่วนของ Playback เพื่อก าหนดการควบคุมลักษณะใน

การเล่นแสดงผลมูฟว่ีบนบราวเซอร์ 
Paused at Start  ไม่เล่นมูฟว่ีจนกว่าจะได้รับค าสั่ง 
Display Menu  เมื่อคลิกเมาส์ขวาที่มูฟว่ีให้ปรากฏเมนูขึ นมา 
Loop   ก าหนดให้เล่นต่อเนื่องกันไปเร่ือย  ถ้าไม่คลิกเลือกจะท าให้มูฟว่ี 

หยุดเมื่อเล่นถึงเฟรมสุดท้าย 
 Device Font   ในกรณีที่ผู้ชมไม่มีตัวอักษร ให้แทนที่ด้วยตัวอักษรในรูปแบบ 

อื่นแทน 
5. คลิกก าหนดคุณภาพของภาพที่แสดงผลบนบราวเซอร์ได้ จากส่วนของ Quality ซึ่งหาก

ก าหนดให้ภาพมีคุณภาพสูง จะท าให้ความเร็วในการแสดงผลลดลง 
Low   คุณภาพของภาพต่ าที่สุด แต่แสดงผลได้เร็วที่สุด 
Auto Low  แสดงคุณภาพที่มีคุณภาพต่ าเพื่อให้แสดงผลได้เร็วก่อน จากนั นจึงค่อย 

ปรับให้ภาพมีคุณภาพที่สูงขึ น 
 Medium ให้ความส าคัญกับคุณภาพและความเร็วในการแสดงผลเท่า  กัน 
 High   คุณภาพของภาพดี แต่หากแสดงภาพเคลื่อนไหวการแสดงผลจะช้าลง 
 Best   คุณภาพของภาพดีที่สุด แต่แสดงผลได้ช้าที่สุด 
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6. คลิกเลือกลักษณะของหน้าต่างมูฟว่ีที่แสดงผลงานบนบราวเซอร์ จากส่วนของ Window 
Mode โดยสามารถก าหนดใช้ได้กับ Internet Explorer 4 ขึ นไปเท่านั น 
Window   แสดงผลบนหน้าต่างวินโดวส์ในลักษณะเป็นสี่เหลี่ยม ซึ่ง 

สามารถแสดงผลได้เร็วที่สุด 
Opaque Windowless สามารถเลือกส่วนที่ซ่อนไว้อยู่ด้านหลังมูฟวี่ได้ 
Transparent Windowless แสดงผลโดยให้พื นหลังของมูฟวี่มีลักษณะโปร่งใส 

7. คลิกเลือกลักษณะต าแหน่งของมูฟว่ีเมื่อแสดงผลบนขึ นมาบราวเซอร์ จากส่วน HTML 
Alignment 
Default  ปรากฏมูฟว่ีขึ นมาตรงกลางของหน้าต่างบราวเซอร์ 
Left   ปรากฏมูฟว่ีขึ นมาชิดด้านซ้ายของหน้าต่างบราวเซอร์ 
Right  ปรากฏมูฟว่ีขึ นมาชิดด้านขวาของหน้าต่างบราวเซอร์ 
Top   ปรากฏมูฟว่ีขึ นมาชิดด้านบนของหน้าต่างบราวเซอร์ 
Bottom ปรากฏมูฟว่ีขึ นมาชิดด้านล่างของหน้าต่างบราวเซอร์ 

8. เมื่อพื นที่ของมูฟว่ีมีขนาดไม่เท่ากับพื นที่ของหน้าต่างบราวเซอร์ ให้คลิกเลือกสัดส่วน
ของมูฟวี่ท่ีต้องการได้จากส่วนของ Scale 
Default  แสดงมูฟวี่ทั งหมดโดยคงสัดส่วนเดิมไว้ 
No Border แสดงมูฟวี่ทั งหมดโดยคงสัดส่วนเดิมไว้ แต่จะไม่ปรากฏเส้นขอบขึ นมา 
Exact Fit  แสดงมูฟวี่บนพื นที่ที่ก าหนดไวโดยไม่ค านึงถึงสัดส่วนเดิม 
No Scale  แสดงตามขนาดหน้าต่างโดยไม่มีการปรับเปลี่ยนสัดส่วนใด  ไปจากเดิม 

9. คลิกเลือกลักษณะการจัดวางมูฟว่ีจากส่วนของ Flash Alignment 
Horizontal  แสดงมูฟวี่ตามแนวนอน 
Vertical แสดงมูฟวี่ตามแนวตั ง 

10. คลิกให้ปรากฏเคร่ืองหมายถูกจากส่วนของ Show Warning Messages เพื่อก าหนดให้แสดง
ข้อความเตือนเมื่อมีข้อผิดพลาดเกิดขึ น 

11. คลิกปุ่ม  เพื่อจัดตั งส่งออกผลงานตามค่าที่ก าหนดไว้ 
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 การต้ังค่าส าหรับไฟล์ แบบ Flash GIF  

เมื่อต้องการน าเสนอผลงานในลักษณะเป็นแอนิเมชันคือ มีการเคลื่อนไหวไปเร่ือย  การ
น าเสนอผลงานในรูปแบบ GIF เป็นรูปแบบที่เหมาะสมที่สุด เนื่องจากสามารถก าหนดจ านวน
ในการแสดงภาพเคลื่อนไหวได้ ก าหนดความโปร่งใสในการแสดงผล ให้แสดงค่าสีที่ใกล้เคียง
ขึ นมาแทนได้ ฯลฯ ส าหรับขั นตอนการก าหนดค่าคุณสมบัติมีดังต่อไปนี   
1. คลิกแท็บ GIF เพื่อน าเสนอผลงานนามสกุล .gif ซึ่งเป็นไฟล์ภาพเคลื่อนไหว 
2. ก าหนดขนาดความกว้างยาวของภาพ จากส่วนของ Dimensions 

คลิกเลือกรูปแบบ 

คลิกเลือกก าหนดความ
กว้างยาวของมูฟวี ่

คลิกให้ปรากฏเครื่องหมายถูก 

คลิกก าหนดคุณภาพของ
ภสพ 

คลิกเลือกลักษณะของ 
หน้าต่างมูฟวี ่

คลิกเลือกลักษณะ 
ต าแหน่งของมฟูวี ่

คลิกเลือกสัดส่วนของมูฟวี ่

คลิกเลือกลักษณะการจัดวางมูฟวี ่

คลิกให้ปรากฏเคร่ืองหมายถูก 

คลิกปุ่ม Publish 
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3. คลิกเลือกรูปแบบของผลงานที่ได้จากส่วนของ Playback 
 Static   สร้างเป็นภาพนิ่ง 
 Loop Continuously สร้างโดยให้แสดงเป็นภาพเคลื่อนไหวไปเร่ือย  
 Animated  สร้างเป็นภาพเคลื่อนไหว 
 Repeat  สร้างโดยก าหนดจ านวนรอบในการแสดงภาพเคลื่อนไหว 
 

4. คลิกให้ปรากฏเครื่องหมายถูกจากส่วนของ Options เพื่อก าหนดค่าคุณสมบัติที่ต้องการ 
Optimize Colors  ลบสีที่ไม่ได้ออกจากตารางสีของ GIF เพื่อช่วยลดขนาดของไฟล์ 
Dither Solids   ให้แสดงสีที่ใกล้เคียง ในกรณีไม่มีสีที่ต้องการ 
Interlace   แสดงภาพพื นก่อนที่ไฟล์ทั งหมดจะถูกดาวน์โหลด ซ่ึงจะท าให้มี 

ลักษณะเหมือนภาพค่อย  ปรากฏขึ นมา 
Remove Gradients ลบการไล่เฉดสีทั งหมดให้แสดงเป็นสีธรรมดา 
Smooth   ให้ภาพมีความราบเรียบละเอียดมากย่ิงขึ น 

5. คลิกเลือกความโปร่งใสของพื นหลัง  
 Opaque  แสดงพื นหลังเป็นสีทึบ 
Transparent  แสดงพื นหลังให้มีความโปร่งใส 
Alpha    ก าหนดค่าความโปร่งใสระหว่าง 0-255 

6. คลิกเลือกการแสดงค่าสีที่ใกล้เคียงแทนสีที่ไม่มี จากส่วนของ Dither 
None   ไม่แสดงค่าสีที่ใกล้เคียงใด  ขึ นมาให้ 
Ordered   ภาพที่แสดงจะมีคุณภาพพอใช้ และไม่สิ นเปลืองหน่วยความจ า 
Diffusion   ภาพที่แสดงจะมีคุณภาพดี แต่สิ นเปลืองหน่วยความจ า 

7. คลิกเลือกชนิดของสีที่ใช้งาน จากส่วนของ Palette Type 
Web 216   ใช้สีมาตรฐานบนเว็บ 216 สี 
Adaptive  วิเคราะห์และสร้างตารางสีขึ นมาใหม่ 
Web Snap Adaptive วิเคราะห์และสร้างตารางสีขึ นมาใหม่ โดยเปรียบเทียบจาก  

Web 216 
Custom  สร้างตารางสีขึ นมาใช้งานเอง 

8. ก าหนดจ านวนสีสูงสุดที่ใช้งาน จากส่วนของ Max Colors 
9. เมื่อคลิกเลือกชนิดของสีเป็น Custom จะปรากฏ Palette ขึ นมาเพื่อให้คลิกน าตารางสีที่

ต้องการเข้ามาใช้งาน 
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10. คลิกปุ่ม  เพื่อจัดตั งส่งออกผลงานตามค่าที่ก าหนดไว้ 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 การต้ังค่าส าหรับไฟล์แบบ  Flash JPEG  
หากไฟล์ภาพที่มีจ านวนค่าสีมาก  การน าเสนอผลงานในรูปแบบ JPEG เป็นรูปแบบที่รองรับ
กับการท างาน ดังกล่าวช่วยให้สามารถก าหนดคุณภาพของภาพได้ตามต้องการ โดยหาก
ก าหนดให้ภาพมีคุณภาพที่สูง ไฟล์ที่ได้ก็จะมีขนาดใหญ่มากย่ิงขึ น ส าหรับขั นตอนการ
ก าหนดค่าคุณสมบัติมีดังต่อไปนี  

ก าหนดขนาดความกว้างยาวของภาพ 
คลิกเลือกรูปแบบของผลงาน 

คลิกให้ปรากฏ
เครื่องหมายถูก 

คลิกเลือกการแสดง
ค่าสีที่ใกล้เคียง คลิกเลือกความโปร่งใสของพื้นหลัง 

ก าหนดจ านวนสีสูงสุด 
คลิกเลือกชนิดของสี 

คลิกน าตารางสีที่ต้องการ 

คลิกปุ่ม Publish 
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1. คลิกแท็บ JPEG เพื่อน าเสนอผลงานนามสกุล .jpg ซึ่งเหมาะส าหรับภาพที่มีจ านวนสีมาก  
2. ก าหนดขนาดความกว้างยาวของภาพ จากส่วนของ Dimensions  
3. ดรากส์เมาส์ก าหนดคุณภาพของภาพที่ได้ จากส่วนของ Quality โดยหากก าหนดค่าตัวเลข

มาก ภาพจะมีคุณภาพสูง และไฟล์ที่ได้จะมีขนาดใหญ่ 
4. คลิกให้ปรากฏเคร่ืองหมายถูกที่ Progressive ไฟล์ภาพที่ได้จะค่อย  ถูกดาวน์โหลดขึ นมา

เมื่อแสดงผลบนบราวเซอร์ 
5. คลิกปุ่ม  เพื่อจัดตั งส่งออกผลงานตามค่าที่ก าหนดไว้ 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ก าหนดขนาด
ความกว้างยาว
ของภาพ 

คลิกให้ปรากฏ
เคร่ืองหมายถูก ดรากส์เมาส์ก าหนด

คุณภาพของภาพ 

คลิกปุ่ม Publish 
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 การต้ังค่าส าหรับไฟล์แบบ Flash PNG 
การน าเสนอผลงานในรูปแบบ PNG เหมาะส าหรับภาพที่ต้องการให้มีความโปร่งใสหรือ

ความโปร่งแสงเกิดขึ นโดยสามารถก าหนดค่าความละเอียดย่ิงขึ น เลือกรูปแบบชนิดของสีที่ใช้
งานได้ ส าหรับขั นตอนการก าหนดค่าคุณสมบัติดังต่อไปนี  
1. คลิกแท็บ PNG เพื่อน าเสนอผลงานนามสกุล .png ซึ่งเหมาะส าหรับภาพที่ต้องการให้มี

ความโปร่งใส 
2. ก าหนดขนาดความกว้างยาวของภาพ จากส่วนของ Dimensions  
3. คลิกเลือกค่าความละเอียดของสีที่ปรากฏบนภาพเป็นจ านวนบิตต่อพิกเซล จากส่วนของ 

Bit Depth 
 8-bit    แสดงภาพ 8 บิต ใช้ค่าสี 256 สี 
 24-bit   แสดงภาพ 24 บิต 
 24-bit with Alpha แสดงภาพพร้อมค่าโปร่งใส 24 บิต 

4. คลิกให้ปรากฏเครื่องหมายถูกจากส่วนของ Options เพื่อก าหนดค่าคุณสมบัติที่ต้องการ 
Optimize Colors  ลบสีที่ไม่ได้ใช้ออกจากตารางสีของ GIF เพื่อช่วยลดขนาดของ 

ไฟล์ 
Dither Solids  ให้แสดงสีที่ใกล้เคียง ในกรณีไม่มีสีที่ต้องการ 
Interlace แสดงภาพพื นก่อนที่ไฟล์ทั งหมดจะถูกดาวน์โหลด ซ่ึงจะท าให้มี

ลักษณะเหมือนภาพค่อย  ปรากฏขึ นมา 
Remove Gradients  ลบการไล่เฉดสีทั งหมดให้แสดงเป็นสีธรรมดา 
Smooth  ให้ภาพมีความราบเรียบละเอียดมากย่ิงขึ น 

5. คลิกเลือกการแสดงค่าสีที่ใกล้เคียงแทนสีที่ไม่มี จากส่วนของ Dither  
None    ไม่แสดงค่าสีที่ใกล้เคียงใด  ขึ นมาให้ 
Ordered  ภาพที่แสดงจะมีคุณภาพพอใช้ และไม่สิ นเปลืองหน่วยความจ า 
Diffusion  ภาพที่แสดงจะมีคุณภาพดี แต่สิ นเปลืองหน่วยความจ า 

6. คลิกเลือกชนิดของสีที่ใช้งาน จากส่วน Palette Type 
Web 216   ใช้สีมาตรฐานบนเว็บ 216 สี 
Adaptive  วิเคราะห์และสร้างตารางสีขึ นมาใหม่ 
Web Snap Adaptive วิเคราะห์และสร้างตารางสีขึ นมาใหม่ โดยเปรียบเทียบจาก  

Web 216 
Custom  สร้างตารางสีขึ นมาใช้งานเอง 
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7. ก าหนดจ านวนสีสูงสุดที่ใช้งาน จากส่วนของ Max Colors 
8. เมื่อคลิกเลือกชนิดของสีเป็น Custom จะปรากฏ Palette ขึ นมาเพื่อให้คลิกน าตารางสีที่

ต้องการเข้ามาใช้งาน 
9. คลิกเลือกลักษณะวิธีการกรอง จากส่วนของ Filter Options ส าหรับการกรองนี จะมี

ประโยชน์ในการบีบอัดไฟล์ให้มีขนาดเล็กลง และสามารถน าไปใช้งานได้อย่างมี
ประสิทธิภาพมากขึ น 

10. คลิกปุ่ม  เพื่อจัดส่งออกผลงานตามค่าที่ก าหนดไว้ 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

ก าหนดขนาดความ
กว้างยาวของภาพ 

คลิกเลือกค่าความละเอียดของสี 

คลิกให้ปรากฏ
เครื่องหมายถูก 

คลิกเลือกการแสดงค่าสีที่ใกล้เคียง 
คลิกเลือกชนิด
ชนิดของสี 

คลิกน าตารางสีที่ต้องการ 

ก าหนดจ านวนสีสูงสุด 

คลิกเลือกลักษณะวิธีการกรอง 

คลิกปุ่ม Publish 
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 การ Export ผลงาน 
วิธีการ Export เพื่อน าเสนอส่งออกผลงานแตกต่างจากวิธีการ Publish คือ การ Export จะไม ่

สามารถแก้ไขค่าคุณสมบัติต่าง  ได้ และสามารถ Export ได้เพียงครั งละ 1 รูปแบบ เช่น GIF, JPEG, 
PNG, BMP, PICT ,QuickTime AVI เท่านั น แต่การ Export จะมีรูปแบบไฟล์ที่ให้เลือกใช้งานเป็น
จ านวนมากกว่าการ Publish  

การ Export สามารถท าได้ 2 รูปแบบ คือ การ Export Movie และการ Export Image ส าหรับข้อ 
แตกต่างระหว่างทั ง 2 รูปแบบ คือ ไฟล์ที่ได้การ Export Movie จะเป็นภาพเคลื่อนไหว แต่ไฟล์ที่ได้
จากการ Export Image จะเป็นภาพนิ่ง แต่หากมีผลงานที่เป็นภาพเคลื่อนไหวและไปท าการ Export 
Image ไฟล์ที่ได้จะเป็นภาพนิ่งต่อเนื่องกันหลาย  ไฟล์ขึ นมา 

 ขั้นตอนการ Export ผลงานในรูปแบบ Movie 

 เมื่อสั่งค าสั่ง Export Movie จะปรากฏไดอะล็อกบ็อกซ์ Export Movie ซึ่งมีรูปแบบไฟล์ในการ
ส่งออกที่เป็นภาพเคลื่อนไหวและไฟล์ในรูปแบบอื่น  ขึ นมาให้เลือกใช้มากมายหลากหลายไฟล์ 
เช่น WAV ซึ่งเป็นไฟล์เสียง AVI เป็นไฟล์มูฟว่ีส าหรับวินโดวส์ เป็นต้น ส าหรับขั นตอนการ
ก าหนดค่าคุณสมบัตมิีดังต่อไปนี  

1. คลิกเมนู File เลือก Export แล้วคลิกเลือกค าสั่ง  Export Movie จากนั นจะปรากฏ
ไดอะล็อกบ็อกซ์ Export Movie ขึ นมา 

2. คลิกเลือกรูปแบบไฟล์ที่ต้องการส่งออกผลงาน จากช่อง Save as Type 
3. คลิกปุ่ม  เพื่อจัดตั งส่งออกผลงานในรูปแบบต่าง  ตามที่ก าหนดไว้  

 
 

 
 
 
 
 
 
 
 
 

คลิกเมนู File > Export > Export Movie 
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 ขั้นตอนการ Export ผลงานในรูปแบบ Image  

 ค าสั่ง Export Image ผลงานที่ได้จะเป็นไฟล์ภาพนิ่ง และส าหรับการ Export Image ไฟล์ที่
ได้จะมีรูปแบบให้เลือก ใช้งานน้อยกว่าการ Export Movie แต่หากมีการน าภาพเคลือ่นไหวที่สร้าง
ขึ นมาสั่ง Export Movie ไฟล์ทีไ่ด้จะเป็นภาพนิ่ง เรียงต่อกันขึ นมาเป็นจ านวนมากมาย ส าหรับ
ขั นตอนการก าหนดค่าคุณสมบัติมีดังต่อไปนี  

1. คลิกเมนู File เลือก Export แล้วเลือกค าสั่ง  Export Image จากนั นจะปรากฏ
ไดอะล็อกบ็อกซ์ Export Image ขึ นมา 

2. คลิกเลือกรูปแบบไฟล์ที่ต้องการส่งออกผลงาน จากช่อง Save as type 
3. คลิกปุ่ม  เพื่อจัดตั งส่งออกผลงานในรูปแบบต่าง  ตามที่ก าหนดไว้ 

 
 
 
 
 
 
 
 
 

คลิกปุ่ม Save 
คลิกเลือกรูปแบบไฟล์ 

คลิกเมนู File > Export >Export Image 
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 การขอดูผลงานที่ได้จากการตั้งค่า 
1. ท าการตั งค่าการสร้างไฟล์ตามตอ้งการด้วยค าสั่ง File > Publish Settings 
2. เลือกค าสั่ง File > Publish Preview แล้วเลือกชนดิของไฟล์ที่จะดูผล 

 

 โปรแกรมจะท าการสร้างไฟล์ชนิดนั นขึ นในโฟลเดอร์เดียวกับไฟล์ชิ นงานของ Flash (.fla) 
นั นเพื่อแสดงผล 

คลิกเลือกรูปแบบไฟล์ 

คลิกปุ่ม Save 
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